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Chapter 1

Introduction

A rule ϕ1, . . . , ϕn / ϕ, understood as “if ϕ1 and . . . and ϕn, then ϕ”, of a logic

L is said to be admissible in L if it can be added to the logic without pro-

ducing any new theorems (in particular, every derivable rule is admissible).

Intuitively, adding an admissible rule to a logical system may change the

internal structure of the system, but does not affect its output. Equivalently,

the rule ϕ1, . . . , ϕn / ϕ is admissible in the logic L, if for any substitution σ,

whenever σ(ϕ1), . . . , σ(ϕn) are theorems of L, also σ(ϕ) is a theorem of L.

Admissibility often plays a substantial role in proving properties of log-

ical systems. For example, establishing the completeness of a proof system

usually involves showing that a certain rule is admissible. In particular, cut-

elimination proofs verify that the cut-rule is admissible with respect to the

given proof system without cut, leading in some cases to decidability, com-

plexity and interpolation results (see, e.g., [74, 4]). Moreover, admissible

rules like the cut rule can be used to shorten proofs, and other admissible

rules might be used to improve proof search. Admissibility is also closely

related to the topic of unification (see, e.g., [99, 42, 43, 44, 46, 1]); in particu-

lar, a formula ϕ is unifiable in a logic L if and only if ϕ / ⊥ is not admissible

in L (assuming that ⊥ is in the language).

The notion of admissibility was defined by Lorenzen in the 1950s [69, page

19] (see Figure 1.1). However, particular admissible rules were already stud-
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Figure 1.1: Excerpt from Einführung in die operative Logik und Mathematik
where admissible (german: zulässig) rules are defined, Lorenzen 1955.

ied by Gentzen [41, e.g.,page 13] and Johansson [63, page 128] in the context

of sequent calculi and minimal logic, respectively, twenty years earlier.

All admissible rules of classical propositional logic CPC are derivable,

i.e., CPC is structurally complete (see [83]). For many other logics this is not

the case. The most famous example is intuitionistic propositional logic IPC

where, e.g., the Kreisel-Putnam rule is admissible, but not derivable:

¬ϕ→ (ψ ∨ χ) / (¬ϕ→ ψ) ∨ (¬ϕ→ χ).

The notion of structural completeness was introduced by Pogorzelski [83] and

has been studied for many-valued logics (in particular, Gödel and  Lukasiewicz

logics) [36, 107, 108, 109, 30], modal and intermediate logics [85, 32, 99] and

substructural logics [82]. Also algebraic characterizations have been given

for structural completeness (see, e.g., [86, 12, 9]).

In 1975, Friedman posed the question as to whether “There is a decision

procedure for determining whether a figure A / B represents a valid rule of

inference in the intuitionistic propositional calculus (where A, B are formulae

in the propositional calculus).” ([39, Question 40]), i.e., whether there is

a decision procedure for admissible rules in IPC. Rybakov answered this

question positively not only for IPC, but also for the modal logic S4 in [96, 98].

10



Concrete proof systems for checking admissibility in modal and intermediate

logics have also been provided (see, e.g., [45, 59, 58, 6]).

Another question of interest is to find (possibly small) sets of rules char-

acterizing the admissible rules of a given logic which is not structurally com-

plete. More formally, a set of admissible rules of a given logic L is called

a basis for the admissible rules of L, if every admissible rule of L is deriv-

able from this set in L. Rybakov showed in particular that there is no finite

basis for the admissible rules of IPC [97]. Iemhoff [56] and Rozière [95]

subsequently proved, independently, that an elegant infinite set of rules con-

jectured by De Jongh and Visser provides a basis. Bases for admissible rules

have also been found for other logics, in particular modal logics [100, 60, 5],

intermediate logics [57, 31],  Lukasiewicz logics [61, 62] and other fuzzy log-

ics [30], fragments of the substructural logic R-Mingle [73] and classes of De

Morgan algebras [26].

The focus of this work is on admissibility in finite-valued logics. At the

beginning of the twentieth century,  Lukasiewicz introduced the three-valued

logic  L3 to handle future contingents such as “tomorrow it will rain” [70].

This and further investigations of finite and infinite valued  Lukasiewicz log-

ics [71, 72] together with the work of Post [84], which introduced other logics

to tackle questions of functional completeness, stimulated further research on

finite-valued logics. Since then many different finite-valued logics have been

defined to treat statements which can have more than just the two truth

values true and false. These additional truth values typically stand for un-

certain, vague, undefined or senseless statements. Famous finite-valued logics

were introduced, e.g., by Gödel [48], Bochvar [23], Kleene [66] and Belnap [8].

Checking the derivability of rules in finite-valued logics is decidable and

has been investigated extensively in the literature. In particular, general

methods for generating proof systems to check derivability such as tableaux,

resolution and multisequent calculi, have been developed, as have standard

optimization techniques for these systems such as lemma generation and in-

dexing (see, e.g., [28, 29, 54, 110, 3, 2]). However, checking the admissibility
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of rules in finite-valued logics is not so well-understood. Although the prob-

lem is decidable, a naive approach leads to computationally unfeasible pro-

cedures even for very small logics. A central goal of this thesis is to obtain

a general and more feasible method to check admissibility in finite-valued

logics. These techniques can then be useful for improving proof systems to

check derivability in the logics or understanding their properties.

Even though the motivation comes from logic, the theory developed in

this thesis makes use of the notions and methods of universal algebra. Many

well-known logics are algebraizable in the sense of [21], i.e., they correspond

to some quasivariety (their algebraic semantics), and hence results obtained

in universal algebra can be translated back into the logical context. A logical

rule corresponds to a quasiequation, i.e., to a finite set of equations implying

another equation. A quasiequation

{ ϕ1 ≈ ψ1, . . . , ϕn ≈ ψn } ⇒ ϕ ≈ ψ

is called admissible in a class of algebras K if every K-unifier of the premises

is a K-unifier of the conclusion, where a K-unifier of an equation ϕ ≈ ψ is a

substitution σ such that σ(ϕ) ≈ σ(ψ) is valid in K.

The starting point for this work is the observation that for a finite set

of finite algebras K, checking admissibility in the quasivariety Q(K) is the

same as checking validity in the free algebra FK(n), where n is the maximal

cardinality of the algebras in K (see Theorem 3.9 and Corollary 2.19). This

algebra FK(n) is finite (see Lemma 2.12), hence checking admissibility in

Q(K) is decidable. But in some cases, even for small n and a small set of

small algebras K, the size of FK(n) is very large. An implementation of a de-

rived proof system to check validity for such algebras would not be practical.

However, sometimes K-admissibility corresponds to validity in other, quite

small algebras. We aim to discover these small algebras using features of the

free algebra. It turns out that every subalgebra of the free algebra FK(n) for

which there are homomorphisms onto the algebras in K, may also be used

for checking K-admissibility. Unfortunately, these subalgebras of FK(n) are

12



not always the smallest algebras with this property. Therefore we provide

an algorithm which finds the minimal (with respect to the standard multiset

ordering) set of algebras satisfying the requirements (see Algorithm 3.1). Us-

ing this algorithm MinGenSet we are then able to characterize structural

completeness and the related property of almost structural completeness.

These algorithms have been implemented in the tool TAFA, which has

then been used to obtain admissibility results (some known and some new)

for a wide range of (classes of) algebras. In particular, after showing that

all two element algebras are structurally complete, we describe admissibility

for all three element groupoids and lattices with up to five elements. We

also provide bases for admissible quasiequations for De Morgan and Kleene

algebras.

We proceed as follows. First, Chapter 2 recalls some required notions

and results from universal algebra. Then Chapter 3 develops the theoretical

core of the thesis, including results on minimal generating sets for quasiva-

rieties, characterizations for admissibility, structural and almost structural

completeness and algorithms to find sets of algebras to check admissibility.

Chapter 4 presents admissibility related results for well known classes of alge-

bras, including, e.g., the proof that all two element algebras are structurally

complete, a study of all three element groupoids (see also Appendix A) and

bases for admissible quasiequations for the quasivarieties of Kleene and De

Morgan lattices and algebras. Chapter 5 describes the system TAFA, a tool

for studying admissibility in finite algebras as well as solving general alge-

braic problems like calculating subalgebras, different kinds of morphisms,

products, congruences and their lattices and checking properties like being

subdirectly irreducible. Finally, Chapter 6 provides a summary of the con-

tribution of the thesis to the theory of admissible rules and lists some ideas

for further work.

Chapter 3 presents joint work with George Metcalfe of which substantial

parts have been published as [76] and [77]. Section 4.4 also presents joint

work with George Metcalfe that has appeared in [75]. The rest of Chapter 4
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and the whole of Chapter 5 is my own work, some of which has appeared in

[92, 93].
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Chapter 2

Preliminaries

This chapter introduces some basic definitions and known results of Univer-

sal Algebra that we will need to develop the theoretical machinery of the

following chapters. We refer to [25] and [49] for further details.

2.1 Algebras

A language is a set of operation symbols L with a nonnegative integer ar(∗)

assigned to each operation symbol ∗ ∈ L, called the arity of ∗. We say that

∗ is n-ary if ar(∗) = n for some operation symbol ∗ ∈ L (nullary , unary or

binary if n is 0, 1 or 2, respectively). An L-algebra A (algebra, if the language

is clear from the context) is an ordered pair consisting of a nonempty set A

(the universe of A) and an n-ary operation ∗A : An → A corresponding

to each n-ary operation symbol ∗ of L (as usual, calling nullary operations

constants). We often omit superscripts when describing the operations of an

algebra. Sometimes we write F for the set of operations on an algebra A

and represent the algebra as follows:

A := 〈A,F〉.
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An algebra A′ := 〈A,F ′〉 is called a reduct of the algebra A := 〈A,F〉 if

F ′ ⊆ F . The L-algebra A is said to be finite if A is a finite set and L

consists of finitely many operation symbols with finite arity.

We use the letters x1, x2, . . . , y1, y2, . . . , z1, z2, . . . , sometimes without

indices, to denote countably infinitely many variables . For a set X of vari-

ables and a language L, the set TmL(X) of L-terms over X is inductively

defined as usual: every variable x ∈ X is an L-term over X and if ϕ1, . . . , ϕn

are L-terms over X and the operation symbol ∗ ∈ L has arity n, then also

∗(ϕ1, . . . , ϕn) is an L-term over X . We call members of TmL({x1, x2, . . . })

L-terms and denote them by TmL(ω) or just TmL. We usually omit brackets

where convenient and use the infix notation for binary operation symbols,

e.g., we write x ∗ y instead of ∗(x, y). The L-terms over X build the uni-

verse of the term algebra over X . The operations of TmL(X) are defined as

expected, i.e., for each n-ary ∗ ∈ L, ϕ1, . . . , ϕn ∈ TmL(X),

∗TmL(X)(ϕ1, . . . , ϕn) := ∗(ϕ1, . . . , ϕn).

Let ϕ(x1, . . . , xn) be an L-term over some set X and A an L-algebra. We

define a map ϕA : An → A called the term operation on A corresponding to

ϕ (we often omit the superscripts for convenience) as follows:

• If ϕ is a variable xi (0 ≤ i ≤ n), then ϕA(a1, . . . , an) := ai.

• If ϕ is of the form ∗(ϕ1(x1, . . . , xn), . . . , ϕk(x1, . . . , xn)) for an operation

symbol ∗ ∈ L of arity k, then

ϕA(a1, . . . , an) := ∗A(ϕA

1 (a1, . . . , an), . . . , ϕA

k (a1, . . . , an)).

The n-ary i-th projection pni is defined by pni (x1, . . . , xn) := xi and the

n-ary constant operation cna is defined by cna(x1, . . . , xn) := a. Let ∗ be an

n-ary operation and ⋄1, . . . , ⋄n m-ary operations. Then the composition of
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the operations ∗ and ⋄ is defined as the m-ary operation

∗[⋄1, . . . , ⋄n](x1, . . . , xm) := ∗(⋄1(x1, . . . , xm), . . . , ⋄n(x1, . . . , xm)).

The clone of operations of A, denoted CloA, is the smallest set of operations

on A which contains all projections pni (n ∈ N, 0 ≤ i ≤ n), the operations of A

and is closed under compositions. We write Clon A to denote the set of n-ary

members of CloA. We say that two algebras A1 and A2 over the universe A

are clone equivalent if CloA1 = CloA2, and write A1 ≈clo A2. We say that

an n-ary operation ∗(x1, . . . , xn) is definable by the set of operations F of an

algebra A := 〈A,F〉 if there exists an ∗′ ∈ CloA such that ∗(a1, . . . , an) =

∗′(a1, . . . , an) for any a1, . . . , an ∈ A.

Example 2.1. Let A := 〈{0, 1},∧,¬〉 be an algebra with x∧ y := min{x, y}

and ¬x := 1 − x. Then the unary operation c10 is definable by {∧,¬}, e.g.,

by x ∧ ¬x, while the nullary operation c00 is not definable by {∧,¬}.

Note that two algebras A1 := 〈A,F〉 and A2 := 〈A,G〉 are clone equivalent

if and only if every operation in F is definable by G and vice versa.

Example 2.2. Let G16 := 〈G16, ◦〉 and G17 := 〈G17, ∗〉 be two L-algebras

with universe {a, b, c} and the binary operations defined as follows (see Ap-

pendix A):

◦ a b c ∗ a b c

a a a a a a a a

b a a a b a a a

c b c a c b c b

G16 and G17 are clone equivalent since for any x, y ∈ {a, b, c}, we have that

x ◦ y = (x ∗ (x ∗ (y ∗ x))) ∗ y, and

x ∗ y = x ◦ ((x ◦ y) ◦ (x ◦ x)).

Let A and B be two L-algebras. B is said to be a subalgebra of A,

written B ≤ A, if B ⊆ A and every operation of B is the restriction of the

17



corresponding operation of A to the universe B.

A map h : A → B is called a homomorphism from A to B, written

h : A→ B, if it is compatible with all operations, i.e., for all a1, . . . , an ∈ A

and every n-ary operation ∗ ∈ L,

h(∗A(a1, . . . , an)) = ∗B(h(a1), . . . , h(an)).

The algebra C with universe C := {h(a) : a ∈ A} ⊆ B and the restrictions

of the operations of B to C as operations is called a homomorphic image of

A. A is called the prehomomorphic image of C in this case. The kernel

of a homomorphism h : A → B is defined by ker h := {(a1, a2) ∈ A2 :

h(a1) = h(a2)}. We often call injective homomorphisms embeddings and a

homomorphism h : A → B that is bijective is called an isomorphism. We

say that A is isomorphic to B if there is an isomorphism from A to B, and

write A ∼= B.

The direct product of the L-algebras {Ai}i∈I for an index set I has uni-

verse
∏

i∈I Ai and its operations are defined coordinate-wise, i.e., for an n-ary

operation symbol ∗ ∈ L, the i-th coordinate is defined as follows:

∗
∏

i∈I
Ai(a1, . . . , an)(i) := ∗Ai(a1(i), . . . , an(i)).

2.2 Varieties and Quasivarieties

An L-equation is a pair of L-terms, written ϕ ≈ ψ. An L-clause is defined

as an ordered pair Σ,∆ of finite sets of L-equations, written Σ ⇒ ∆, and

called an L-quasiequation if |∆| = 1 and an L-negative clause if ∆ = ∅. As

usual, if the language is clear from the context, we may omit the prefix L.

Let us fix K to be a class of L-algebras, noting that often in what follows

K will consist of a finite set of L-algebras A1, . . . ,An, and in this case we

typically omit brackets. For a finite set of L-equations Σ ∪ ∆, we say that

the set Σ is K-satisfiable if Σ ⊆ ker h for some A ∈ K and homomorphism

h : TmL → A, and the L-clause Σ ⇒ ∆ is K-valid (or, K satisfies the L-
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clause Σ ⇒ ∆), written Σ |=K ∆ (or |=K ∆, if Σ = ∅), if for every A ∈ K

and homomorphism h : TmL → A,

Σ ⊆ ker h implies ∆ ∩ ker h 6= ∅.

The class K is said to be axiomatized by a set of L-clauses Λ if K is the

class of L-algebras A such that all L-clauses in Λ are A-valid, i.e., A ∈ K if

and only if Σ |=A ∆ for all Σ⇒ ∆ ∈ Λ. The class of L-algebras K is called

an L-universal class , L-variety , L-quasivariety or L-antivariety if it is ax-

iomatized by a set of L-clauses, L-equations, L-quasiequations or L-negative

clauses, respectively. The universal class U(K), variety V(K), quasivariety

Q(K) and antivariety V-(K) generated by K are the smallest universal class,

variety, quasivariety and antivariety containing K, respectively. K is called

the generating set in this cases. If K is a finite set of finite L-algebras, these

classes are called finitely generated .

Moreover, let H, I, S, P, PU , P∗
U and H−1 be the class operators (map-

ping classes of algebras to classes of algebras) of taking homomorphic images,

isomorphic images, subalgebras, products, ultraproducts, non-empty ultra-

products1 and prehomomorphic images, respectively. E.g., A ∈ H(K) if A

is a homomorphic image of some B ∈ K. Birkhoff proved in his famous

HSP theorem [17] that the equational classes, i.e., varieties, are exactly the

classes which are closed under H, S and P. Tarski refined this result to

V(K) = HSP(K) in [105]. Similar results were also obtained for other syn-

tactically defined classes of algebras:

Theorem 2.3. Let K be a class of L-algebras.

(a) U(K) = ISPU(K) ([25, Theorem V.2.20]).

(b) V(K) = HSP(K) ([17, Theorem 6] and [105, Theorem]).

(c) Q(K) = ISPPU(K) ([51, Theorem]).

1We refer to Section IV.6 in [25] for a proper definition of ultraproducts since they do
not play any special role when considering finite sets of finite algebras.
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(d) V-(K) = H−1SP∗
U(K) ([50, Theorem 1.2]).

If K is a finite set of finite algebras, then PU(K) ⊆ I(K) (see [25, Lemma

IV.6.5]); hence U(K) = IS(K), Q(K) = ISP(K) and V-(K) = H−1S(K). Note

furthermore, that all varieties and quasivarieties contain trivial algebras since

empty products are allowed (contrary to, e.g., [25]).

Example 2.4. A Boolean algebra is an algebra B := 〈B,∧,∨,¬,⊥,⊤〉 such

that 〈B,∧,∨〉 is a distributive lattice (see Section 2.3) and the following hold:

x ∧ ⊥ ≈ ⊥, x ∨ ⊤ ≈ ⊤, x ∧ ¬x ≈ ⊥, x ∨ ¬x ≈ ⊤. If B2 is the two

element Boolean algebra, then Q(B2) = Q(B2 ×B2) since B2 ∈ P(B2) and

B2 ∈ IS(B2 ×B2), but U(B2 ×B2) 6⊆ U(B2) since B2 ×B2 6∈ IS(B2).

It is crucial to note that equations are preserved by the class operators

defining universal classes, varieties and quasivarieties.

Lemma 2.5 ([25, Lemma II.11.3]). Let K be a class of L-algebras. Then K,

I(K), H(K), S(K), P(K), PU(K) and P∗
U(K) satisfy the same equations.

Proof. The cases K, I(K), H(K), S(K), P(K) are covered in [25]. For the

ultraproducts note that P∗
U(K) ⊆ PU(K) ⊆ HP(K).

2.3 Lattices and Congruences

A lattice is an algebra L := 〈L,∧,∨〉, where ∧ and ∨ (called meet and join)

are binary operations satisfying the following equations:

commutativity x ∧ y ≈ y ∧ x

x ∨ y ≈ y ∨ x

associativity x ∧ (y ∧ z) ≈ (x ∧ y) ∧ z

x ∨ (y ∨ z) ≈ (x ∨ y) ∨ z

idempotency x ∧ x ≈ x

x ∨ x ≈ x

absorption x ∧ (x ∨ y) ≈ x

x ∨ (x ∧ y) ≈ x.

20



A distributive lattice is a lattice admitting the equations of

distributivity x ∧ (y ∨ z) ≈ (x ∧ y) ∨ (x ∧ z)

x ∨ (y ∧ z) ≈ (x ∨ y) ∧ (x ∨ z),

and a bounded lattice L is an algebra 〈L,∧,∨,⊥,⊤〉 such that 〈L,∧,∨〉 is

a lattice and the constants ⊥ and ⊤ satisfy the equations x ∨ ⊥ ≈ x and

x ∧ ⊤ ≈ x. A lattice L is complete if for every subset B ⊆ L the meet
∧
B

and join
∨
B exist. An element a of a complete lattice L is called completely

meet irreducible (meet irreducible) if for any (finite) subset B ⊆ L, a =
∧
B

implies a ∈ B. The notion of join irreducibility is defined dually.

Besides this algebraic definition of a lattice there exists a corresponding

order theoretic definition. To establish this connection we first have to intro-

duce the notion of a partially ordered set. A partially ordered set , poset for

short, is a set P together with a binary relation ≤ (the partial order), written

〈P,≤〉, such that for all a, b, c ∈ P the following hold: a ≤ a (reflexivity),

a ≤ b and b ≤ a imply a = b (antisymmetry) and a ≤ b and b ≤ c imply

a ≤ c (transitivity). An upper (lower) bound of a subset A of a poset P is an

element b ∈ P such that a ≤ b (b ≤ a) for all a ∈ A. A least upper (greatest

lower) bound is an upper (lower) bound m ∈ P such that for all other upper

(lower) bounds b, m ≤ b (b ≤ m). We now define a lattice as a poset P

such that any two elements a, b ∈ P have a least upper bound and a greatest

lower bound. These two definitions of lattices are equivalent in the following

sense: If L is a lattice by the first definition, we define a partial order ≤ on

L by a ≤ b iff a = a ∧ b. If P is a lattice by the second definition, we define

the binary operations ∧ and ∨ to be the greatest lower bound and the least

upper bound, respectively.

We say that b covers a in the poset P , denoted a ≺ b, if a ≤ c ≤ b for

any c ∈ P implies a = c or b = c. We usually draw finite posets using Hasse

Diagrams : a circle “◦” represents an element of the poset and whenever

a ≺ b, we draw the b-circle above the a-circle and connect them with a line.

Example 2.6. The Hasse Diagram depicted below shows two posets 〈P,≤〉

and 〈C2,≤〉. P is not a lattice since a, b ∈ P do not have a lower bound.
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P

a b

⊤ C2

⊥

⊤

bc

bc

bc bc

bc

Interpreted as algebras P := 〈P,∧,∨〉 (setting a∧b := b) and C2 := 〈C2,∧,∨〉

we can define a homomorphism h as indicated by the dotted arrows in the

picture. Note that C2 satisfies the ∧-distributivity law x ∧ (y ∨ z) ≈ (x ∧

y) ∨ (x ∧ z), while P does not (e.g., a ∧ (b ∨ a) = a ∧ ⊤ = a 6= ⊤ =

b∨a = (a∧b)∨(a∧a)). Hence prehomomorphisms do not preserve equations

(compare with Lemma 2.5).

An equivalence relation θ on a set A is a subset θ ⊆ A×A, such that for

all a, b, c ∈ A, 〈a, a〉 ∈ θ (reflexivity), 〈a, b〉 ∈ θ implies 〈b, a〉 ∈ θ (symmetry)

and 〈a, b〉, 〈b, c〉 ∈ θ implies 〈a, c〉 ∈ θ (transitivity). For the elements a ∈

A we define a/θ := {b ∈ A : 〈a, b〉 ∈ θ}, the equivalence class modulo θ

(sometimes just [a] if it is clear which equivalence relation we mean). The

quotient of A by θ, denoted A/θ, is the collection of the equivalence classes

of θ, i.e., A/θ := {a/θ : a ∈ A}. A congruence on an L-algebra A is an

equivalence relation θ on A satisfying for each n-ary operation symbol ∗ of

L and a1, . . . , an, b1, . . . , bn ∈ A:

〈a1, b1〉 ∈ θ, . . . , 〈an, bn〉 ∈ θ implies 〈∗A(a1, . . . , an), ∗A(b1, . . . , bn)〉 ∈ θ.

The congruences of A, denoted Con(A), form a complete lattice Con(A) :=

〈Con(A),∧,∨〉 with bottom element ∆A := {〈a, a〉 : a ∈ A} and top element

∇A := {〈a, b〉 : a, b ∈ A}, where the meet of two congruences θ1, θ2 on A is

just the intersection θ1 ∩ θ2 and the join of θ1 and θ2 is the intersection of all

congruences containing θ1 ∪ θ2.

Given θ ∈ Con(A), the quotient algebra of A by θ is the L-algebra A/θ

with universe A/θ and operations defined for each n-ary operation symbol

∗ ∈ L by

∗A/θ(a1/θ, . . . , an/θ) := ∗A(a1, . . . , an)/θ.
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For an algebra A and a congruence θ ∈ Con(A), the natural homomorphism

νθ : A→ A/θ (sometimes just ν for convenience) sends each element of A to

its congruence class, i.e., νθ(a) := a/θ.

We finish this section by stating that term operations behave as the op-

erations of an algebra with respect to congruences and homomorphisms:

Lemma 2.7 ([25, Theorem II.10.3]). Let A, B be L-algebras, ϕ(x1, . . . , xn)

an n-ary L-term and a1, . . . , an, b1, . . . , bn ∈ A.

(a) If θ ∈ Con(A) and 〈ai, bi〉 ∈ θ for 1 ≤ i ≤ n, then

〈ϕA(a1, . . . , an), ϕA(b1, . . . , bn)〉 ∈ θ.

(b) If h : A→ B is a homomorphism, then

h(ϕA(a1, . . . , an)) = ϕB(h(a1), . . . , h(an)).

2.4 Subdirect Representations

An L-algebra A is called a subdirect product of the family (Ai)i∈I if there

exist surjective homomorphisms fi : A → Ai for each i of the index set I

such that the induced homomorphism

f : A→
∏

i∈I

Ai, f(x)(i) := fi(x),

is an embedding. In this case, f is called a subdirect representation of A

and the members of (Ai)i∈I are called subdirect components (for this rep-

resentation). If K is a class of L-algebras and Ai ∈ K for all i ∈ I, then

A is called a K-subdirect product of the algebras Ai, i ∈ I and f is called

a K-subdirect embedding . A is called K-subdirectly irreducible if for every

K-subdirect embedding f : A →
∏

i∈I Ai, A is isomorphic to Ai for some

i ∈ I.

The well known Subdirect Decomposition Theorem for equational classes

[19, Theorem 2] also holds for more general classes, including quasivarieties:
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Theorem 2.8 ([27, Corollary 6]). Let Q be a quasivariety and A ∈ Q. Then

A is a Q-subdirect product of Q-subdirectly irreducible members of Q.

Moreover, the Q(K)-subdirectly irreducible algebras always embed into a

generating algebra A ∈ K of the quasivariety:

Lemma 2.9 ([49, Proposition 3.1.6]). Let Q(K) be a finitely generated qua-

sivariety and A a Q(K)-subdirectly irreducible algebra. Then A ∈ IS(K).

Theorem 2.10 ([18, Theorem VI.11]). Let A be a subdirect product of the

family (Ai)i∈I. Then there exist for i ∈ I, congruences θi ∈ Con(A) such

that Ai
∼= A/θi and

⋂
i∈I θi = ∆A.

Conversely, let (θi)i∈I be a family of congruences on A. Then the quotient

A/(
⋂

i∈I θi) is a subdirect product of the family (A/θi)i∈I .

We now translate this theorem to Q-subdirect representations of an algebra

A, where Q is a quasivariety containing A. This establishes the relationship

between Q-subdirect representations of A and families of Q-congruences on

A. The set of Q-congruences on A is defined as

ConQ(A) := {θ ∈ Con(A) : A/θ ∈ Q}.

Corollary 2.11. Let Q be a quasivariety and A ∈ Q.

(a) Let A be a Q-subdirect product of the family (Ai)i∈I . Then there exist

for i ∈ I, Q-congruences θi ∈ ConQ(A) such that Ai
∼= A/θi and

⋂
i∈I θi = ∆A.

Conversely, let (θi)i∈I be a family ofQ-congruences on A with
⋂

i∈I θi =

∆A. Then A is a Q-subdirect product of the family (A/θi)i∈I .

(b) A is Q-subdirectly irreducible iff it is trivial or the bottom element ∆A

of ConQ(A) is completely meet-irreducible.

Proof. (a) Suppose that A is a Q-subdirect product of the family (Ai)i∈I and

hence obviously also a subdirect product of the family (Ai)i∈I . So there exist
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for i ∈ I, congruences θi ∈ Con(A) such that Ai
∼= A/θi and

⋂
i∈I θi = ∆A

by Theorem 2.10. But then θi ∈ ConQ(A) for all i ∈ I since Ai ∈ Q for

all i ∈ I by assumption and Q is closed under isomorphisms. For the other

direction consider a family of Q-congruences (θi)i∈I on A with
⋂

i∈I θi = ∆A.

By Theorem 2.10, A/(
⋂

i∈I θi) is a subdirect product of the family (A/θi)i∈I .

But since
⋂

i∈I θi = ∆A and A/θi ∈ Q for all i ∈ I by assumption, A is a

Q-subdirect product of the family (A/θi)i∈I .

(b) Define J := ConQ(A) \ {∆A}. Suppose for a contradiction that A

is non-trivial and Q-subdirectly irreducible and that
⋂
J = ∆A. A is a

Q-subdirect product of the algebras {A/θ : θ ∈ J} by (a). Since A is

subdirectly irreducible, there is an isomorphism f : A→ A/θ for some θ ∈ J ,

which contradicts ∆A 6∈ J . For the other direction suppose that
⋂
J 6= ∆A

and let f : A →
∏

i∈I Ai be a subdirect representation of A. By (a) there

exist for i ∈ I, Q-congruences θi ∈ ConQ(A) such that Ai
∼= A/θi and

⋂
i∈I θi = ∆A. So by assumption θi = ∆A for some j ∈ I, hence A ∼= A/θj

and A is subdirectly irreducible.

Note, moreover, that the number of congruences needed to obtain a sub-

direct representation of a finite algebra A is at most |A|, the maximal number

of coatoms of the congruence lattice Con(A).

2.5 Free Algebras

Given a class of L-algebras K and a set of variables X such that either X 6= ∅

or L contains at least one constant symbol, the term algebra TmL(X) exists

and admits the following congruence:

ΨK(X) :=
⋂
{θ ∈ Con(TmL(X)) : TmL(X)/θ ∈ IS(K)}.

Following [25], we let X := X/ΨK(X) and define the free algebra of K over

X by:

FK(X) := TmL(X)/ΨK(X).
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Then FK(X) has the universal mapping property for K over X , i.e., for each

A ∈ K, any map from X to A extends to a homomorphism from FK(X) to

A (see [25, Theorem II.10.10]).

Note that FK(X) ∼= FK(Y ) whenever |X| = |Y |. Also |X| = |X| if K

contains at least one non-trivial algebra (in this case we write x for x ∈ X).

Hence we may consider for each cardinal κ, the (unique up to isomorphism)

free algebra of K on κ generators FK(κ), where FK(κ1) is a subalgebra of

FK(κ2) for cardinals κ1 ≤ κ2.

It is crucial for us that for a finite set of finite algebras2 K, the free algebra

FK(n) is finite for all n ∈ N:

Lemma 2.12 ([17, Corollary 2]). For any set of finite L-algebras K :=

{A1, . . . ,Am} and n ∈ N:

|FK(n)| ≤
m∏

i=1

|Ai|
|Ai|

n

.

We will sometimes need the fact that a free algebra is contained in the

corresponding quasivariety and variety.

Lemma 2.13 ([25, Theorem II.10.12]). Suppose that TmL(X) exists. Then

for a nonempty class K of L-algebras,

FK(X) ∈ ISP(K).

Note that if K is a universal class or an antivariety, then FK(X) ∈ K does

not hold in general.

Theorem 2.14 ([25, Theorem II.11.4]). Let K be a class of L-algebras and

ϕ, ψ ∈ TmL(x1, . . . , xn). Then the following are equivalent:

(1) �K ϕ ≈ ψ.

(2) �
FK(X) ϕ ≈ ψ.

2This was extended in [15, Theorem 2.8] to members of finitely generated varieties.
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(3) ϕFK(X)(x1, . . . , xn) = ψFK(X)(x1, . . . , xn).

(4) 〈ϕ, ψ〉 ∈ ΨK(X).

It follows that the free algebras of two classes of algebras K1 and K2

are the same if and only if K1 and K2 satisfy the same equations. Define

EqK(X) := {ϕ ≈ ψ : ϕ, ψ ∈ TmL(X) and |=K ϕ ≈ ψ}.

Corollary 2.15. Let K1,K2 be classes of L-algebras. Then FK1
(X) =

FK2
(X) iff EqK1

(X) = EqK2
(X). In particular, FV(K1)(ω) = FV(K2)(ω) iff

V(K1) = V(K2).

Combining this with Lemma 2.5 we immediately get:

Corollary 2.16. Let K be a class of L-algebras and κ a cardinal number

with κ ≤ ω. Then

FK(κ) = FU(K)(κ) = FV(K)(κ) = FQ(K)(κ).

Also, Lemma 2.13 and Theorem 2.14 imply that the free algebra of a

variety V on infinitely many generators generates V.

Corollary 2.17. If V is a variety, then V = V(FV(ω)).

IfQ is a finitely generated quasivariety, then only finitely many generators

are needed to generate Q(FQ(ω)).

Theorem 2.18 ([99, Lemma 4.1.10]). Let K be a finite set of finite L-

algebras {A1, . . . ,An} and m := max{|A| : A ∈ K}. Then Q(FQ(K)(ω)) =

Q(FQ(K)(m)).

Hence we obtain, using Lemma 2.12, Corollary 2.16 and PU(A) ⊆ I(A)

for a finite algebra A (see Section 2.2), the following useful corollary:

Corollary 2.19. Let K be a finite set of finite L-algebras {A1, . . . ,An} and

m := max{|A| : A ∈ K}. Then Q(FK(ω)) = ISPPU(FK(m)) = ISP(FK(m)).
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Chapter 3

Finitely Generated Quasivarieties

In this chapter, we address issues of admissibility in finitely generated qua-

sivarieties: that is, quasivarieties generated by a finite number of finite alge-

bras. We start by defining minimal generating sets for a finitely generated

quasivariety Q: minimal sets of algebras K (with respect to some multiset

ordering) with Q(K) = Q (Section 3.1). Due to the fact that the consid-

ered quasivarieties Q(K) are finitely generated, we are able to present an

algorithm which calculates a minimal generating set for Q(K), given K (see

Algorithm 3.1). Sections 3.2, 3.4 and 3.5 provide useful characterizations of

unification, structural completeness and almost structural completeness, re-

spectively, and Section 3.3 presents an algorithm to build a proof system for

checking admissibility in finitely generated quasivarieties. Section 3.6 takes

a closer look at clone equivalences to prove that if the clones of operations

of two algebras A1,A2 are the same, the free algebras FA1
(n) and FA2

(n)

and the corresponding minimal generating sets are isomorphic up to a trans-

lation (inside the clone) of their languages. Section 3.7 explains how the

algebraic ideas presented in this chapter can be transferred to finite-valued

logics and Section 3.8 finally gives a concrete example of how a proof system

for checking admissibility can be automatically generated.
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3.1 Minimal Generating Sets

If Q is a quasivariety, a quasiequation Σ ⇒ ϕ ≈ ψ is Q-admissible if and

only if Σ |=FQ(ω) ϕ ≈ ψ (see Theorem 3.9). I.e., to check the Q-admissibility

of a quasiequation, we have to check whether this quasiequation holds in

the quasivariety generated by the free algebra FQ(ω). When Q is finitely

generated there is an n ∈ N such that FQ(n) generates the same quasivariety

(see Theorem 2.18). Since this algebra FQ(n) is finite (see Lemma 2.12), it

is possible to generate a proof system with a tool such as MUltlog [101] or

3TAP [7] to check the validity of the quasiequation Σ ⇒ ϕ ≈ ψ (e.g., using

MUltseq [47]). See Section 3.8 for an example system.

It is natural to ask for the “smallest” set of algebras generating the qua-

sivariety Q(FQ(ω)). But first we have to determine a suitable measure for

comparison. It turns out that a good choice for comparing the cardinalities

of the algebras is the multiset well-ordering defined in [34]. Recall that a mul-

tiset over a set S is an ordered pair 〈S, f〉 where f is a function f : S → N.

The multiset 〈S, f〉 is called finite if {x ∈ S : f(x) > 0} is finite. We will

write a finite multiset over S as [a1, . . . , an] where a1, . . . , an ∈ S may include

repetitions. For a well-ordered set 〈S,≤〉, the multiset ordering ≤m on the set

M(S) of finite multisets over S is defined by 〈S, f〉 ≤m 〈S, g〉 if f(x) > g(x)

implies that for some y ∈ S, y > x and g(y) > f(y). Intuitively, M1 ≤mM2

holds for two multisets M1 and M2 if M1 can be obtained from M2 by

replacing its elements with a finite number (possibly zero) of strictly smaller

elements of M1.

Example 3.1. Let M1 := [1, 1, 3, 3, 3, 7] and M2 := [2, 8] be multisets over

N. Then M1 ≤m M2 since 8 can be replaced by 3, 3, 3, 7 and 2 by 1, 1 to

obtain M1 from M2.

We are now able to compare sets of algebras by comparing the corre-

sponding multisets of cardinalities using ≤m. A set of finite L-algebras

A := {A1, . . . ,An} will be called a minimal generating set for the quasi-
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variety Q(A1, . . . ,An) if for every set of finite L-algebras B := {B1, . . . ,Bk}:

Q(A) = Q(B) implies [|A1|, . . . , |An|] ≤m [|B1|, . . . , |Bk|].

The smallest free algebra FK(n), n ∈ N, that generates the quasivariety

Q(FK(ω)) is called the minimal generating free algebra for Q(FK(ω)). By

Theorem 2.18 such a free algebra must exist.

Although it may seem counter-intuitive to say that twenty algebras with

three elements are an improvement over one single four element algebra,

the measure ≤m is a good choice for comparing generating sets. Check-

ing a quasiequation with r variables in a finite algebra A requires checking

|A|r assignments of variables to elements of A. But then checking validity

in {A1, . . . ,An} will involve checking fewer assignments of variables than

checking validity in {B1, . . . ,Bk} if [|A1|, . . . , |An|] ≤m [|B1|, . . . , |Bk|] for

quasiequations with sufficiently many variables1.

Given a finitely generated quasivariety, we would like to calculate a mini-

mal generating set. To do this, we need the following decomposition lemma:

Lemma 3.2. Let K be a class of L-algebras and suppose that K′ is obtained

from K by either (a) replacing A ∈ K with A1, . . . ,An where A is a Q(K)-

subdirect product of A1, . . . ,An, or (b) replacing A,B ∈ K with B where

A ∈ IS(B). Then Q(K) = Q(K′).

Proof. Assume that K is a class of L-algebras. If A is a Q(K)-subdirect

product of A1, . . . ,An, then A ∈ ISP(A1, . . . ,An) ⊆ Q(A1, . . . ,An) and

A1, . . . ,An ∈ Q(K). Hence Q(K) = Q(K′), where K′ is obtained from K

by replacing A with A1, . . . ,An. On the other hand, if A ∈ IS(B), then

A ∈ IS(K \ {A}) ⊆ Q(K \ {A}) and hence Q(K) = Q(K′), where K′ is

obtained from K by replacing A,B ∈ K with B.

In particular, replacing each algebra A in a finite set K of finite algebras with

1In the example above where we have twenty three element algebras or one single four-
element algebra, we need at least eleven variables to see the advantage with respect to
≤m, since 20 · 3r < 4r for r ≥ 11.
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the Q(K)-subdirectly irreducible algebras in some Q(K)-subdirect represen-

tation of A, then removing any algebra that embeds into another algebra

in the set, produces a minimal generating set for Q(K) that is unique up to

isomorphism.

Theorem 3.3. Suppose that Q := Q(A1, . . . ,An) where Ai is a finite Q-

subdirectly irreducible algebra for i ∈ {1, . . . , n} and Ai 6∈ IS(Aj) for j 6= i.

Then {A1, . . . ,An} is the unique minimal generating set for Q up to isomor-

phism.

Proof. Let Q := Q(A1, . . . ,An) where Ai is a finite Q-subdirectly irreducible

algebra for i ∈ {1, . . . , n} and Ai 6∈ IS(Aj) for j 6= i. Suppose for a con-

tradiction that Q := Q(B1, . . . ,Bk) and [|B1|, . . . , |Bk|] <m [|A1|, . . . , |An|].

Without loss of generality, we can suppose that Bj is Q-subdirectly irre-

ducible for j ∈ {1, . . . , k}; otherwise, by Theorem 2.8 and Lemma 3.2, Bj can

be replaced with the Q-subdirectly irreducible components of a Q-subdirect

representation of Bj and we obtain a smaller (according to ≤m) generating

set of algebras for Q.

It follows that there exists a largest r ∈ N such that there are strictly

more occurrences of r in [|A1|, . . . , |An|] than in [|B1|, . . . , |Bk|], and for each

r′ > r, the number of occurrences of r′ in [|A1|, . . . , |An|] and [|B1|, . . . , |Bk|]

are equal. Each Ai is finite and Q-subdirectly irreducible, and hence by

Lemma 2.9, embeds into some Bj where |Ai| ≤ |Bj|. If every Ai of size

r embeds into, and is hence isomorphic to, a Bj of size r, then (by the

pigeonhole principle) there must be two isomorphic algebras in {A1, . . . ,An},

a contradiction. Hence, suppose without loss of generality that A1 embeds

into B1 with |A1| = r and |B1| > r. But notice now that B1 is also Q-

subdirectly irreducible and hence embeds into some Ai with i ∈ {2, . . . , n}.

So A1 ∈ IS(Ai), a contradiction.

Finally, consider any minimal generating set {B1, . . . ,Bk} for Q, and

suppose for a contradiction that Bi 6∈ I(A1, . . . ,An) for some i ∈ {1, . . . , k}.

Then by Lemma 2.9, Bi properly embeds into Aj for some j ∈ {1, . . . , n}.

But also by Lemma 2.9, Aj embeds into Bd for some d ∈ {1, . . . , k} \ {i}.
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It follows that Bi can be embedded into the strictly larger algebra Bd. But

then {B1, . . . ,Bk} is not a minimal generating set for Q, a contradiction.

Hence, to calculate a minimal generating set for a finitely generated quasiva-

riety Q(K), we should find Q(K)-subdirect products with Q(K)-irreducible

components of the algebras in K. Recalling the connection between sub-

direct representations of a given algebra A and sets of congruences on A

(see Theorem 2.10), it would appear to be a good idea to calculate the set

ConQ(K)(A), the universe of a sublattice of the lattice of congruences Con(A)

(see [49, Corollary 1.4.11]). It is known that the problem of finding the con-

gruence closure for a given equivalence relation on a finite algebra, i.e., the

smallest congruence containing this equivalence, can be solved in polynomial

time2. The problem of finding the Q-congruence closure of an equivalence

relation on a finite algebra with respect to a finitely generated quasivariety

Q appears to be much harder, however. Instead, we use here the follow-

ing characterization of Q-subdirectly irreducible algebras without needing to

calculate the Q-congruence lattice.

Lemma 3.4. Let K be a finite set of finite L-algebras and A ∈ Q(K). Then

the following are equivalent:

(1) A is Q(K)-subdirectly irreducible.

(2)
⋂
{θ ∈ Con(A) \ {∆A} : A/θ ∈ IS(K)} 6= ∆A.

Proof. For convenience, let

Θ := {θ ∈ Con(A) \ {∆A} : A/θ ∈ IS(K)} ⊆ ConQ(K)(A).

(1) ⇒ (2) We proceed contrapositively. If
⋂

Θ = ∆A, then by Corol-

lary 2.11(a), A is a Q(K)-subdirect product of algebras in {A/θ : θ ∈ Θ}.

But also by Corollary 2.11(b), since ∆A 6∈ Θ, A is not Q(K)-subdirectly

irreducible.

2This was used in [33] to provide a polynomial time algorithm for calculating a subdirect
representation of a finite algebra. We refer to [24] for the definitions of complexity classes.
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(2) ⇒ (1) Again, we proceed contrapositively and assume that A is not

Q(K)-subdirectly irreducible. By combining Theorem 2.8 and Corollary 2.11,

there exist (θi)i∈I ⊆ ConQ(K)(A) \ {∆A} such that
⋂

i∈I θi = ∆A and A

is a Q(K)-subdirect product of Q(K)-subdirectly irreducible algebras A/θi

(i ∈ I). But then we have A/θi ∈ IS(K) for each i ∈ I by Lemma 2.9, so

(θi)i∈I ⊆ Θ, and hence
⋂

Θ = ∆A.

We now have all the ingredients necessary to describe the algorithm Min-

GenSet (see Algorithm 3.1) that calculates the (unique up to isomorphism)

minimal generating set for a finitely generated quasivariety.

Theorem 3.5. For a finite set K of finite L-algebras, MinGenSet(K) re-

turns the (unique up to isomorphism) minimal generating set for Q(K).

Proof. Let Q := Q(K). By Theorem 3.3, it suffices to find a set of Q-

subdirectly irreducible algebras that generates Q, where no member of the

set embeds into another member of the set. The algorithm proceeds by con-

sidering each A ∈ K in turn. First, the congruence lattice Con(A) is gener-

ated (line 10) by checking for all equivalence relations if they are congruences.

Next, the congruences θ ∈ Con(A) \ {∆A} such that A/θ embeds into A

or some other member of K are collected in sets S1 and S2, respectively. If
⋂

(S1 ∪S2) 6= ∆A, then A is Q-subdirectly irreducible by Lemma 3.4, so the

algorithm proceeds to the next algebra in K. Otherwise
⋂

(S1 ∪ S2) = ∆A

and by Lemma 3.4, A is not Q-subdirectly irreducible. In this case, for each

θ ∈ S1\S2, the algebra A/θ is added to K (line 15) and A is removed from K

(line 17). Note that since the cardinalities of the added algebras are strictly

smaller than the cardinality of the removed algebra, the new set of algebras

is smaller according to the multiset ordering ≤m. Hence this procedure is ter-

minating. Moreover, the resulting finite set of finite algebras must generate

the quasivariety Q (by Lemma 3.2), contain only Q-subdirectly irreducible

algebras, and not contain any algebra that embeds into another member of

the set (lines 22–26). Hence MinGenSet(K) is the minimal generating set

of Q(K) up to isomorphism by Theorem 3.3.
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Algorithm 3.1 MinGenSet(K): For a finite set K of finite algebras, return
the minimal generating set of Q(K).

1: function MinGenSet(K)

2: declare S1, S2, C : set

3: declareM : list

4: declare A : algebra

5: declare i : integer

6: M← list(K)

7: i← 1

8: while i ≤ length(M) do

9: A←M[i]

10: C ← Con(A) \ {∆A}

11: S1 ← {θ ∈ C : A/θ embeds into A}

12: S2 ← {θ ∈ C : A/θ embeds into some M[j] 6= A}

13: if
⋂

(S1 ∪ S2) = ∆A then

14: for all θ in S1 \ S2 do

15: add A/θ to M

16: end for

17: remove A from M

18: else

19: i← i + 1

20: end if

21: end while

22: for all A in M do

23: if A embeds into some M[j] 6= A then

24: remove A from M

25: end if

26: end for

27: return set(M)

28: end function
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We remark that although the algorithm MinGenSet does not need to

calculate the Q-congruence lattice, already calculating the congruence lattice

of a finite algebra can take exponential time EXPTIME. Moreover, the algo-

rithm repeatedly checks for embeddings, which is in general an NP-complete

problem (see [78, 13]).

3.2 Unification

For a class of L-algebras K, a set of L-equations Σ is said to be K-unifiable, if

there is a homomorphism σ : TmL → TmL (often called a substitution) such

that |=K σ(ϕ) ≈ σ(ψ) for all ϕ ≈ ψ ∈ Σ. In this case we call σ a K-unifier

of Σ and say that it K-unifies Σ.

Note that a finite set Σ of L-equations is K-unifiable if and only if the L-

negative clause Σ⇒ ∅ is not K-admissible. Or equivalently, when K contains

a non-trivial algebra, if and only if the L-quasiequation Σ⇒ x ≈ y with x, y

not occurring in Σ is not K-admissible.

We will prove in Theorem 3.7 that for checking K-unifiability for a given

set of L-equations Σ, it suffices to find a smallest subalgebra C of the free

algebra FK(1), noting that this is FK(0) if the language L contains constants.

Then Σ isK-unifiable if and only if Σ is C-valid, and indeed there is no smaller

algebra with this property. First, however, we prove a useful lemma:

Lemma 3.6. Let K and K′ be classes of L-algebras. Then the following are

equivalent:

(1) Σ is K-unifiable iff Σ is K′-satisfiable.

(2) V-(K′) = V-(FK(ω)).

Proof. Recall (from Section 2.2) that V-(K′) = V-(FK(ω)) is equivalent to

the condition that an L-negative clause Σ ⇒ ∅ is K′-valid iff it is FK(ω)-

valid. However, Σ ⇒ ∅ is K′-valid iff Σ is not K′-satisfiable and Σ ⇒ ∅ is

FK(ω)-valid iff Σ is not FK(ω)-satisfiable. For the equivalence of (1) and (2),
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it suffices therefore to show that Σ is FK(ω)-satisfiable iff Σ is K-unifiable.

Suppose first that h : TmL → FK(ω) satisfies Σ. Then any homomorphism

σ : TmL → TmL defined such that σ(x) ∈ h(x) for each variable x is a

K-unifier of Σ. Conversely, if σ is a K-unifier of Σ, then the homomorphism

h : TmL → FK(ω) defined by h(x) := σ(x)/ΨK(ω) for each variable x satisfies

Σ as required.

Theorem 3.7. Let K be a class of L-algebras and A ∈ S(FK(ω)).

(a) Σ is K-unifiable iff Σ is A-satisfiable.

(b) If A is a smallest finite subalgebra of FK(ω) and K′ is a class of L-

algebras such that Σ is K-unifiable iff Σ is K′-satisfiable, then |A| ≤ |B|

for each B ∈ K′.

Proof. (a) By assumption, A ∈ V-(FK(ω)), so V-(A) ⊆ V-(FK(ω)). But

also, since A ∈ S(FK(ω)) ⊆ V(FK(ω)) = V(K) by Corollary 2.16 and

FK(ω) = FV(K)(ω) has the universal mapping property for V(K) over count-

ably infinitely many generators, we obtain a homomorphism h : FK(ω)→ A

defined by h(x) := a for every variable x for some fixed a ∈ A. But then

h[FK(ω)] is a subalgebra of A. Hence FK(ω) ∈ H−1S(A) ⊆ V-(A). So

V-(FK(ω)) ⊆ V-(A) and the result follows by Lemma 3.6.

(b) Let A be a smallest finite subalgebra of FK(ω) and suppose that

K′ is a class of L-algebras such that Σ is K-unifiable iff Σ is K′-satisfiable.

Then by Lemma 3.6 and part (a), V-(K′) = V-(FK(ω)) = V-(A). Hence if

B ∈ K′ ⊆ V-(K′) = V-(FK(ω)) = V-(A) = H−1SP∗
U (A) = H−1(A), then

clearly |A| ≤ |B|.

Example 3.8. De Morgan algebras are algebras 〈A,∧,∨,¬,⊥,⊤〉 such that

〈A,∧,∨,⊥,⊤〉 is a bounded distributive lattice satisfying the following equa-

tions:

involution ¬¬x ≈ x

De Morgan laws ¬(x ∧ y) ≈ ¬x ∨ ¬y

¬(x ∨ y) ≈ ¬x ∧ ¬y.
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The variety DMA of De Morgan algebras is generated as a quasivariety by

the De Morgan algebra D4 illustrated below (the negation is indicated by the

dotted arrows):

bc

bc bc

bc

⊥

a b

⊤

Since there are constants in the language of D4, the smallest algebra for

checking DMA-unifiability is the two element ground algebra FD4
(0): i.e., the

two element Boolean algebra. That is, checking unifiability amounts to check-

ing classical satisfiability. E.g., x∧¬x ≈ x∨¬x is not DMA-unifiable, since

in the two element Boolean algebra, ⊤∧¬⊤ 6= ⊤∨¬⊤ and ⊥∧¬⊥ 6= ⊥∨¬⊥.

The case of the “constant-free” variety DML of De Morgan lattices, generated

as a quasivariety by Dℓ
4

:= 〈{⊥, a, b,⊤},∧,∨,¬〉, is not so immediate. How-

ever, there is also a smallest two element subalgebra of FDℓ
4

(ω) with elements

corresponding to x ∧ ¬x and x ∨ ¬x. So checking DML-unifiability amounts

again to checking classical satisfiability.

3.3 Admissibility

Let K be a class of L-algebras. An L-quasiequation Σ ⇒ ϕ ≈ ψ is called

K-admissible if every K-unifier σ of Σ also K-unifies ϕ ≈ ψ. More formally,

Σ⇒ ϕ ≈ ψ is K-admissible (or admissible in K) if for every homomorphism

σ : TmL → TmL:

|=K σ(ϕ′) ≈ σ(ψ′) for all ϕ′ ≈ ψ′ ∈ Σ implies |=K σ(ϕ) ≈ σ(ψ).

Actually, K-admissible quasiequations are simply the quasiequations that

are valid in FK(ω). We integrate this fact, which was already proven in [99,

Theorem 1.4.5], into the following characterization theorem.
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Theorem 3.9 ([99, Theorem 1.4.5] and [26, Theorem 2]). Let K be a class of

L-algebras and Σ ∪ {ϕ ≈ ψ} a finite set of L-equations. Then the following

are equivalent:

(1) Σ⇒ ϕ ≈ ψ is K-admissible.

(2) Σ⇒ ϕ ≈ ψ is Q(K)-admissible.

(3) Σ |=FK(ω) ϕ ≈ ψ.

(4) V(K) = V({A ∈ Q(K) : Σ |=A ϕ ≈ ψ}).

Proof. (1) ⇒ (2) Suppose Σ ⇒ ϕ ≈ ψ is K-admissible and |=Q(K) σ(ϕ′) ≈

σ(ψ′) for all ϕ′ ≈ ψ′ ∈ Σ and some homomorphism σ : TmL → TmL. By

Lemma 2.5, |=K σ(ϕ′) ≈ σ(ψ′) for all ϕ′ ≈ ψ′ ∈ Σ and since Σ⇒ ϕ ≈ ψ is K-

admissible also |=K σ(ϕ) ≈ σ(ψ). Again by Lemma 2.5, |=Q(K) σ(ϕ) ≈ σ(ψ)

and hence Σ⇒ ϕ ≈ ψ is Q(K)-admissible.

(2)⇒ (1) is similar.

(1) ⇒ (3) Suppose that Σ ⇒ ϕ ≈ ψ is K-admissible and let g : TmL →

FK(ω) be a homomorphism such that Σ ⊆ ker g. We define a map σ

that sends each variable x to a member of the equivalence class g(x). By

the universal mapping property of TmL, this extends to a homomorphism

σ : TmL → TmL. But since ν(σ(x)) = g(x) for each variable x (ν is the

natural homomorphism for the congruence ΨK(ω)), we obtain ν ◦σ = g. But

then Σ ⊆ ker(ν ◦ σ), so for each ϕ′ ≈ ψ′ ∈ Σ, we have ν(σ(ϕ′)) = ν(σ(ψ′))

and therefore |=K σ(ϕ′) ≈ σ(ψ′). Hence by assumption, |=K σ(ϕ) ≈ σ(ψ),

and g(ϕ) = ν(σ(ϕ)) = ν(σ(ψ)) = g(ψ) as required.

(3) ⇒ (1) Suppose that Σ |=FK(ω) ϕ ≈ ψ and let σ : TmL → TmL

be a homomorphism such that |=K σ(ϕ′) ≈ σ(ψ′) for each ϕ′ ≈ ψ′ ∈ Σ

and hence ν(σ(ϕ′)) = ν(σ(ψ′)). By assumption, ν(σ(ϕ)) = ν(σ(ψ)). Hence

|=K σ(ϕ) ≈ σ(ψ) as required.

We define Q′ := {A ∈ Q(K) : Σ |=A ϕ ≈ ψ} for the rest of the proof.

(3) ⇒ (4) Suppose that Σ |=FK(ω) ϕ ≈ ψ. Then FK(ω) ∈ Q′ and,

using Corollary 2.17 and Lemma 2.13, V(K) = V(FK(ω)) ⊆ V(Q′), hence

V(K) = V(Q′) since Q′ ⊆ Q(K) ⊆ V(K).
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(4) ⇒ (2): Suppose V(K) = V(Q′) and let σ : TmL → TmL be a ho-

momorphism such that |=Q(K) σ(ϕ′) ≈ σ(ψ′) for all ϕ′ ≈ ψ′ ∈ Σ. Since

Σ |=Q′ ϕ ≈ ψ and Q′ ⊆ Q(K), |=Q′ σ(ϕ) ≈ σ(ψ) and by assumption,

|=K σ(ϕ) ≈ σ(ψ). Hence by Lemma 2.5, |=Q(K) σ(ϕ) ≈ σ(ψ) as required.

Example 3.10. The following quasiequations, expressing meet and join semi-

distributivity for L := {∧,∨} are satisfied by all free lattices (see [64, Lemma

2.6]), and are therefore admissible in the variety of lattices.

x ∧ y ≈ x ∧ z ⇒ x ∧ y ≈ x ∧ (y ∨ z)

x ∨ y ≈ x ∨ z ⇒ x ∨ y ≈ x ∨ (y ∧ z).

Given a class K of L-algebras, we are interested in determining when the

K-admissibility of quasiequations coincides with their K′-validity in another

class of L-algebrasK′. By Theorem 3.9, this is the case exactly when Q(K′) =

Q(FK(ω)). The next result provides a further useful characterization of this

situation.

Theorem 3.11. Let K be a class of L-algebras and Σ∪ {ϕ ≈ ψ} a finite set

of L-equations. Then the following are equivalent:

(1) Σ⇒ ϕ ≈ ψ is K-admissible iff Σ |=K′ ϕ ≈ ψ.

(2) Q(K′) = Q(FK(ω)).

(3) K′ ⊆ Q(FK(ω)) and K ⊆ V(K′).

Proof. (1)⇔ (2) follows directly from Theorem 3.9.

(2)⇒ (3) Suppose that Q(K′) = Q(FK(ω)). Then clearlyK′ ⊆ Q(FK(ω)).

Moreover, V(K′) = V(Q(K′)) = V(Q(FK(ω))) = V(FK(ω)) = V(K), so

K ⊆ V(K′).

(3) ⇒ (2) Suppose that K′ ⊆ Q(FK(ω)) and K ⊆ V(K′). Then clearly

Q(K′) ⊆ Q(FK(ω)). But also V(K) ⊆ V(K′) ⊆ V(Q(FK(ω))) = V(FK(ω)) =

V(K). That is, V(K) = V(K′). Hence FK(ω) = FK′(ω) ∈ Q(K′) and

Q(FK(ω)) ⊆ Q(K′).
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For checking K-admissibility, we make use of a known result for finitely

generated quasivarieties (see [99, Lemma 4.1.10]), obtained here as a corollary

of Theorem 3.11:

Corollary 3.12. Let K be a finite set of finite L-algebras with n := max{|A| :

A ∈ K}.

(a) Q(FK(ω)) = Q(FK(n)).

(b) Σ⇒ ϕ ≈ ψ is K-admissible iff Σ |=FK(n) ϕ ≈ ψ.

Proof. Observe first that each A ∈ K is a homomorphic image of FK(n).

That is, define any surjective map from the n generators of FK(n) to A; this

extends to a surjective homomorphism from FK(n) onto A since FK(n) has

the universal mapping property for K over n generators. So K ⊆ V(FK(n))

and, since also FK(n) ∈ Q(FK(ω)), (a) and (b) follow by Theorem 3.11.

Hence, since the finitely generated free algebra FK(n) is finite when K is

a finite set of finite algebras (see Lemma 2.12), checking K-admissibility of

quasiequations is decidable. However, even when K consists of a small num-

ber of small algebras, free algebras on a small number of generators can be

quite large. For example, the free algebra FD4
(2) (see Example 3.8) has 168

elements. We therefore seek smaller algebras or finite sets of smaller algebras

that also generate Q(FK(ω)) as a quasivariety. In fact, since Q(FK(ω)) is

finitely generated, we may apply the multiset ordering ≤m and seek a min-

imal generating set of finite algebras for this quasivariety that is unique up

to isomorphism. One strategy would therefore be to apply the algorithm

MinGenSet directly to FK(n). However, this method is not feasible for

large free algebras, since it involves the computationally labor-intensive task

of building the congruence lattice of FK(n). Instead, we make use of the

following corollary of Theorem 3.11:

Corollary 3.13. Let K be a class of L-algebras and K′ ⊆ S(FK(ω)) such

that K ⊆ H(K′).
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(a) Q(K′) = Q(FK(ω)).

(b) Σ⇒ ϕ ≈ ψ is K-admissible iff Σ |=K′ ϕ ≈ ψ.

Hence, given a class K of L-algebras, we might seek a set K′ of smallest

subalgebras (according to ≤m) of the free algebra FK(ω) such that K ⊆ H(K′)

to reduce the complexity of checking admissibility. Note, however, that this

set K′ might not be the minimal generating set for Q(FK(ω)).

Example 3.14. Consider the algebra G106 := 〈{a, b, c}, ◦〉 with the binary

operation ◦ defined as follows (see also Appendix A):

◦ a b c

a a a a

b a b b

c a c b

The minimal generating free algebra for Q(FG106
(ω)) has two generators

and ten elements. There are 21 subalgebras of FG106
(2) which are pre-

homomorphic images of G106, out of 93 subalgebras in total (see filled dots

in Figure 3.1). The two smallest subalgebras A with G106 ∈ H(A) have

four elements, but MinGenSet(Q(FG106
(2))) consists of two algebras B1 :=

〈{a, b}, ◦〉, B2 := 〈{a, b}, ◦〉 with

◦B1 a b ◦B2 a b

a a b a b a

b b b b b b

and hence A is not the best choice with respect to the multiset ordering ≤m.

We combine the idea of decomposition via the algorithm MinGenSet

and the search for subalgebras of the minimal generating free algebra that still

generate the quasivariety, using Corollary 3.13, into the algorithm AdmAlgs

(see Algorithm 3.2). This algorithm calculates the (unique up to isomor-
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Figure 3.1: Lattice of subuniverses of the algebra FG106
(2).

phism) minimal generating set for Q(FK(ω)) for a finite set K of finite L-

algebras.

Theorem 3.15. For a finite set K of finite L-algebras, AdmAlgs(K) re-

turns the (unique up to isomorphism) minimal generating set for Q(FK(ω)).

Proof. Let K be a finite set of finite L-algebras. When AdmAlgs is applied

to K, first D := MinGenSet(K) is calculated, which typically is a small

set of small algebras with Q(K) = Q(D) (see Theorem 3.5). We know by

Theorem 2.18 that Q(FK(ω)) = Q(FD(n)) where n := max{|D| : D ∈ D}.

By Corollary 3.13 it even suffices that the free algebras are prehomomorphic

images of the algebras in D. Such free algebras are calculated in line 7 for

each A ∈ D by the procedure3 Free(A,D), which returns the smallest

free algebra FD(n), n ≤ |A|, with A ∈ H(FD(n)). (The procedure begins by

checking the smallest free algebra FD(0) or FD(1), then increases the number

of generators one at a time.) The algorithm then searches for progressively

smaller subalgebras of FD(m) which have A as a homomorphic image. More

precisely, the procedure SubPreHom(A,B) searches for a proper subalgebra

of B that is a homomorphic image of A, returning B if no such algebra

exists (line 9). This process terminates with a (hopefully reasonably small)

3We obviously do not calculate the same free algebra twice in the implementation.
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Algorithm 3.2 AdmAlgs(K): For a finite set K of finite algebras, return
the minimal generating set of Q(FK(ω)).

1: function AdmAlgs(K)

2: declare A,D : set

3: declare B,B′ : algebra

4: D ← MinGenSet(K)

5: A ← ∅

6: for all A ∈ D do

7: B← Free(A,D)

8: B′ ← SubPreHom(A,B)

9: while B′ 6= B do

10: B← B′

11: B′ ← SubPreHom(A,B)

12: end while

13: add B to A

14: end for

15: return MinGenSet(A)

16: end function
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algebra which is added to a set A. Again using Corollary 3.13, Q(A) =

Q(FK(ω)). Finally, the procedure MinGenSet is applied to A to get the

minimal generating set of Q(FK(ω)) by Theorem 3.5.

3.4 Structural Completeness

We now turn our attention to classes of algebras for which admissibility and

validity of quasiequations coincide. More formally, a class K of L-algebras is

said to be structurally complete if for any L-quasiequation Σ⇒ ϕ ≈ ψ:

Σ⇒ ϕ ≈ ψ is K-admissible iff Σ |=K ϕ ≈ ψ.

We say that A is structurally complete if {A} is structurally complete.

Using Theorem 3.9, this is true if and only if Q(K) = Q(FK(ω)) and leads

to the following useful characterization, which also includes the equivalent

condition proved by Berman [9]:

Theorem 3.16 ([9, Proposition 2.3]). Let K be a class of L-algebras. Then

the following are equivalent:

(1) K is structurally complete.

(2) Q(K) = Q(FK(ω)).

(3) Q′ ⊂ Q(K) for some quasivariety Q′ implies V(Q′) ⊂ V(K).

Proof. (1) ⇔ (2) Let K be a class of L-algebras and Σ ⇒ ϕ ≈ ψ any L-

quasiequation. By the definition of structural completeness and Theorem 3.9,

Σ |=K ϕ ≈ ψ iff Σ⇒ ϕ ≈ ψ is K-admissible iff Σ |=FK(ω) ϕ ≈ ψ as required.

(2)⇒ (3) Suppose that Q(K) = Q(FK(ω)) and, for a contradiction, that

Q′ ⊂ Q(K) and V(Q′) = V(K) for some quasivariety Q′. But then Q(K) ⊆

Q(FK(ω)) = Q(FQ′(ω)) ⊆ Q′ by Corollaries 2.15 and 2.16, a contradiction.

(3)⇒ (2) Assume that V(Q′) ⊂ V(K) for every quasivariety Q′ ⊂ Q(K).

Using Lemma 2.13 it is clear that Q(FK(ω)) ⊆ Q(K). Suppose for a contra-
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diction that Q(FK(ω)) ⊂ Q(K), so V(FK(ω)) ⊂ V(K) by assumption, which

is a contradiction by Corollaries 2.16 and 2.17.

This provides a method for establishing structural completeness for quasi-

varieties. A quasivariety Q is structurally complete if each member of a class

of algebras generating Q as a quasivariety can be embedded into the free

algebra FQ(ω), since then any quasiequation failing in one of the generating

algebras also fails in FQ(ω). More precisely:

Theorem 3.17 ([30, Theorem 3.3]). Let K be a class of L-algebras and

suppose that for each A ∈ K, there is a map gA : A → TmL such that

ν ◦ gA embeds A into FK(ω), where ν is the natural homomorphism (see

Section 2.3). Then K is structurally complete.

Proof. Let K be a class of L-algebras and suppose that each A ∈ K embeds

into FK(ω). Q(FK(ω)) ⊆ Q(K) by Lemma 2.13. On the other hand A ∈

IS(FK(ω)) ⊆ Q(FK(ω)) for each A ∈ K, hence Q(K) ⊆ Q(FK(ω)) and K is

structurally complete by Theorem 3.16.

Combining this result with Corollary 2.19 we obtain:

Corollary 3.18. Let K be a finite set of finite L-algebras and suppose that

for each A ∈ K, there is a map gA : A→ TmL such that ν◦gA embeds A into

FK(m), where m := max{|A| : A ∈ K}. Then K is structurally complete.

Example 3.19. Consider the variety BA of Boolean algebras, generated as

a quasivariety by the two element Boolean algebra B2 (see Example 2.4).

Define g(0) := ⊥ and g(1) := ⊤. Then ν ◦ g is a homomorphism embedding

B2 into FBA(0) and hence BA is structurally complete.

If a quasivariety Q is not structurally complete, then the question arises

of how to characterize the Q-admissible quasiequations. Let Q and Q′ be

quasivarieties for a language L and let Λ be a set of L-quasiequations. Sup-

pose that A ∈ Q′ if and only if both A ∈ Q and each quasiequation in Λ

holds in A. Then Λ axiomatizes Q′ relative to Q. In particular, if Q(FQ(ω))
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is axiomatized by Λ relative to Q, then we call Λ a basis for the admissible

quasiequations of Q.

Example 3.20. Rozière [94] (see also [95]) and Iemhoff [56] proved indepen-

dently that the the set {Vn : n = 1, 2, . . . } of quasiequations Vn forms a basis

for the admissible quasiequations of the variety of Heyting algebras, where Vn

is defined as

(
n∧

i=1

(xi → yi)→ (xn+1 ∨ xn+2)) ∨ z ≈ ⊤ ⇒
n+2∨

j=1

(
n∧

i=1

(xi → yi)→ xj) ∨ z ≈ ⊤.

Since Q(FQ(ω)) ⊆ Q for any quasivariety Q, finding a basis for the admis-

sible quasiequations of Q essentially involves finding a set of quasiequations

that are admissible in Q and that axiomatize a structurally complete quasi-

variety relative to Q. More precisely:

Theorem 3.21. Let Q and Q′ be L-quasivarieties and let Λ be a set of L-

quasiequations axiomatizing Q′ relative to Q. Suppose that Q′ is structurally

complete and that each quasiequation in Λ is admissible in Q. Then Λ is a

basis for the Q-admissible quasiequations.

Proof. It suffices to show that Q′ = Q(FQ(ω)). If each quasiequation in Λ

is admissible in Q, then by Theorem 3.9, each quasiequation in Λ holds in

FQ(ω). Hence FQ(ω) ∈ Q′ and Q(FQ(ω)) ⊆ Q′. Suppose for a contradiction

that Q(FQ(ω)) ⊂ Q′. Since Q′ is structurally complete, V(Q) = V(FQ(ω)) =

V(Q(FQ(ω))) ⊂ V(Q′) by Corollaries 2.16 and 2.17. But Q′ ⊆ Q, so V(Q′) ⊆

V(Q), a contradiction.

We now present another characterization of structural completeness. We

have already seen in Theorem 3.17 that whenever each algebra of a given

class K embeds into the free algebra FK(ω), then K is structurally complete.

The converse is not true in general.

Example 3.22. Consider the four element algebra P := 〈{a, b, c, d}, ∗〉 where

the unary operation ∗ and the free algebras FP(n) are described by Figure 3.2.
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aP

b

c d

FP(n)

x1 ∗(x1) ∗(∗(x1))

b

b

b

xn ∗(xn) ∗(∗(xn))

Figure 3.2: The algebra P and its free algebras FP(n).

We calculate that MinGenSet({P}) = MinGenSet({FP(2)}) = {FP(1)},

where FP(2) is the minimal generating free algebra for FP(ω). Hence Q(P) =

Q(FP(1)) = Q(FP(ω)) and P is structurally complete by Theorem 3.16. But

P can not be embedded into FP(n) for any n ∈ N since there is no element

b′ ∈ FP(n) that is the ∗-image of three pairwise different other elements.

It turns out that we have to check the embeddings for the minimal generating

sets to have a nice characterization of structural completeness4:

Theorem 3.23. Let K be a finite set of finite L-algebras. Then the following

are equivalent:

(1) K is structurally complete.

(2) MinGenSet(K) ⊆ IS(FK(n)) where n := max{|C| : C ∈ K}.

Proof. (1) ⇒ (2) If K is structurally complete, then, by Theorem 3.16 and

Corollary 3.12, Q(K) = Q(FK(ω)) = Q(FK(n)) where n := max{|C| : C ∈

K}. So MinGenSet(K) ⊆ Q(FK(n)). But each A ∈ MinGenSet(K) is

Q(FK(n))-subdirectly irreducible, so by Lemma 2.9, A embeds into FK(n).

I.e., MinGenSet(K) ⊆ IS(FK(n)).

(2) ⇒ (1) Suppose that each A ∈ MinGenSet(K) embeds into FK(n).

Then Q(FK(n)) ⊆ Q(K) = Q(MinGenSet(K)) ⊆ Q(FK(n)). So K is struc-

turally complete by Theorem 3.16.

4Note that Rybakov has a similar result in the context of logics possessing an analogue
of the deduction theorem (see [99, Theorem 5.1.4]).
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Note that we can reduce the number of generators of the free algebra in which

we embed the minimal generating set of K, using Corollaries 2.16 and 3.13:

Corollary 3.24. Let K be a finite set of finite L-algebras. Then the following

are equivalent:

(1) K is structurally complete.

(2) MinGenSet(K) ⊆ IS(FK(n)) where n is the smallest natural number

such that MinGenSet(K) ⊆ H(FK(n)).

3.5 Almost Structural Completeness

For certain classes, admissibility and validity coincide for quasiequations with

unifiable premises. More precisely, we call a class K of L-algebras almost

structurally complete if it satisfies the condition:

Σ⇒ ϕ ≈ ψ is K-admissible iff Σ |=K ϕ ≈ ψ or Σ is not K-unifiable.

Theorem 3.25. Let K be a class of L-algebras and B ∈ S(FK(ω)). Then

the following are equivalent:

(1) K is almost structurally complete.

(2) Q({A×B : A ∈ K}) = Q(FK(ω)).

(3) {A×B : A ∈ K} ⊆ Q(FK(ω)).

Proof. (1) ⇒ (2) Suppose that K is almost structurally complete. To estab-

lish Q({A×B : A ∈ K}) = Q(FK(ω)), it suffices to show that a quasiequation

Σ⇒ ϕ ≈ ψ is valid in all algebras A×B for A ∈ K iff it is valid in FK(ω).

Suppose first that Σ |=FK(ω) ϕ ≈ ψ. Then by Theorem 3.9, either Σ is not

K-unifiable or Σ ⇒ ϕ ≈ ψ is K-valid. In the first case, by Theorem 3.7,

Σ is not B-satisfiable, so Σ ⇒ ϕ ≈ ψ is valid in A × B for all A ∈ K. In

the second case, Σ ⇒ ϕ ≈ ψ is valid in A × B ∈ Q(K) for all A ∈ K.
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Conversely, if Σ⇒ ϕ ≈ ψ is valid in A×B for each A ∈ K, then either Σ is

not B-satisfiable or Σ⇒ ϕ ≈ ψ is valid in each A in K. In the first case, by

Theorem 3.7, Σ is not K-unifiable, so Σ ⇒ ϕ ≈ ψ is valid in FK(ω). In the

second case, Σ⇒ ϕ ≈ ψ is valid in Q(K) and hence valid in FK(ω).

(2) ⇒ (1) Suppose that Q(FK(ω)) = Q({A × B : A ∈ K}). Then

whenever Σ⇒ ϕ ≈ ψ is K-admissible, it is FK(ω)-valid and hence also valid

in A×B for all A ∈ K. Moreover, if Σ is K-unifiable, then, by Theorem 3.7,

it is B-satisfiable. I.e., there exists a homomorphism h : TmL → B with

Σ ⊆ ker h. For any A ∈ K and homomorphism k : TmL → A with Σ ⊆ ker k,

define eA : TmL → A×B by eA(u) := (k(u), h(u)). Then, since Σ⇒ ϕ ≈ ψ

is valid in A×B for all A ∈ K, Σ ⊆ ker e, so e(ϕ) = e(ψ) and k(ϕ) = k(ψ).

I.e., Σ |=A ϕ ≈ ψ. So we have shown that Σ |=K ϕ ≈ ψ.

(2) ⇒ (3) Immediate.

(3) ⇒ (2) Suppose that {A×B : A ∈ K} ⊆ Q(FK(ω)). Then also, since

A ∈ H(A×B) for each A ∈ K, we obtain K ⊆ V({A×B : A ∈ K}). Hence

by Theorem 3.11, Q({A×B : A ∈ K}) = Q(FK(ω)).

Example 3.26. Consider the Wajsberg algebras with two and three elements

L2 := 〈{0, 1},→,¬〉 and L3 := 〈{0, 1
2
, 1},→,¬〉 where

x→ y := min(1, 1− x+ y) and ¬x := 1− x.

L2 embeds into FL3
(ω) via 0 7→ [¬(x → x)], 1 7→ [x → x] and hence is

(isomorphic to) a subalgebra of FL3
(ω). The algebra L3 × L2 embeds into

FL3
(ω), as illustrated in the diagram below by the terms associated to el-

ements, and has L3 as a homomorphic image, as indicated by the arrows.

Hence by Corollary 3.13 and Theorem 3.25, L3 is almost structurally com-

plete. However, it is not structurally complete since, e.g., x ≈ ¬x⇒ x ≈ y is

L3-admissible, but not L3-valid. On the other hand, its implicational reduct

L→
3

:= 〈{0, 1
2
, 1},→〉 is structurally complete, since it embeds into FL→

3
(2)

(see Theorem 3.17).
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bc

bc

bc

bc

bc

bc
bc

bc

bc

[¬(ϕ→ ¬ϕ)]

[ϕ]

[ϕ→ ϕ]

[ϕ→ ¬ϕ]

[¬ϕ]

[¬(ϕ→ ϕ)]

1

1
2

0

ϕ := (x→ ¬x)→ ¬x

We now are able to prove a characterization for almost structural com-

pleteness similar to Theorem 3.23:

Theorem 3.27. Let K be a finite set of finite L-algebras, B ∈ S(FK(ω)) and

n := max{|C| : C ∈ K}. Then the following are equivalent:

(1) K is almost structurally complete.

(2) MinGenSet({A×B : A ∈ K}) ⊆ IS(FK(n)).

Proof. (1)⇒ (2) If K is almost structurally complete, then by Theorem 3.25

and Corollary 3.12, Q({A × B : A ∈ K}) = Q(FK(ω)) = Q(FK(n)) where

n := max{|C| : C ∈ K}. In particular, MinGenSet({A × B : A ∈

K}) ⊆ Q(FK(n)). But each C ∈ MinGenSet({A × B : A ∈ K}) is

Q(FK(n))-subdirectly irreducible, so by Lemma 2.9, C embeds into FK(n).

I.e., MinGenSet({A×B : A ∈ K}) ⊆ IS(FK(n)).

(2) ⇒ (1) If MinGenSet({A × B : A ∈ K}) ⊆ IS(FK(n)), then {A ×

B : A ∈ K} ⊆ Q(FK(n)) = Q(FK(ω)). So by Theorem 3.25, K is almost

structurally complete.

3.6 Clone Equivalences

This section makes a useful observation regarding clone equivalent algebras:

There is no need to calculate free algebras, minimal generating sets or the
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property of structural completeness twice, if the operations of two algebras

on the same universe are inter-definable. However, checking whether two

finite algebras are clone equivalent is EXPTIME-complete (see [11]).

Recall from Section 2.1 that clones of operations are defined on a fixed

universe and hence two clone equivalent algebras A and B are isomorphic

in the language L = CloA = CloB. The next theorem states that the free

algebras and the minimal generating sets of the quasivarieties generated by

the free algebras on countably infinitely many generators are clone equivalent

for clone equivalent algebras. Hence if we calculated the minimal generating

free algebra FA(n) for Q(FA(ω)), we only need to translate the operations

from the language of A into the language of B to get the minimal generating

free algebra FB(n) for Q(FB(ω)).

Theorem 3.28. Let A and B be two clone equivalent finite algebras.

(a) FA(n) ≈clo FB(n) for all natural numbers n ≥ m, where m is the

maximal arity of the operations on A and B.

(b) Any member of a minimal generating set for Q(FA(ω)) has exactly one

clone equivalent member in a minimal generating set for Q(FB(ω)).

(c) A is structurally complete iff B is structurally complete.

(d) A is almost structurally complete iff B is almost structurally complete.

Proof. (a) Clon A = Clon B for any n greater than the maximal arity of

the operaions on A and B by the assumption, so FA(n) ≈clo FB(n) follows

directly from FA(k) ∼= Clok A for any k ∈ N (see [10, Exercise 4.34.3]),

where Clon A is the algebra with universe Clon A and the natural induced

operations.

(b) follows from (a) since FA(n) ∼= FB(n) in L = Clon A.

(c), (d) then follow directly from (a),(b) using Theorems 3.23 and 3.27.
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3.7 Finite-Valued Logics

For algebraizable logics, admissible rules may be translated into admissible

quasiequations and vice versa (see [21]). The characterizations of admissi-

bility we have seen in the preceding sections can be adapted to finite-valued

logics. Unlike the algebraic case we have to treat here the designated val-

ues of the logic, i.e., the truth values considered true. Here we describe a

method that given a finite-valued logic L, provides another (hopefully small)

finite-valued logic L′ such that validity in L′ corresponds to admissibility in

L. The more general case, where we search for a smallest finite set of logics

such that validity in all members of the set corresponds to admissibility in a

logic (or logics), will not be considered here.

Recall that a finite-valued logic L := (A, D) for a language L consists of

a finite L-algebra A and a set of designated values D ⊆ A. Given Γ∪{ϕ} ⊆

TmL, we let Γ ⊢L ϕ denote that for all homomorphisms h : TmL → A,

whenever h[Γ] ⊆ D, also h(ϕ) ∈ D. A term ϕ is L-valid if ⊢L ϕ.

Consider now a finite-valued logic L := (A, D) for a language L and a

finite set of terms Γ ⊆ TmL. We say that Γ is L-unifiable if there exists

a homomorphism σ : TmL → TmL such that ⊢L σ(ψ) for all ψ ∈ Γ and

call σ in this case an L-unifier of Γ. A rule is a pair 〈Γ, ϕ〉, Γ ∪ {ϕ} ⊆ TmL

finite, where the elements of Γ are called the premises and ϕ the conclusion of

the rule. The pair 〈{σ(ϕ1), . . . , σ(ϕn)}, σ(ϕ)〉 is called an instance of the rule

〈{ϕ1, . . . , ϕn}, ϕ〉, where σ is a substitution on TmL. A rule 〈{ϕ1, . . . , ϕn}, ϕ〉

named ⊛ is usually written as

ϕ1, . . . , ϕn / ϕ or
ϕ1, . . . , ϕn

ϕ ⊛.

A rule Γ / ϕ is said to be L-admissible if every L-unifier of Γ is an L-

unifier of ϕ. Note that if L is an algebraizable logic (see [21]) with equivalent

quasivarietyQ and translationsE and ∆, then the rule Γ / ϕ is L-admissible if

and only if the quasiequation E[Γ]⇒ E(ϕ) is Q-admissible. Now if we define

the finite-valued logic L∗ := (FA(|A|), D∗) where D∗ := {[ϕ] ∈ FA(|A|) : ⊢L
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ϕ}, then we obtain the following analogue of Theorem 3.9.

Theorem 3.29. Let L := (A, D) be a finite-valued logic for a language L.

Then Γ / ϕ is L-admissible iff Γ ⊢L∗ ϕ.

Proof. (⇒) Suppose that Γ / ϕ is L-admissible and let h : TmL → FA(|A|)

be a homomorphism such that h[Γ] ⊆ D∗. We define a map σ that sends each

variable x to a member of the equivalence class h(x). By the universal map-

ping property of TmL, this extends to a homomorphism σ : TmL → TmL.

But since ν(σ(x)) = h(x) for each variable x (ν is the natural homomorphism

for the congruence ΨA(|A|)), we obtain ν ◦ σ = h. So for each ψ ∈ Γ, we

have ν(σ(ψ)) ∈ D∗ and therefore ⊢L σ(ψ). Hence by assumption, ⊢L σ(ϕ),

and h(ϕ) = ν(σ(ϕ)) ∈ D∗ as required.

(⇐) Suppose that Γ ⊢L∗ ϕ and let σ : TmL → TmL be a unifier of

Γ, i.e., ⊢L σ(ψ) for all ψ ∈ Γ and hence ν(σ(ψ)) ∈ D∗. By assumption,

ν(σ(ϕ)) ∈ D∗. Hence ⊢L σ(ϕ) as required.

The next result may then be understood as an analogue of Theorem 3.11.

Theorem 3.30. Let L := (A, DA) and L′ := (B, DB) be finite-valued logics

for a language L such that B is a subalgebra of FA(|A|), DB = D∗
A ∩B and

there exists a surjective homomorphism h : B → A satisfying h[DB] ⊆ DA.

Then Γ / ϕ is L-admissible iff Γ ⊢L′ ϕ.

Proof. If Γ / ϕ is L-admissible, then by Lemma 3.29, Γ ⊢L∗ ϕ. Since B ≤

FA(|A|) and DB = D∗
A ∩ B, also Γ ⊢L′ ϕ. Conversely, suppose that Γ ⊢L′ ϕ

and that σ is an L-unifier of Γ. Notice that if ⊢L ψ, then ⊢L∗ ψ and ⊢L′

ψ. So σ is also an L∗-unifier and L′-unifier of Γ. But σ(Γ) ⊢L′ σ(ϕ) and

therefore ⊢L′ σ(ϕ). Now consider any homomorphism e : TmL → A. Since

h is a surjective homomorphism from B to A, there exists a homomorphism

k : A→ B such that h◦k is the identity map on A. But ⊢L′ σ(ϕ) and hence

k ◦ e ◦ σ(ϕ) ∈ DB. Therefore e ◦ σ(ϕ) = h ◦ k ◦ e ◦ σ(ϕ) ∈ h[DB] ⊆ DA. So

⊢L σ(ϕ).
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Example 3.31. The three-valued  Lukasiewicz logic  L3 and Jaśkowski logic

J3 may both be presented using the three element Wajsberg algebra L3 (Ex-

ample 3.26) but with 1 as designated value for  L3 and 1
2

and 1 as designated

values for J3. That is,  L3 := (L3, {1}) and J3 := (L3, {
1
2
, 1}). In this case,

there is a smallest subalgebra of FL3
(ω) isomorphic to L3 × L2 with a sur-

jective homomorphism that maps L3 × L2 onto L3 and sends the inherited

designated values (1, 1) to 1 and (1
2
, 1) to 1

2
. We therefore obtain a logic

(L3 × L2, {(1, 1)}) corresponding to admissibility in  L3, and another logic

(L3 × L2, {(
1
2
, 1), (1, 1)}) corresponding to admissibility in J3.

3.8 Automatically Generated Proof Systems

Here we show how proof systems for admissibility and validity can be gen-

erated using the system MUltlog [101]. We first give a brief overview of the

most important definitions; please refer to [110] for a detailed introduction.

Let L := (Alg, D) be an n-valued logic for a language L. A sequent Γ of L

is an n-tuple Γa1 | . . . | Γan of finite sequences Γai of L-terms, where Alg :=

{a1, . . . , an}. The Γai are called the components of Γ. Let h : TmL → Alg

be a homomorphism (also called an interpretation). h satisfies a sequent Γ

if there is an a ∈ A such that h(ϕ) = a for some L-term ϕ ∈ Γa. In this

case, h is called a model of Γ, written h |= Γ. Γ is called satisfiable if there

is an interpretation h such that h |= Γ and valid if for every interpretation

h, h |= Γ. The sequent calculus SCL for the logic L is given by the following

rules:

• an axiom for every L-term ϕ:

ϕ | . . . | ϕ
axϕ

• weakening rules for every truth value ak:

Γ1 | . . . | Γn

Γ1 | . . . | Γk, ϕ | . . . | Γn

weakak
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• exchange rules for every truth value ak:

Γ1 | . . . | Γk, ϕ, ψ,∆k | . . . | Γn

Γ1 | . . . | Γk, ψ, ϕ,∆k | . . . | Γn

exchak

• contraction rules for every truth value ak:

Γ1 | . . . | Γk, ϕ, ϕ | . . . | Γn

Γ1 | . . . | Γk, ϕ | . . . | Γn

contak

• cut rules for every two truth values ak 6= al:

Γ1 | . . . | Γk, ϕ | . . . | Γn ∆1 | . . . | ∆l, ϕ | . . . | ∆n

Γ1,∆1 | . . . | Γn,∆n

cutakal

• an introduction rule5 ∗ak for every connective ∗ and truth value ak.

A finite tree P of sequents is called a proof in the sequent calculus SCL if

every leaf is an axiom of SC, and all other sequents are obtained from their

children by applying one of the rules of SC. The sequent at the root of P is

called its end-sequent . A sequent Γ is called provable in SC, written ⊢SC Γ,

if it is the end-sequent of some proof in SC. Soundness, completeness and

cut-elimination for SC are proved in [110].

Note that the choice of designated values for the logic L does not affect

the structure of the rules of the sequent calculus SC. Also, if we want to

check whether an L-equation or L-quasiequation is valid in L, the choice of

designated values does not change anything.

Let us now consider the three element algebra G9 := 〈{0, 1, 2}, ∗〉 with

the binary operation ∗ where x∗y := 2 when x = 2 and y ∈ {1, 2}, x∗y := 0

otherwise (see also Appendix A). We input this information to the tool

MUltlog (see Figure 3.3) which then outputs, amongst many other things,

the introduction rules for the operation ∗ (see Figure 3.4). Intuitively, the

5We leave out a proper explanation of the construction of these logical rules here, but
will present the concrete introduction rules in the upcoming examples.
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logic "G9".

truth_values { 0 , 1 , 2 }.

designated_truth_values { 2 }.

operator( ast/2, table [

0, 1, 2,

0, 0, 0, 0,

1, 0, 0, 0,

2, 0, 2, 2

]

).

Figure 3.3: Input file G9.lgc for the system MUltlog.

rule ∗0 of Figure 3.4 expresses the fact that ϕ ∗ ψ takes value 0 under some

interpretation h : TmL → G9 whenever h(ϕ) = 0 or h(ψ) = 0 or h(ϕ) = 1.

I.e., the stroke “|” denotes “or” between different values of the underlying

logic while the comma “,” denotes “or” between different formulas of the

sequents. Together with the structural rules explained above they build the

proof system SCG9
to check validity in G9.

Γ1, ϕ, ψ | Γ2, ϕ | Γ3

Γ1, ϕ ∗ ψ | Γ2 | Γ3

∗0

Γ1 | Γ2 | Γ3

Γ1 | Γ2, ϕ ∗ ψ | Γ3

∗1

Γ1 | Γ2, ψ | Γ3, ψ Γ1 | Γ2 | Γ3, ϕ

Γ1 | Γ2 | Γ3, ϕ ∗ ψ
∗2

Figure 3.4: The introduction rules for the operation ∗ of G9.

Using the tool MUltseq (see [47]), the companion of MUltlog, we can check

whether the following quasiequation holds in G9 (we write x2 to denote (x∗x)

for convenience):

x2 ≈ y ∗ x2, x ∗ y ≈ y ∗ x2, y ∗ x ≈ y2 ⇒ y ∗ x ≈ y ∗ x2. (3.1)

The output of MUltseq tells us that proving (3.1) is equivalent to proving
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the following sequents6, which is not possible and hence (3.1) does not hold

in G9. MUltseq even provides a counterexample: x = 1, y = 2.

y ∗ x, y2 | x2, x ∗ y, y ∗ x2 | x2, x ∗ y, y ∗ x, y2, y ∗ x2

y ∗ x, y2 | x2, x ∗ y, y ∗ x, y2, y ∗ x2 | x2, x ∗ y, y ∗ x2

x2, x ∗ y, y ∗ x2 | y ∗ x, y2 | x2, x ∗ y, y ∗ x, y2, y ∗ x2

x2, x ∗ y, y ∗ x, y2, y ∗ x2 | y ∗ x, y2 | x2, x ∗ y, y ∗ x2

x2, x ∗ y, y ∗ x2 | x2, x ∗ y, y ∗ x, y2, y ∗ x2 | y ∗ x, y2

x2, x ∗ y, y ∗ x, y2, y ∗ x2 | x2, x ∗ y, y ∗ x2 | y ∗ x, y2

Using TAFA (see Chapter 5) we calculate the minimal generating free algebra

for Q(FG9
(ω)) which has two generators and seven elements. Calculating

MinGenSet(FG9
(2)) returns AdmG9 := 〈{a, b, c, d}, ∗〉 with

∗ a b c d

a c d c d

b b b d d

c c d c d

d d d d d

MUltlog then calculates the introduction rules for the operation ∗ of the alge-

bra AdmG9 (see Figure 3.5). Running MUltseq with the input for AdmG9

(see Figure 3.6) confirms that the quasiequation (3.1) is provable in SCAdmG9

and hence is G9-admissible. It is also possible to output proof trees of specific

sequents. In this case (here with one out of twelve sequents to check for the

proof of (3.1)) MUltseq then also outputs a skeleton of the proof as follows7

((ϕ)ai means that the term ϕ stands in the i-th position of the sequent):

Proof skeleton of [(x ∗ x)a, (x ∗ x)c, (x ∗ x)d, (x ∗ y)a, (x ∗ y)c, (x ∗ y)d, (y ∗

6It is not hard to see that checking the validity of an equation ϕ ≈ ψ for, e.g., a
three-valued algebra, is equivalent to checking the validity of the three sequents ϕ | ψ | ψ,
ψ | ϕ | ψ and ψ | ψ | ϕ. This idea is then extended combinatorially to quasiequations.

7The right upper side of the proof tree (which is obviously equal to the left part) is
abbreviated here because of the space.
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Γ1 | Γ2 | Γ3 | Γ4

Γ1, ϕ ∗ ψ | Γ2 | Γ3 | Γ4

∗a

Γ1, ψ | Γ2, ψ | Γ3 | Γ4 Γ1 | Γ2, ϕ | Γ3 | Γ4

Γ1 | Γ2, ϕ ∗ ψ | Γ3 | Γ4

∗b

Γ1, ψ | Γ2 | Γ3, ψ | Γ4 Γ1, ϕ | Γ2 | Γ3, ϕ | Γ4

Γ1 | Γ2 | Γ3, ϕ ∗ ψ | Γ4

∗c

Γ1 | Γ2, ϕ, ψ | Γ3 | Γ4, ϕ, ψ Γ1, ϕ | Γ2 | Γ3, ϕ, ψ | Γ4, ϕ, ψ

Γ1 | Γ2 | Γ3 | Γ4, ϕ ∗ ψ
∗d

Figure 3.5: The introduction rules for the operation ∗ of AdmG9.

x)a, (y∗x)b, (y∗x)c, (y∗y)a, (y∗y)b, (y∗y)c, (y∗(x∗x))a, (y∗(x∗x))c, (y∗(x∗x))d]:

4

8

11 12
10

∗b

9
∗a

7
∗d 14

17

21
23 23

22
∗c

20
∗b

19
∗a

24
18

∗c

16
∗b

15
∗a

13
∗d

6
∗c

5
∗a

3
∗d

....
3

2
∗c

1
∗a

Table of sequents8:

1. [(x ∗ x)a, (x ∗ x)c, (x ∗ x)d, (x ∗ y)a, (x ∗ y)c, (x ∗ y)d, (y ∗ x)a, (y ∗ x)b, (y ∗

x)c, (y ∗ y)a, (y ∗ y)b, (y ∗ y)c, (y ∗ (x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

2. [(x ∗ x)c, (x ∗ x)d, (x ∗ y)a, (x ∗ y)c, (x ∗ y)d, (y ∗ x)a, (y ∗ x)b, (y ∗ x)c, (y ∗

y)a, (y ∗ y)b, (y ∗ y)c, (y ∗ (x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

3. [xa, xc, (x ∗ x)d, (x ∗ y)a, (x ∗ y)c, (x ∗ y)d, (y ∗ x)a, (y ∗ x)b, (y ∗ x)c, (y ∗

y)a, (y ∗ y)b, (y ∗ y)c, (y ∗ (x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

8Note that we can apply axiom rules to the leaves of the proof tree, e.g., axx to no. 4.
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% admgnine - specification of a sequent calculus for AdmG9

option(tex_rulenames(on)).

truth_values([a,b,c,d]).

designated_truth_values([d]).

% Definition of the operation ast.

tex_op((A*B), ["(", A, bslash, "ast ", B, ")"]).

rule((A*B)^a, [[]], asta).

rule((A*B)^b, [[B^a,B^b],[A^b]], astb).

rule((A*B)^c, [[B^a,B^c],[A^a,A^c]], astc).

rule((A*B)^d, [[A^b,A^d,B^b,B^d],[A^a,A^c,A^d,B^c,B^d]], astd).

tex_rn(asta, ["{", bslash, "ast_a}"]).

tex_rn(astb, ["{", bslash, "ast_b}"]).

tex_rn(astc, ["{", bslash, "ast_c}"]).

tex_rn(astd, ["{", bslash, "ast_d}"]).

% Test the derivability of a sequent

ts(s1, [(a*a)^a,(a*a)^c,(a*a)^d,(a*b)^a,(a*b)^c,(a*b)^d,

(b*a)^a,(b*a)^b,(b*a)^c,(b*b)^a,(b*b)^b,(b*b)^c,(b*(a*a))^a,

(b*(a*a))^c,(b*(a*a))^d]).

% Test the validity of a quasiequation

tqe(qe1, [a*a=b*(a*a),a*b=b*(a*a),b*a=b*b], b*a=b*(a*a)).

tex_opname(a, ["x"]).

tex_opname(b, ["y"]).

Figure 3.6: Input file admgnine.lgc for the system MUltseq.
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4. [xa, xb, xc, xd, (x∗y)a, (x∗y)c, (x∗y)d, (y∗x)a, (y∗x)b, (y∗x)c, (y∗y)a, (y∗

y)b, (y ∗ y)c, (y ∗ (x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

5. [xa, xc, xd, (x∗y)a, (x∗y)c, (x∗y)d, (y ∗x)a, (y ∗x)b, (y ∗x)c, (y ∗y)a, (y ∗

y)b, (y ∗ y)c, (y ∗ (x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

6. [xa, xc, xd, (x∗ y)c, (x∗ y)d, (y ∗x)a, (y ∗x)b, (y ∗x)c, (y ∗ y)a, (y ∗ y)b, (y ∗

y)c, (y ∗ (x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

7. [xa, xc, xd, ya, yc, (x ∗ y)d, (y ∗ x)a, (y ∗ x)b, (y ∗ x)c, (y ∗ y)a, (y ∗ y)b, (y ∗

y)c, (y ∗ (x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

8. [xa, xb, xc, xd, ya, yb, yc, yd, (y ∗ x)a, (y ∗ x)b, (y ∗ x)c, (y ∗ y)a, (y ∗ y)b, (y ∗

y)c, (y ∗ (x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

9. [xa, xc, xd, ya, yc, yd, (y ∗x)a, (y ∗x)b, (y ∗x)c, (y ∗y)a, (y ∗y)b, (y ∗y)c, (y ∗

(x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

10. [xa, xc, xd, ya, yc, yd, (y ∗ x)b, (y ∗ x)c, (y ∗ y)a, (y ∗ y)b, (y ∗ y)c, (y ∗ (x ∗

x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

11. [xa, xb, xc, xd, ya, yc, yd, (y ∗x)c, (y ∗y)a, (y ∗y)b, (y ∗y)c, (y ∗(x∗x))a, (y ∗

(x ∗ x))c, (y ∗ (x ∗ x))d]

12. [xa, xc, xd, ya, yb, yc, yd, (y ∗x)c, (y ∗y)a, (y ∗y)b, (y ∗y)c, (y ∗(x∗x))a, (y ∗

(x ∗ x))c, (y ∗ (x ∗ x))d]

13. [xa, xc, xd, (x ∗ y)d, (y ∗x)a, (y ∗x)b, (y ∗x)c, (y ∗ y)a, (y ∗ y)b, (y ∗ y)c, (y ∗

(x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

14. [xa, xb, xc, xd, yb, yd, (y ∗x)a, (y ∗x)b, (y ∗x)c, (y ∗y)a, (y ∗y)b, (y ∗y)c, (y ∗

(x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

15. [xa, xc, xd, yc, yd, (y ∗ x)a, (y ∗ x)b, (y ∗ x)c, (y ∗ y)a, (y ∗ y)b, (y ∗ y)c, (y ∗

(x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

16. [xa, xc, xd, yc, yd, (y∗x)b, (y∗x)c, (y∗y)a, (y∗y)b, (y∗y)c, (y∗(x∗x))a, (y∗

(x ∗ x))c, (y ∗ (x ∗ x))d]
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17. [xa, xb, xc, xd, yc, yd, (y ∗ x)c, (y ∗ y)a, (y ∗ y)b, (y ∗ y)c, (y ∗ (x ∗ x))a, (y ∗

(x ∗ x))c, (y ∗ (x ∗ x))d]

18. [xa, xc, xd, yb, yc, yd, (y ∗ x)c, (y ∗ y)a, (y ∗ y)b, (y ∗ y)c, (y ∗ (x ∗ x))a, (y ∗

(x ∗ x))c, (y ∗ (x ∗ x))d]

19. [xa, xc, xd, yb, yc, yd, (y∗y)a, (y∗y)b, (y∗y)c, (y∗(x∗x))a, (y∗(x∗x))c, (y∗

(x ∗ x))d]

20. [xa, xc, xd, yb, yc, yd, (y∗y)b, (y∗y)c, (y∗(x∗x))a, (y∗(x∗x))c, (y∗(x∗x))d]

21. [xa, xc, xd, ya, yb, yc, yd, (y ∗ y)c, (y ∗ (x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

22. [xa, xc, xd, yb, yc, yd, (y ∗ y)c, (y ∗ (x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

23. [xa, xc, xd, ya, yb, yc, yd, (y ∗ (x ∗ x))a, (y ∗ (x ∗ x))c, (y ∗ (x ∗ x))d]

24. [xa, xc, xd, ya, yb, yc, yd, (y ∗ y)a, (y ∗ y)b, (y ∗ y)c, (y ∗ (x ∗ x))a, (y ∗ (x ∗

x))c, (y ∗ (x ∗ x))d]
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Chapter 4

Case Studies

In this chapter, we make use of the methods and theorems of the previous

chapter to investigate admissibility for some well-known (classes of) alge-

bras, obtaining new structural completeness, almost structural completeness

and axiomatization results. We start with the proof that every two element

algebra is structurally complete (Section 4.1). Section 4.2 investigates ad-

missibility for three element algebras with one binary operation. Section 4.3

starts an investigation into admissibility of standard, bounded and pseudo-

complemented finite lattices. In Section 4.4 we present bases for admissible

quasiequations for De Morgan and Kleene algebras and lattices. Section 4.5

studies reducts of Sugihara monoids and Section 4.6 finally summarizes the

obtained results1.

4.1 Two Element Algebras

In this section we prove that that admissibility in a two element algebra A

coincides with validity in this algebra A, i.e., that every two element algebra

is structurally complete. We remark that another proof of this fact was given

by Rautenberg in [89, Corollary 1] by proving that each two element algebra

generates a minimal quasivariety (compare Theorem 3.16).

1Note that most of the calculations in this chapter were done with TAFA (see Chapter 5).

63



c10
0 0
1 0

c11
0 1
1 1

id
0 0
1 1

¬
0 1
1 0

c20 0 1
0 0 0
1 0 0

∧ 0 1
0 0 0
1 0 1

6→ 0 1
0 0 0
1 1 0

idx 0 1
0 0 0
1 1 1

6← 0 1
0 0 1
1 0 0

idy 0 1
0 0 1
1 0 1

6↔ 0 1
0 0 1
1 1 0

∨ 0 1
0 0 1
1 1 1

↓ 0 1
0 1 0
1 0 0

↔ 0 1
0 1 0
1 0 1

¬y 0 1
0 1 0
1 1 0

← 0 1
0 1 0
1 1 1

¬x 0 1
0 1 1
1 0 0

→ 0 1
0 1 1
1 0 1

↑ 0 1
0 1 1
1 1 0

c21 0 1
0 1 1
1 1 1

Figure 4.1: Possible unary and binary operations on {0, 1}.

Theorem 4.1. Any two element algebra A is structurally complete.

Proof. Without loss of generality we assume that A := 〈{0, 1},F〉. By Corol-

lary 3.18 it suffices to find an embedding h : A → FA({x0, x1}). First no-

tice that there are only four unary and sixteen binary operations on the

elements 0 and 1 (see Figure 4.1). Also note that some of the binary opera-

tions are not proper binary operations in the sense that they do not depend

on both variables as, e.g., idx(x, y) := x does not depend on y. We pro-

ceed by a case distinction on F , always trying to find a suitable embedding

h : A → FA({x0, x1}). For convenience we write F for FA({x0, x1}) and we

say that 0 or 1 is definable, if some ci0 or ci1 is definable for i ∈ N, respectively.

Case 1: F = ∅. Define h(0) := [x0], h(1) := [x1]. Obviously this map

is injective and it is a homomorphism since there are no operations to be

preserved.
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Case 2: 0 is definable by F , 1 is not. Assume without loss of generality

that ci0 defines 0. Define h(0) := [ci0], h(1) := [x0]. h is injective so it

remains to show that h(⊚A(a1, . . . , an)) = ⊚F(h(a1), . . . , h(an)) for every

⊚ ∈ F and ai ∈ {0, 1}. It suffices to show that h(⊚A(0, . . . , 0, 1, . . . , 1))

= ⊚F(h(0), . . . , h(0), h(1), . . . , h(1)). Note that ⊚A(0, . . . , 0, x, . . . , x) cannot

be ¬x or 1, since otherwise 1 would be definable. So there are only two cases:

(i) If ⊚A(0, . . . , 0, x, . . . , x) = 0, then h(⊚A(0, . . . , 0, 1, . . . , 1)) = h(0) =

[ci0] and ⊚F(h(0), . . . , h(0), h(1), . . . , h(1)) = [ci0].

(ii) If ⊚A(0, . . . , 0, x, . . . , x) = x, then h(⊚A(0, . . . , 0, 1, . . . , 1)) = h(1) =

[x0] and ⊚F(h(0), . . . , h(0), h(1), . . . , h(1)) = [x0].

Case 3: 1 is definable by F , 0 is not. Very similar to the preceding case.

Case 4: Both 0 and 1 are definable by F . Assume without loss of gener-

ality that ci0 defines 0 and cj1 defines 1. The map defined by h(0) := [ci0] and

h(1) := [cj1] is certainly injective and preserves every operation ⊚ of F .

Case 5: F 6= ∅ only contains unary and binary operations, but 0 and 1 are

not definable by F . Since F only contains unary or binary operations, all the

possible operations on A are listed in Figure 4.1. But the following operations

cannot be in F since they define 0 or 1: c10, c
1
1, c

2
0, c

2
1, ←, →, ↔, 6←, 6→, 6↔,

↓ and ↑, as e.g., (x ↑ x) ↑ x = 1. We also do not need to consider binary

operations depending only on one variable (c20, c
2
1, idx, idy, ¬x, ¬y) since they

are preserved by any homomorphism preserving the unary operations. Since

id is compatible with every operation, we only have to consider cases where

F contains ¬, ∧ or ∨. Note that ¬ cannot occur together with ∧ or ∨, since

then 0 and 1 would be definable (e.g., ¬x ∧ x = 0).

(i) F = {¬}: Define h(0) := [x0], h(1) := [¬x0]. This map is injective and

h(¬Ax) = ¬Fh(x) since h(¬A0) = h(1) = [¬x0] = ¬F[x0] = ¬Fh(0)

and h(¬A1) = h(0) = [x0] = ¬F[¬x0] = ¬Fh(1).

(ii) F = {∧}: Let h(0) := [x0 ∧ x1], h(1) := [x0]. This map is injective.

Also
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– h(0∧A 0) = h(0) = [x0∧x1] = [x0∧x1]∧
F [x0∧x1] = h(0)∧F h(0).

– h(0 ∧A 1) = h(0) = [x0 ∧ x1] = [x0 ∧ x1] ∧
F [x0] = h(0) ∧F h(1).

– h(1 ∧A 0) = h(0) = [x0 ∧ x1] = [x0] ∧
F [x0 ∧ x1] = h(1) ∧F h(0).

– h(1 ∧A 1) = h(1) = [x0] = [x0] ∧
F [x0] = h(1) ∧F h(1).

(iii) F = {∨}: Dual to the previous case with h(0) := [x0] and h(1) :=

[x0 ∨ x1].

(iv) F = {∧,∨}: The map defined by h(0) := [x0∧x1] and h(1) := [x0∨x1]

is injective and (the preservation of ∨ is shown dually)

– h(0∧A 0) = h(0) = [x0∧x1] = [x0∧x1]∧
F [x0∧x1] = h(0)∧F h(0).

– h(0∧A 1) = h(0) = [x0∧x1] = [x0∧x1]∧
F [x0∨x1] = h(0)∧F h(1).

– h(1∧A 0) = h(0) = [x0∧x1] = [x0∨x1]∧
F [x0∧x1] = h(1)∧F h(0).

– h(1∧A 1) = h(1) = [x0∨x1] = [x0∨x1]∧
F [x0∨x1] = h(1)∧F h(1).

Case 6: F 6= ∅ and F contains operations with arity greater than two, but

0 and 1 are not definable by F . Let G be the set of all unary and binary oper-

ations obtained by using at most two different parameters of operations in F .

A ternary operation ⊚ ∈ F , for example, produces {⊚xxx,⊚xxy,⊚xyx,⊚yxx} ⊆

G, where, e.g., ⊚xxy(x, y) := ⊚(x, x, y). By assumption G fits into (i)–(iv)

of the previous case. Define the appropriate embedding h from 〈A,G〉 into

〈F,G〉. Indeed, this also embeds A into F. Since A has only two elements,

it suffices to prove that for an arbitrary n-ary operation symbol ⊚ ∈ F

h(⊚A(x0, . . . , x0, x1, . . . , x1)) = ⊚
F(h(x0), . . . , h(x0), h(x1), . . . , h(x1)).

But by the definition of G there is a binary g ∈ G such that g〈A,G〉(x0, x1) =

⊚A(x0, . . . , x0, x1, . . . , x1), so h(⊚A(x0, . . . , x0, x1, . . . , x1)) = h(g〈A,G〉(x0, x1)).

With the fact that h embeds 〈A,G〉 into 〈F,G〉 we get h(g〈A,G〉(x0, x1)) =

g〈F,G〉(h(x0), h(x1)) = ⊚F(h(x0), . . . , h(x0), h(x1), . . . , h(x1)) as required.
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Figure 4.2: Cardinality of the minimal generating free algebras for Q(FG(ω))
(x-axis) and the number of corresponding clone equivalence classes (y-axis).

4.2 Three Element Groupoids

An algebra G having exactly one binary operation ⋆ is called a groupoid . The

goal of the present section is to investigate the minimal generating sets of

the quasivarieties Q(FG(3)) for all three element groupoids G := 〈{0, 1, 2}, ⋆〉

(see also [16]). Using Theorems 3.23 and 3.27 we also check which groupoids

are (almost) structurally complete. Furthermore we calculate the size of the

smallest subalgebra of the free algebra FG(3) suitable for checking unifiability

in the quasivariety generated by the groupoid G (see Theorem 3.7).

There are 3330 different groupoids up to isomorphism (out of 39 = 19683

in total) which build 411 classes of clone equivalent algebras. By Theo-

rem 3.28 it suffices to calculate the mentioned properties just once for each

clone equivalence class. The full list of the results obtained can be found in

Appendix A.

Figure 4.2 gives a rough idea of the distribution of the cardinalities of

the minimal generating free algebras of all clone equivalence classes. The

number of generators is not always the same to produce a free algebra of a

given cardinality and there are even sixteen cases where three generators are

needed.

The main goal was to calculate the smallest set of algebras to check admis-

sibility for all groupoids G, namely the results of MinGenSet({FG(3)}) (see
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Figure 4.3: Cardinalities of MinGenSet({FG(3)}) (x-axis) and the number
of corresponding clone equivalence classes (logarithmic scaled y-axis).

Section 3.1). For free algebras with less than 25 elements we performed Min-

GenSet directly, for the larger cases we used AdmAlgs (see Section 3.3).

The algebras of the minimal generating sets all have fewer than ten elements.

Figure 4.3 lists the multisets of cardinalities of the minimal generating sets

and for how many clone equivalence class they occur.

Performing the completeness checks to representatives of the groupoid

clone equivalence classes confirmed that 107 of the investigated algebras are

not structurally complete, of which 31 are almost structurally complete. The

remaining 304 groupoids are structurally complete.

Finally, the checks for unifiability showed that for most groupoids unifica-

tion is trivial: 344 of the groupoids have a one element algebra as subalgebra

of the free algebra FG(ω). For the remaining free algebras the smallest sub-

algebras had two (fifty-seven cases), three (eight cases) or four elements (two

cases).

4.3 Lattices

In this section we begin an investigation into admissibility in finite lattices.

For small lattices up to five elements we easily confirm structural complete-
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ness with TAFA2, i.e., validity and admissibility coincide for the quasivarieties

generated by these lattices. For some lattices, structural completeness also

follows from well-known theorems:

Example 4.2. A modular lattice L may be characterized as a lattice sat-

isfying the equation (x ∧ y) ∨ (y ∧ z) ≈ y ∧ ((x ∧ y) ∨ z). Famously, a

lattice L is non-modular if and only if the lattice L5 (often called N5) dis-

played in Table 4.1 embeds into L (see [25, Theorem I.3.5]). But since L5

is non-modular, also FL5
(ω) (which must satisfy the same equations) is non-

modular. So L5 embeds into FL5
(ω), hence L5 is structurally complete. Sim-

ilarly, it is well-known that a lattice L is distributive if and only if neither

L5 nor L4 (often called M5), also displayed in Table 4.1, embeds into L

(see [25, Theorem I.3.6]). Since L4 is non-distributive and modular, also

FL4
(ω) is non-distributive and modular. So L4 embeds into FL4

(ω), and L4

is structurally complete.

Note that bounded lattices (see Section 2.3), obtained from lattices by

just adding the constants ⊥ and ⊤ to the language L := {∧,∨}, are not

structurally complete in general:

Theorem 4.3. The smallest bounded lattice which is not structurally com-

plete has five elements.

Proof. TAFA provides embeddings from the bounded lattices with up to four

elements into the corresponding free algebras, so these lattices are struc-

turally complete by Corollary 3.18. Let Lb be the five element bounded

lattice with the universe of L4 (see Table 4.1), i.e., Lb := 〈L4,∧,∨,⊥,⊤〉.

TAFA confirms that MinGenSet(Lb) = {Lb} and that there is no embed-

ding from Lb into FLb(3), the minimal generating free algebra for Q(FLb(ω)).

Hence Lb is not structurally complete by Corollary 3.24. An example of a

quasiequation that is admissible but not valid in Lb is

x ∨ y ≈ ⊤, x ∧ z ≈ ⊥, y ∧ z ≈ ⊥ ⇒ z ≈ ⊥.
2A list of all (non-trivial) lattices up to size seven can be found on http://math.

chapman.edu/~jipsen/posets/lattices77.html.
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We were unable to check structural completeness for all six element lat-

tices since the free algebras for the lattices L9 and L10 are too big for TAFA

(e.g., the algebra FL9
(4) has 56694 elements). For all other lattices with

up to six elements (see Table 4.1) TAFA confirms structural completeness.

To our knowledge it is still an open question whether all finite lattices are

structurally complete. However, the variety of all lattices is not structurally

complete, since every free lattice satisfies the semi-distributivity laws (see

Example 3.10), but there are lattices which are not semi-distributive, e.g.,

L4 (see also [106, 80]).

We now consider a special class of distributive lattices extended not only

with ⊤ and ⊥, but also a unary operation ∗. A pseudocomplemented dis-

tributive lattice (PCL for short) is an algebra L := 〈L,∧,∨,∗ ,⊥,⊤〉 such

that 〈L,∧,∨,⊥,⊤〉 is a distributive bounded lattice and the unary operation
∗ is pseudocomplementation, i.e.,

x ∧ y = ⊥ iff y ≤ x∗.

It is known that the class of PCLs is a variety (see [90]) and that the

subdirectly irreducible pseudocomplemented distributive lattices are exactly

(up to isomorphism) Boolean algebras extended with an extra top element

corresponding to the constant ⊤ where the negation is adapted such that

both ¬⊥ = ⊤ and ¬⊤ = ⊥ hold ([67, Theorem 2]).

We have considered here the first five subdirectly irreducible PCLs, de-

picted in Figure 4.4. Note that PCL0, the smallest non-trivial PCL, is just

the two element Boolean algebra. The cardinalities of the minimal generating

free algebras and the minimal generating sets (column “M”) are listed in Ta-

ble 4.2. The algebra PCL1 generates the variety of Stone algebras (see, e.g.,

[52]), which is structurally complete. PCL2 is also structurally complete,

but not PCL3 or PCL4.
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Table 4.1: Lattices with up to six elements.

MinGenSet(L) Lattices

Lt

L0 L1 L2

L3 L6 L7

L8 L17 L18

L21 L22 L23

L4 L12 L19

L5 L14 L15

L16 L20

L9

L10

L11

L13
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Figure 4.4: The five first (non-trivial) subdirectly irreducible PCLs.

Table 4.2: Admissibility for PCLs.

Lattice Cardinality Free algebra M

PCL0 20 + 1 = 2 |FPCL0
(0)| = 2 2

PCL1 21 + 1 = 3 |FPCL1
(1)| = 6 3

PCL2 22 + 1 = 5 |FPCL2
(1)| = 7 5

PCL3 23 + 1 = 9 |FPCL3
(2)| = 625 19

PCL4 24 + 1 = 17 |FPCL4
(2)| = 626 1673

4.4 De Morgan and Kleene Algebras

This section provides bases for the admissible quasiequations of the classes

of Kleene lattices KL, Kleene algebras KA, De Morgan lattices DML and De

Morgan algebras DMA, mainly making use of Theorems 3.17 and 3.21.

Recall from Example 3.8 that De Morgan algebras are defined as algebras

〈A,∧,∨,¬,⊥,⊤〉 such that 〈A,∧,∨,⊥,⊤〉 is a bounded distributive lattice

satisfying the De Morgan laws and ¬ is an involutive negation. The class

DMA of De Morgan algebras forms a variety containing just two proper non-

trivial subvarieties: the class KA of Kleene algebras satisfying x ∧ ¬x ≤

y ∨¬y and the class BA of Boolean algebras satisfying x ≤ y ∨¬y (see [65]),

where x ≤ y stands for x ∧ y ≈ y. The classes DML, KL and BL of De

Morgan, Kleene and Boolean lattices are defined analogously by omitting the

3We have found a subalgebra of FPCL4
(2) with 167 elements which is a prehomomorphic

image of PCL4, but we were not able to confirm that this is the smallest subalgebra with
this property. Also, for the procedure MinGenSet this algebra is too big.
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constants ⊥ and ⊤ from the language. We define LDMA := {∧,∨,¬,⊥,⊤},

LDML := LDMA \ {⊥,⊤} and write Aℓ to denote the LDML-reduct of a De

Morgan algebra A. Moreover, we define the following finite members of KA

for 1 ≤ m ∈ N, with operations x ∧ y := min{x, y}, x ∨ y := max{x, y},

¬x := −x, ⊥ := −m and ⊤ := m:

C2m := 〈{−m,−m + 1, . . . ,−1, 1, . . . , m− 1, m},∧,∨,¬,⊥,⊤〉

C2m+1 := 〈{−m,−m + 1, . . . ,−1, 0, 1, . . . , m− 1, m},∧,∨,¬,⊥,⊤〉.

The “fuzzy algebra” 〈[0, 1],min,max, 1 − x, 0, 1〉 and also each Cn for any

odd n ≥ 3, generates KA as a quasivariety. In particular, KA = Q(C3) (see,

e.g. [65, 88]). Now consider the quasiequation

x ≈ ¬x ⇒ x ≈ y. (4.1)

(4.1) is not C3-valid: just consider the homomorphism h : TmLDMA
(x, y)→

C3 defined by h(x) := 0 and h(y) := 1. But there is no term ϕ such that

ϕ ≈ ¬ϕ holds in all Kleene algebras (or indeed, in all Boolean algebras).

So the quasiequation (4.1) is admissible and by Theorem 3.16, KA is not

structurally complete. However, the proper subquasivariety of KA generated

by Cn for any even n ≥ 4 is structurally complete. In particular, using

Corollary 3.18 we can show that C4 is structurally complete with the map

gC4 : C4 → TmLDMA
defined by

2 7→ ⊤

1 7→ x ∨ ¬x

−1 7→ x ∧ ¬x

−2 7→ ⊥.

Lemma 4.4. Q(C4) is axiomatized relative to KA by the quasiequation

¬x ≤ x, x ∧ ¬y ≤ ¬x ∨ y ⇒ ¬y ≤ y. (4.2)

Proof. Very similar to the proof of [88], Proposition 4.7, which states that
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Q(Cℓ
4
) is axiomatized relative to KL by the quasiequation (4.2).

Theorem 4.5. {(4.2)} is a basis for the admissible quasiequations of KA.

Proof. Q(C4) is structurally complete and axiomatized relative to KA by

{(4.2)} by Lemma 4.4. Moreover, C3 is a homomorphic image of C4, so

V(C4) = V(C3) = KA. Hence, since (4.2) holds in C4, it is admissible in

KA, and the result follows by Theorem 3.21.

Note that the quasiequation (4.1) does not provide a basis for the admissi-

ble quasiequations of KA. In fact, it axiomatizes the quasivariety Q(C3×C2)

relative to KA (see [88], Proposition 4.5). With the same reasoning we also

obtain a basis for the admissible quasiequations of KL:

Lemma 4.6 ([88, Proposition 4.7]). Q(Cℓ
4
) is axiomatized relative to KL by

the quasiequation (4.2).

Theorem 4.7. {(4.2)} is a basis for the admissible quasiequations of KL.

Proof. Using Corollary 3.18 with the map gC
ℓ
4 : Cℓ

4 → TmLDML
defined by

2 7→ (x ∨ ¬x) ∨ y

1 7→ x ∨ ¬x

−1 7→ x ∧ ¬x

−2 7→ (x ∧ ¬x) ∧ y,

Q(Cℓ
4
) is structurally complete. By Lemma 4.6, Q(Cℓ

4
) is axiomatized rel-

ative to KL by {(4.2)}. Moreover, Cℓ
3

is a homomorphic image of Cℓ
4
, so

V(Cℓ
4
) = V(Cℓ

3
) = KL. Hence, since (4.2) holds in Cℓ

4
, it is admissible in KL,

and the result follows by Theorem 3.21.

We now turn our attention to the classes of De Morgan algebras DMA and

De Morgan lattices DML (see Example 3.8 or Figure 4.5), which are gener-

ated as quasivarieties by the algebras D4 and Dℓ
4
, respectively (see [65]). De

Morgan lattices were first studied by Moisil [79] and Kalman [65], and subse-

quently, with or without the constants ⊥ and ⊤, by many other researchers.
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Figure 4.5: The De Morgan algebras D4, D42 and D̄42.

In particular, the quasivariety lattice of De Morgan lattices has been fully

characterized by Pynko in [88] (see Figure 4.6), while the more complicated

(infinite) quasivariety lattice of De Morgan algebras has been investigated by

Gaitán and Perea in [40].

As before, we use an axiomatization lemma and Theorem 3.21 to find a

basis for the admissible quasiequations of DML:

Lemma 4.8 ([88, Proposition 4.2]). Q(Dℓ
42

) is axiomatized relative to DML

by the quasiequation (4.1).

Theorem 4.9. {(4.1)} is a basis for the admissible quasiequations of DML.

Proof. By Theorem 3.16 a quasivariety Q is structurally complete if every

proper subquasivariety of Q generates a proper subvariety of V(Q). The only

non-trivial varieties of De Morgan lattices are BL = Q(Cℓ
2
), KL = Q(Cℓ

3
) and

DML = Q(Dℓ
4
). Hence by inspection of the subquasivariety lattice, the only

non-trivial structurally complete subquasivarieties of DML are BL = Q(Cℓ
2
),

Q(Cℓ
4
) and Q(Dℓ

42
) where D42 is defined as the direct product D4 ×C2

(see Figure 4.5)4. By Lemma 4.8, Q(Dℓ
42

) is axiomatized relative to DML

by {(4.1)}. Moreover, Dℓ
4

is a homomorphic image of Dℓ
42

using the first

projection homomorphism, so V(Dℓ
42

) = V(Dℓ
4
) = DML. Hence, since (4.1)

4We also easily find an embedding of Dℓ
42 into FDℓ

42

(2) using TAFA. Then Q(Dℓ
42) is

structurally complete using Corollary 3.18.
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Figure 4.6: Subquasivarieties of DML.

holds in Dℓ
42

, it is admissible in DML, and the result follows by Theorem 3.21.

The case of De Morgan algebras is more complicated since the lattice

of quasivarieties is infinite (see [40, Figure 7]). Unlike the case of DML, the

quasiequation (4.1) does not provide a basis for the admissible quasiequations

of DMA. It follows from results of Pynko [88] that {(4.1)} axiomatizes the

quasivariety Q(D42) relative to DMA. However, the quasiequation

(x ∧ ¬x) ∨ y ≈ ⊤ ⇒ y ≈ ⊤

is admissible in DMA but does not hold in the De Morgan algebra D42. So

{(4.1)} cannot suffice as a basis for the admissible quasiequations of DMA.

Let us consider instead the De Morgan algebra D̄42 obtained from D42

by adding an extra top element ⊤ and bottom element ⊥ (see Figure 4.5).

Note that D4 is a homomorphic image of D̄42 under the composition of

f : D̄42 → D42, f(⊤) := (⊤, 1), f(⊥) := (⊥, 0), f((x, y)) := (x, y) for all

(x, y) 6∈ {⊥,⊤} and the projection p21 : D42 → D4. Hence V(Q(D̄42)) =
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DMA. TAFA provides an embedding of D̄42 into the free algebra FD̄42
({x, y})

defined by

(⊥,⊥) 7→ (ϕ ∧ ψ) ∨ (¬ϕ ∧ ¬ψ) (⊤,⊤) 7→ (ϕ ∨ ψ) ∧ (¬ϕ ∨ ¬ψ)

(a,⊥) 7→ (¬ϕ ∧ ¬ψ) ∨ ϕ (a,⊤) 7→ (ϕ ∨ ψ) ∧ ¬ϕ

(b,⊥) 7→ (ϕ ∧ ψ) ∨ ¬ψ (b,⊤) 7→ (¬ϕ ∨ ¬ψ) ∧ ψ

(⊤,⊥) 7→ ϕ ∨ ¬ψ (⊥,⊤) 7→ ¬ϕ ∧ ψ,

where ϕ := x ∧ ¬x and ψ := y ∨ ¬y. Hence D̄42 is structurally complete

by Corollary 3.18, so the admissible quasiequations of DMA consist of those

quasiequations that hold in Q(D̄42).

We now present an axiomatization of the admissible quasiequations of

De Morgan algebras using also clauses and not only quasiequations. Observe

that the following clause holds in D̄42 and hence also in FDMA using V(D̄42) =

V(DMA), Theorem 2.14 and Corollary 2.16:

x ∨ y ≈ ⊤ ⇒ x ≈ ⊤, y ≈ ⊤. (4.3)

We define DMA∗ := {A ∈ DMA : A satisfies (4.1) and (4.3)}. We will show

that a quasiequation is admissible in DMA if and only if it is valid in DMA
∗.

The main idea of the proof is to reduce the question of the admissibility of a

quasiequation in DMA to the question of the admissibility of quasiequations

in DML. The following lemma will be useful in this respect. For a set of

LDMA-equations, let c(Σ) be the number of occurrences of connectives ∧, ∨

and ¬.

Lemma 4.10. For any ϕ ∈ TmLDMA
, one of the following holds:

(i) |=DMA ϕ ≈ ⊥.

(ii) |=DMA ϕ ≈ ⊤.

(iii) |=DMA ϕ ≈ ψ for some ψ ∈ TmLDML
with c(ψ) ≤ c(ϕ).

Proof. For an arbitrary ϕ ∈ TmLDMA
, we proceed by induction on the length

of the term: In the base case ϕ is atomic, i.e., ϕ = ⊥, ϕ = ⊤ or ϕ = x for

77



some variable x as required. For the inductive step suppose the assumption

holds for |ϕ| < n. Then there are three cases:

(i) ϕ = ϕ1 ∧ ϕ2. Without loss of generality we have the following cases:

– �DMA ϕ1 ≈ ⊥ ⇒ �DMA ϕ ≈ ⊥ ∧ ϕ2 = ⊥.

– �DMA ϕ1 ≈ ⊤ ⇒ �DMA ϕ ≈ ⊤ ∧ ϕ2 = ϕ2.

– �DMA ϕ1 ≈ ψ1 and �DMA ϕ2 ≈ ψ2 for some ψ1, ψ2 ∈ TmLDML
with

c(ψ1) ≤ c(ϕ1) and c(ψ2) ≤ c(ϕ2) ⇒ �DMA ϕ ≈ ψ1 ∧ ψ2 = ψ with

ψ ∈ TmLDML
and c(ψ) ≤ c(ϕ).

(ii) ϕ = ϕ1 ∨ ϕ2. Dual to the previous case.

(iii) ϕ = ¬ϕ1. There are three cases:

– �DMA ϕ1 ≈ ⊥ ⇒ �DMA ϕ ≈ ⊤.

– �DMA ϕ1 ≈ ⊤ ⇒ �DMA ϕ ≈ ⊥.

– �DMA ϕ1 ≈ ψ1 for some ψ1 ∈ TmLDML
with c(ψ1) ≤ c(ϕ1) ⇒

�DMA ϕ ≈ ¬ψ1 = ψ with ψ ∈ TmLDML
and c(ψ) ≤ c(ϕ).

Let us say that an LDMA-equation ϕ ≈ ψ is in normal form if ϕ and ψ are

either ⊥, ⊤ or members of TmLDML
.

Theorem 4.11. Let Σ⇒ ϕ ≈ ψ be an LDMA-quasiequation. Then

Σ⇒ ϕ ≈ ψ is admissible in DMA iff Σ |=DMA∗ ϕ ≈ ψ.

Proof. Suppose first that Σ |=DMA∗ ϕ ≈ ψ. Both the quasiequation (4.1) and

the clause (4.3) hold in FDMA, so FDMA ∈ DMA∗. Hence Σ |=FDMA
ϕ ≈ ψ and

by Theorem 3.9, Σ⇒ ϕ ≈ ψ is admissible in DMA.

For the other direction, it suffices, using Lemma 4.10 and Theorem 3.9,

to prove that for any finite set Σ ∪ {ϕ ≈ ψ} of LDMA-equations in normal

form:

Σ |=FDMA
ϕ ≈ ψ implies Σ |=DMA∗ ϕ ≈ ψ. (⋆)
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We prove (⋆) by induction on the lexicographically ordered pair 〈c(Σ), s(Σ)〉,

where s(Σ) be the number of equations in Σ containing ⊥ or⊤. The idea is to

successively eliminate occurrences of ⊥ and ⊤ in Σ by reducing 〈c(Σ), s(Σ)〉.

Base case. Suppose that there are no occurrences of ⊥ and ⊤ in Σ, i.e.,

s(Σ) = 0. If ϕ = ψ or {ϕ, ψ} ⊆ {⊥,⊤}, then we are done. Moreover,

if ϕ ∈ TmLDML
and ψ ∈ {⊥,⊤}, then Σ 6|=FDMA

ϕ ≈ ψ: just consider a

homomorphism from TmLDMA
to D4 that maps all the variables to a. Finally,

consider ϕ, ψ ∈ TmLDML
. Suppose that Σ |=FDMA

ϕ ≈ ψ. By Theorem 3.9,

Σ ⇒ ϕ ≈ ψ is admissible in DMA. But for any ϕ′, ψ′ ∈ TmLDML
, we have

|=DMA ϕ′ ≈ ψ′ iff |=D4
ϕ′ ≈ ψ′ iff |=Dℓ

4

ϕ′ ≈ ψ′ iff |=DML ϕ′ ≈ ψ′. So

Σ⇒ ϕ ≈ ψ is admissible in DML. Hence by Theorem 4.9, Σ⇒ ϕ ≈ ψ holds

in Q(Dℓ
42

). But every De Morgan algebra in DMA∗ is also (ignoring ⊥ and

⊤ in the language) a De Morgan lattice in Q(Dℓ
42

), so Σ |=DMA∗ ϕ ≈ ψ.

Inductive step. Given the set Σ, suppose that (⋆) holds for all ∆ and

〈c(∆), s(∆)〉 < 〈c(Σ), s(Σ)〉. We use A ⊔ B to denote the disjoint union of

two sets A and B, i.e., A ∩B = ∅. Consider the following cases:

• Σ = ∆ ⊔ {⊥ ≈ ⊤}. Then (⋆) clearly holds since Σ |=DMA∗ ϕ ≈ ψ.

• Σ = ∆ ⊔ {χ ≈ χ}. Then Σ |=FDMA
ϕ ≈ ψ implies ∆ |=FDMA

ϕ ≈ ψ and,

by the induction hypothesis, ∆ |=DMA∗ ϕ ≈ ψ. So ∆ ⊔ {χ ≈ χ} |=DMA∗

ϕ ≈ ψ as required.

• Σ = ∆⊔{χ1∨χ2 ≈ ⊥}. Suppose that ∆⊔{χ1∨χ2 ≈ ⊥} |=FDMA
ϕ ≈ ψ.

Then also ∆ ∪ {χ1 ≈ ⊥, χ2 ≈ ⊥} |=FDMA
ϕ ≈ ψ. So by the induction

hypothesis, ∆ ∪ {χ1 ≈ ⊥, χ2 ≈ ⊥} |=DMA∗ ϕ ≈ ψ. But then since

{χ1 ∨ χ2 ≈ ⊥} |=DMA∗ χi ≈ ⊥ for i = 1, 2, we obtain ∆ ⊔ {χ1 ∨ χ2 ≈

⊥} |=DMA∗ ϕ ≈ ψ as required.

• Σ = ∆⊔{χ1∨χ2 ≈ ⊤}. Suppose that ∆⊔{χ1∨χ2 ≈ ⊤} |=FDMA
ϕ ≈ ψ.

Then ∆ ∪ {χi ≈ ⊤} |=FDMA
ϕ ≈ ψ for i = 1, 2. So by the induction

hypothesis, ∆ ∪ {χi ≈ ⊤} |=DMA∗ ϕ ≈ ψ for i = 1, 2. But now,

since (4.3) holds in every algebra in DMA
∗, we have ∆ ⊔ {χ1 ∨ χ2 ≈

⊤} |=DMA∗ ϕ ≈ ψ as required.
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• Σ = ∆ ⊔ {¬χ ≈ ⊤}. Suppose that ∆ ⊔ {¬χ ≈ ⊤} |=FDMA
ϕ ≈ ψ. Then

∆ ∪ {χ ≈ ⊥} |=FDMA
ϕ ≈ ψ, so by the induction hypothesis, ∆ ∪ {χ ≈

⊥} |=DMA∗ ϕ ≈ ψ. But then also ∆ ⊔ {¬χ ≈ ⊤} |=DMA∗ ϕ ≈ ψ as

required.

• Σ = ∆ ⊔ {x ≈ ⊤}. Suppose that ∆ ⊔ {x ≈ ⊤} |=FDMA
ϕ ≈ ψ. Let ∆′

and ϕ′ ≈ ψ′ be the result of substituting every occurrence of ⊤ for x

in ∆ and ϕ ≈ ψ, respectively. Then ∆′ |=FDMA
ϕ′ ≈ ψ′. Notice that

c(∆′) = c(Σ) and s(∆′) < s(Σ). By Lemma 4.10, we can find equations

∆∗ and ϕ∗ ≈ ψ∗ in normal form such that

(a) ∆∗ |=FDMA
ϕ∗ ≈ ψ∗.

(b) c(∆∗) ≤ c(∆′) and s(∆∗) = s(∆′).

(c) ∆∗ |=DMA∗ ϕ∗ ≈ ψ∗ implies ∆ ∪ {x ≈ ⊤} |=DMA∗ ϕ ≈ ψ.

By the induction hypothesis, using 1. and 2., ∆∗ |=DMA∗ ϕ∗ ≈ ψ∗. But

then also by 3., ∆ ∪ {x ≈ ⊤} |=DMA∗ ϕ ≈ ψ as required.

• The cases Σ = ∆ ⊔ {χ1 ∧ χ2 ≈ ⊥}, Σ = ∆ ⊔ {χ1 ∧ χ2 ≈ ⊤}, Σ =

∆⊔ {¬χ ≈ ⊥} and Σ = ∆⊔ {x ≈ ⊥} are treated symmetrically to the

preceding cases.

We close this section by remarking that Cabrer and Metcalfe (see [26,

Theorem 30]) have recently used natural dualities to show that the following

quasiequations (4.4) and (4.5) provide a basis for the admissible quasiequa-

tions of DMA:

x ≤ ¬x, ¬(x ∨ y) ≤ x ∨ y, ¬y ∨ z ≈ ⊤ ⇒ z ≈ ⊤ (4.4)

x ≤ ¬x, y ≤ ¬y, x ∧ y ≈ ⊥ ⇒ x ∨ y ≤ ¬(x ∨ y) (4.5)
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4.5 Reducts of Sugihara Monoids

In this section we consider (reducts of) Sugihara monoids , members of the

variety generated by the algebras {Ze

2m
: m ≥ 1}, where

Ze

2m
:= 〈{−m,−m + 1, . . . ,−1, 1, . . . , m− 1, m},∧,∨,→,¬, e〉

with ∧ and ∨ as min and max, respectively, ¬x := −x, x → y := ¬x ∨ y if

x ≤ y and ¬x∧y otherwise, and e := 1 (see [35]). We also define the algebras

Ze := 〈Z,∧,∨,→,¬, e〉 and

Ze

2m+1
:= 〈{−m,−m + 1, . . . ,−1, 0, 1, . . . , m− 1, m},∧,∨,→,¬, e〉,

with the same definitions of the operations except that the constant e has

value 0. For any L-reduct of a Sugihara monoid A we write AL, except that

we delete the set {∧,∨,→,¬} from the superscript for convenience. The

variety of Sugihara algebras V(Z) builds the algebraic semantics (see [21])

for the relevant logic R-mingle RM, i.e., for a set of terms Γ∪ {ϕ}, Γ ⊢RM ϕ

if and only if {ψ ≈ ψ → ψ : ψ ∈ Γ} |=Z ϕ ≈ ϕ → ϕ. The logic RM as well

as the variety of Sugihara algebras have been studied intensively (see, e.g.,

[22, 35, 73, 20, 81]). Note that in particular the algebra Z→¬
3

generates the

variety of multiplicative Sugihara algebras (see [73] for details):

Theorem 4.12 ([103], see also [73, Theorem 5.1]). Let SAm be the algebraic

semantics of the {→,¬}-fragment of the logic RM, denoted RMm. Then

V(SAm) = V(Z→¬
3

).

Moreover, Q(Z→¬
3

) provides algebraic semantics5 for the logic RMm extended

by the modus-ponens-like “Avron-rule”

ϕ, (ϕ→ (ψ → ψ))→ (ϕ→ ψ) / ψ (A)

Theorem 4.13 ([73, Lemma 5.4]). Q(Z→¬
3

) builds the algebraic semantics

of RMm + (A).

5Note that the multiplication · used in [73] can be defined by x · y := ¬(x→ ¬y).
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→Ze

3 −1 0 1

−1 1 1 1

0 −1 0 1

1 −1 −1 1

→Ze

4 −2 −1 1 2

−2 2 2 2 2

−1 −2 1 1 2

1 −2 −1 1 2

2 −2 −2 −2 2

Figure 4.7: The tables for → of the algebras Ze

3
and Ze

4
.

We study here some reducts of the Sugihara monoids Ze

3
and Ze

4
with

universes {−1, 0, 1} and {−2,−1, 1, 2}, respectively. The tables of the corre-

sponding implications → are shown in Figure 4.7.

We list in Table 4.3 the results obtained when applying AdmAlgs to Ze

3

and Ze

4
, respectively, while changing the underlying language. The algebras

Z3 and Z→¬
3

are the only three element algebras of the list which are not

structurally complete, since there are quasiequations which are admissible

but not valid in the corresponding algebras. E.g., considering the truth table

for the equation

y → (x→ x) ≈ (x ∧ ¬x) ∧ (y ∧ ¬y) (4.6)

confirms that (4.6) is only satisfiable with x = y = 0 or x = y = −1.

But it is not hard to see that there cannot be any {∧,∨,→,¬}-term which

always takes value 0 or −1, respectively. Hence (4.6) is not Z3-unifiable.

So the quasiequation (4.7) is Z3-admissible, but not Z3-valid and Z3 is not

structurally complete6.

y → (x→ x) ≈ (x ∧ ¬x) ∧ (y ∧ ¬y) ⇒ x ≈ z. (4.7)

Note moreover that although Z3 and Z→¬
3

are not clone equivalent by

Theorem 3.28 and the size of their free algebras, their minimal generating

algebras are isomorphic when we define ∧ and ∨ component-wise for Z→¬
3

. In

6The argument also holds for Z→¬
3

, since (x∧¬x)∧ (y ∧¬y) = ¬(((x→ x)→ y)→ y).
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Table 4.3: Admissibility for reducts of Sugihara monoids.

A |A| Language n F(n) M SC

Ze

3
3 ∧,∨,→,¬, e 1 9 3 sc

Z3 3 ∧,∨,→,¬ 2 1296 6 asc

Z→¬
3

3 →,¬ 2 264 6 asc

Z→
3

3 → 2 60 3 sc

Z→¬e
3

3 →,¬, e 1 5 3 sc

Z→e

3
3 →, e 1 5 3 sc

Ze

4
4 ∧,∨,→,¬, e 1 64 8 asc

Z4 4 ∧,∨,→,¬ 2 20736 ? ?

Z→¬
4

4 →,¬ 2 264 6 no

Z→
4

4 → 2 60 3 no

Z→¬e
4

4 →,¬, e 1 18 6 no

Z→e

4
4 →, e 2 453 4 no

fact they are isomorphic to the product Z3 × Z2. On the other hand, Z→¬e
3

and Z→e

3
are clone equivalent, since ¬x = x→ e if e = 0.

It is remarkable that although the algebra Z→e

4
is not structurally com-

plete and not Z→e

4
-irreducible, nevertheless the algorithm AdmAlgs pro-

duces a four element algebra that is not isomorphic to Z→e

4
. For Z→

4
we even

obtain a three element algebra.

Even though the free algebra of Z4 is too big7 to run AdmAlgs({Z4})

within TAFA, it is clear that FZ4
(2) is the minimal generating free algebra

for Q(FZ4
(ω)): Since FZ4

(1) has four elements and is not isomorphic to Z4,

it cannot be a generating algebra for Q(FZ4
(ω)) by Corollary 3.13. So we

define a map h : {x, y} → Z4 by h(x) := 1, h(y) := 2. By the universal

mapping property of FZ4
(ω) for Q(Z4) this extends to a homomorphism

h : FZ4
(ω) → Z4 with h(¬x) := −1 and h(¬y) := −2. Hence h is surjective

and by Corollary 3.13, FZ4
(2) is the minimal generating free algebra for

Q(FZ4
(ω)) as required.

7The size of FZ4
(2) was calculated by the tool UACalc of Ralph Freese [38].
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4.6 Summary

We remark that all the quasivarieties Q(K) studied so far had only one gen-

erating algebra, i.e., |K| = 1. There are certainly interesting examples with

more generating algebras (see, e.g., Example 4.14 below). Nevertheless ev-

ery finitely generated quasivariety is also generated by one finite algebra, i.e.,

FK(ω) = FA1×···×An
(ω) for a finite set of finite L-algebras K := {A1, . . . ,An}

by Corollary 2.16 and A1 × · · · ×An ∈ P(K) and Ai ∈ S({A1 × · · · ×An})

using the i-th projection homomorphism for i ∈ {1, . . . , n}.

Example 4.14. Consider the two chains C2 := 〈{⊥,⊤},∧,∨,¬, c〉 and

C3 := 〈{⊥, e,⊤},∧,∨,¬, c〉 where ¬ swaps ⊥ and ⊤ and leaves e fixed and

cC2 := ⊤, cC3 := e. Individually, these algebras are structurally complete.

However, applying AdmAlgs to K := {C2,C3}, we find that K is not struc-

turally complete: both C2 and C3 are homomorphic images of the sixteen

element free algebra FK(1), and the minimal generating set for Q(FK(ω))

consists of a single four element algebra.

Table 4.4 summarizes the results (without the lattices of Table 4.1), or-

dered by the cardinalities of the algebras (first priority) and their free algebras

(second priority).
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Table 4.4: Algebras for checking admissibility. The column “n” lists the
number of generators needed to generate Q(FA(ω)), “FA(n)” the cardinality
of the minimal generating free algebra, “M” the cardinalities of the minimal
generating set for Q(FA(n)) and “SC” whether A is structurally complete
(“sc”), almost structurally complete (“asc”) or none of the two (“no”).

A |A| Language Quasivariety Q(A) n F(n) M SC

B2 2 ∧,∨,¬,⊥,⊤ Q(B2) (Exs 2.4,3.19) 0 2 2 sc

Z→¬e
3

3 →,¬, e Q(Z→¬e
3

) (Sec. 4.5) 1 5 3 sc

Z→e
3

3 →, e Q(Z→e
3

) (Sec. 4.5) 1 5 3 sc

C3 3 ∧,∨,¬,⊥,⊤ Kleene algebras (Sec. 4.4) 1 6 4 no

PCL1 3 ∧,∨,∗ ,⊥,⊤ Stone algebras (Sec. 4.3) 1 6 3 sc

G9 3 ∗ Q(G9) (Sec. 3.8) 2 7 4 no

S 3 ⊃,¬ Algebras for P1 (Sec. 5.3) 1 9 9 no

Ze
3

3 ∧,∨,→,¬, e Q(Ze
3
) (Sec. 4.5) 1 9 3 sc

G106 3 ◦ Q(G106) (Ex. 3.14) 2 10 2,2 no

L3 3 →,¬ Algebras for  L3 (Ex. 3.26) 1 12 6 asc

L→
3

3 → Algebras for  L→
3 (Ex. 3.26) 2 40 3 sc

Z→
3

3 → Algebras for RM→ (Sec. 4.5) 2 60 3 sc

Cℓ
3

3 ∧,∨,¬ Kleene lattices (Sec. 4.4) 2 82 4 no

Z→¬
3

3 →,¬ Algebras for RM→¬ (Sec. 4.5) 2 264 6 asc

Z3 3 ∧,∨,→,¬ Q(Z3) (Sec. 4.5) 2 1296 6 asc

P 4 ∗ Q(P) (Ex. 3.22) 2 6 3 sc

Z→¬e
4

4 →,¬, e Algebras for RM→¬e (Sec. 4.5) 1 18 6 no

Z→
4

4 → Q(Z→
4

) (Sec. 4.5) 2 60 3 no

Ze
4

4 ∧,∨,→,¬, e Q(Ze
4
) (Sec. 4.5) 1 64 8 asc

Dℓ
4

4 ∧,∨,¬ De Morgan lattices (Sec. 4.4) 2 166 8 asc

D4 4 ∧,∨,¬,⊥,⊤ De Morgan algebras (Sec. 4.4) 2 168 10 no

Z→¬
4

4 →,¬ Q(Z→¬
4

) (Sec. 4.5) 2 264 6 no

Z→e
4

4 →, e Algebras for RM→e (Sec. 4.5) 2 453 4 no

Z4 4 ∧,∨,→,¬ Q(Z4) (Sec. 4.5) 2 20736 ? ?

PCL2 5 ∧,∨,∗ ,⊥,⊤ Q(PCL2) (Sec. 4.3) 1 7 5 sc

PCL3 9 ∧,∨,∗ ,⊥,⊤ Q(PCL3) (Sec. 4.3) 2 625 19 no

PCL4 17 ∧,∨,∗ ,⊥,⊤ Q(PCL4) (Sec. 4.3) 2 626 ? no

85



86



Chapter 5

TAFA - A Toolbox for Finite Algebras

This chapter presents TAFA (standing for “Tool for Admissibility in Finite

Algebras”), an implementation of the algebraic tools and algorithms from

Chapter 3. Nearly all the calculations made in this thesis, in particular,

those in Chapter 4, were made using TAFA1. We implemented TAFA using

Delphi XE2, a development environment for Object Pascal. It is currently

compiled for Windows, but can easily be used on Mac and Linux using an

emulator such as Wine2. Many ideas concerning the data structures and

basic operations are taken from the source code of the Algebra Workbench

(see [104, 91]). An executable file of TAFA is available from https://sites.

google.com/site/admissibility/.

Sections 5.1 and 5.2 provide an overview of the features offered by TAFA.

Section 5.3 then gives an insight into the look-and-feel of the tool by guiding

the reader through an example session related to the paraconsistent Sette

algebra, which was introduced in [87].

1Note, however, that to calculate the size of a free algebra with more than 1500 elements
(without having the corresponding operation tables) we used UACalc [38].

2Wine can be downloaded from http://www.winehq.org/.
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5.1 Basic Operations

In order to use TAFA the user should first either define the algebras of interest

in TAFA or load some predefined (see File > Predefined algebras3) or previ-

ously stored algebras (from a file). Defining a new algebra (see File > New

algebra) includes giving it a name, labeling the elements and defining the

operations. The user can easily rename, sort, delete or edit algebras, their

elements and operations or add some comment by either double clicking the

corresponding field of the grid in the main window or using the menu Edit .

The main window of TAFA contains a list showing for each algebra its name,

cardinality, the names and arities of its operations and any comments.

TAFA can save the selected or chosen4 algebras as a binary file (*.fab,

fast, illegible), as a text file (*.fai, slower, legible) or, if the algebra is a

partially ordered set with an operation “meet”, to a *.osf file which can

be read by the Algebra Workbench to visualize the corresponding Hasse

diagram. TAFA loads algebras from fab- or fai-files and is able to copy or

remove algebras in the main window (menu File). The algebras are stored

as the data type TAlgebra within TAFA, which is connected to lists of the

type TAlgebraUniverse and TOperationList providing further procedures and

objects. Once the algebras of interest are defined in the main window, the

basic operations of universal algebra described below can be performed.

The menu item Tools > Morphisms opens a dialogue window where the

user can choose a domain A1 and a codomain A2 (of the same language)

from the list of defined algebras. It is possible to choose whether to calculate

all homomorphisms between A1 and A2 or only those that are surjective,

injective or bijective. When the button “Calculate” is pressed, TAFA lists

the homomorphisms satisfying the chosen criteria. Double-clicking on an

entry of the list shows the mappings from elements of A1 to elements of A2.

Using the Tools menu of this dialogue window it is also possible to add the

3Navigation through the menus is denoted here by Menu > Menu item.
4We say that an entry of a list, e.g., an algebra in the main window, is selected if it is

highlighted, and chosen if the appropriate check box is checked.
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homomorphic image as a new algebra to the main window or to save the

mapping information to a text file.

The menu item Tools > Subalgebras opens a dialogue window which lists

all the subalgebras of the active algebra. The subalgebras are stored as

entities of TAlgebraUniverse within this dialogue window to save time (there

is no need to build up the operation tables), but it is possible to add the

checked subalgebras as new algebras to the main window using the menu

Tools of the dialogue window. The Options menu of the dialogue window

offers the possibility to (heuristically) first list the smaller and then the bigger

algebras by first calculating the subalgebras generated by zero or one element,

storing their sizes and then trying to combine the given generators in such a

way that the subalgebras generated are potentially small.

Tools > Generating subalgebra opens a dialogue window where the user

can choose some elements a1, . . . , ak of the active algebra A. TAFA then

calculates the unique subalgebra of A generated by the elements a1, . . . , ak

and adds it as a new algebra to the main window.

Having defined algebras A1, . . . ,An of the same language in the main

window of TAFA, the user can calculate the direct product A1 × · · · × An

using Tools > Direct product . Specifying some k ∈ N with Tools > Direct

power , the direct power Ak of the selected L-algebra A is calculated.

Tools > Congruences opens a dialogue window which lists the congru-

ences Con(A) of the selected L-algebra A in the main window. Selecting a

congruence in the list shows the congruence classes on the right side. The di-

alogue window menu Tools lets the user store the congruence lattice Con(A)

as a new algebra (with the lattice operations ∧ and ∨ as language) to the

main window. It is also possible to quotient the active structure with the

selected congruence or to save the congruence information to a text file.

If the set K := {A1, . . . ,An} of L-algebras is chosen in TAFA, the menu

item Tools > Free algebra lets the user specify a natural number n ∈ N and

TAFA calculates the free algebra FK(n). There is also the possibility to search

for the smallest generating free algebra for K.
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5.2 Advanced Features

Tools > Minimal Generating Set (MinGenSet) calculates MinGenSet(K)

for the chosen set of L-algebras K in TAFA (see Algorithm 3.1).

Let A be an L-algebra and FA(n) the minimal generating free algebra for

Q(FA(ω)). We call an L-algebra B an admissibility algebra, if B ∈ S(FA(n))

and A ∈ H(B) (see Corollary 3.13).

Given a set K of L-algebras chosen in TAFA, the user selects the appropri-

ate free algebra or lets the program find the smallest generating free algebra

for K with Tools > Admissibility algebra. The menu Options of the dia-

logue window for calculating admissibility algebras then lets the user choose

whether to search for admissibility algebras from smaller to larger or with

the usual algorithm of searching for subalgebras (which is independent of

their cardinalities). Although the latter is much quicker for small algebras,

there are some cases where the heuristic method performs faster. Once the

admissibility algebra is stored as a new algebra in the main window, the user

can calculate MinGenSet(K) as needed.

The menu Check enables the user to check whether the selected L-algebra

A is subdirectly irreducible, Q(A)-subdirectly irreducible (see Corollary 2.11),

structurally complete (see Theorem 3.23) or almost structurally complete (see

Theorem 3.27).

5.3 Example Session

In this section we guide the reader through an example TAFA session, trying

to find the minimal generating set for the quasivariety Q(FS(ω)), where S is

the Sette algebra generating the algebraic semantics Q(S) for the paracon-

sistent Sette logic P1 (see [102, 87]).

The first step is of course to define the algebra S within TAFA. S has

three elements {0, 0.5, 1}, a binary operation ⊃ and a unary operation ¬
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defined as follows:

⊃ 0 0.5 1

0 1 1 1

0.5 0 1 1

1 0 1 1

¬

0 1

0.5 1

1 0

We first open TAFA, select the menu item File > New algebra (see figure

below), enter the name “Sette” into the opened text field and hit “OK”. The

algebra is now defined, but has no elements and operations yet.

To define the universe select Edit > Edit elements or double click onto the

“0” in the column called “Card”. A dialogue window called “Elements of

Sette” opens. Define the elements 0, 0.5 and 1 with the appropriate buttons,

then hit “OK” (see figure below). The universe is now defined.
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To define the operations select Edit > Edit operations or double click onto

the operations cell of the grid. A dialogue window called “Operations of

Sette” opens. Click “Add”, then name the first operation (e.g., “imp”) and

fix the arity (here two). After confirming with “OK” we see a row displayed

in red in the grid of this dialogue window, which means that the operation is

defined but there are still undefined values. Now we either click the button

“Edit” or double click on the line of the operation “imp” to define the table of

values for ⊂. In the opened window called “Operation table of imp” we can

either enter the values by typing them on the keyboard or by selecting them

in the drop down menu called “Active element” and then double clicking

on the desired coordinate of the table (see figure below). When the table is

completely defined we confirm with “OK” and go through the same procedure

to define the operation ¬.

By either selecting Edit > Edit comment or double clicking on the comment
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cell in the grid we can also add a comment if we like. Now the algebra S

is completely defined and ready to use. With the menu item File > Save

algebra to file we can save the algebra into a file for later use.

In order to find the minimal generating set for Q(FS(ω)), we first need

to calculate the minimal generating free algebra for this quasivariety. The

menu item Tools > Free algebra opens a dialogue window called “Number

of generators for the free algebra”, where we check the box “Calculate the

minimal generating free algebra” and confirm with “OK”:

It turns out that the minimal generating free algebra for Q(FS(ω)) is FS(1)

which has nine elements. By double clicking on the “Card” cell we get a list

of representatives of the equivalence classes of the free algebra showing how

the elements of the free algebra were generated (see figure below).

Suppose that we would like to know the definition of a homomorphism from

the free algebra FS(1) onto S (note that there must be at least one such homo-

morphism since FS(1) is the minimal generating free algebra for Q(FS(ω))).

Calculating morphisms is done through the menu item Tools > Morphisms :
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The morphisms window opens, where we choose the domain, codomain and

type of homomorphism we search for. Clicking “Calculate” shows us that

there is only one surjective homomorphism from the free algebra onto S.

Double clicking the corresponding row presents the mapping:
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The menu item Tools > Congruences opens a dialogue window called “Con-

gruences of F {Sette}(1)”. Calculating the congruences by clicking “Cal-

culate” shows that there are only twelve congruences in Con(FS(1)) (see

figure below) and hence we could directly apply the algorithm MinGenSet

to {FS(1)} to get (in a reasonable amount of time) the minimal generating

set for the quasivariety Q(FS(ω)). But for the sake of the example, let us

suppose that we want to apply the algorithm AdmAlgs.

For this we choose the menu item Tools > Admissibility algebra (note that

we need to choose the algebra “Sette” first in the main grid) and then select

the free algebra called “F {Sette}(1)” in the list that pops up:
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Clicking “OK” opens a dialogue window called “Admissibility algebras for

Sette”. We only deselect “Chain of subalgebras (found subalgebras as new

starting point)” of the menu Options if we want to find all the subalgebras of

the minimal generating free algebra (here FS(1)) which are prehomomorphic

images of the generating algebra (here S). For small algebra it is much faster

to have the option “From smaller to bigger algebras (heuristic)” deselected.

So we start the calculation by clicking the button “Calculate” and then see

that the new algebra in the main grid has nine elements like the free algebra

and hence must be the free algebra itself. To finish our search we have

finally to apply the algorithm MinGenSet to this algebra with the menu

item Tools > Minimal generating set (MinGenSet) since it could be that

there are smaller algebras generating the same quasivariety which are not

prehomomorphic images of S. This is not the case here for FS(1), hence

MinGenSet(FS(ω)) = { FS(1) }.

Note that we can check that S is not almost structurally complete (see figure

below) with the use of Check > Almost structural completeness .
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Chapter 6

Concluding Remarks

This chapter summarizes the results obtained in this thesis and explains how

they fit into the existing theory of admissible rules in universal algebra and

finite-valued logics (Section 6.1). We conclude the thesis by sketching some

ideas for future research into questions related to this work (Section 6.2).

6.1 Contribution of the Thesis

Our primary goal in this thesis was to investigate admissibility in finitely

generated quasivarieties and finite-valued logics. There has been a substantial

amount of research into admissibility for intermediate and modal logics (see,

e.g., [99, 43, 44, 56, 60]), but a general theory of admissibility for finite-valued

logics was, before the work reported here, lacking. A central aim of the thesis

was to establish general algorithms to check whether a given quasiequation

is admissible in a finitely generated quasivariety Q. This is the case if and

only if it is valid in the free algebra FQ(n) where n is the maximum of the

cardinalities of the generating algebras (see Theorem 3.9), but free algebras

are often quite big even for a small number of generators.

A first step towards addressing this issue was the introduction of minimal

generating sets for any finitely generated quasivariety Q (see Algorithm 3.1),

i.e., smallest (with respect to the standard multiset ordering) sets of alge-
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bras K such that Q = Q(K). Minimal generating sets are unique up to

isomorphism (see Theorem 3.3) and provide a useful general tool for in-

vestigating finitely generated quasivarieties in universal algebra. The al-

gorithm MinGenSet provides here a possibility of answering the prob-

lem of checking admissibility in finitely generated quasivarieties Q(K), since

MinGenSet({FQ(K)(n)}) (where n is the maximum of the cardinalities of

the algebras in K) returns the minimal generating set for Q(FQ(K)(ω)).

However, finding a minimal generating set is not generally feasible for

larger algebras. A further important ingredient of our approach is there-

fore Theorem 3.11 since it describes how to replace the generating free al-

gebra with a smaller algebra while making sure that the new (sub)algebra

still generates the same quasivariety Q(FQ(ω)). Results from Birkhoff (see

Lemma 2.12) and Rybakov (see Theorem 2.18) allow this theorem to be ap-

plied to finitely generated quasivarieties. Finally, the procedure AdmAlgs

(see Algorithm 3.2) joins the two ideas of finding the minimal generating set

and reducing the size of the generating algebras by searching for suitable

subalgebras, providing a general algorithm for checking admissibility (see

Theorem 3.15). Table 4.4 lists the remarkable reductions of the cardinalities

from the appropriate free algebras to the results of the algorithm AdmAlg.

These results contribute to the study of some well known classes of algebras,

including the varieties of De Morgan and Kleene algebras.

Theorem 3.7 connects unifiability of a set of equations with satisfiability

of this set in a subalgebra of a finite free algebra. Hence unifiability is decid-

able and can be checked in the (usually small) smallest subalgebra of the free

algebra. Theorem 3.23 characterizes structural completeness using the algo-

rithm MinGenSet. This implementable (see Chapter 5) characterization

provides a nice alternative to known proof techniques for establishing struc-

tural completeness in finitely generated quasivarieties or finite-valued logics

such as Theorem 3.17 or “Prucnal’s trick” (see [85]). Theorem 3.25 provides a

characterization for almost structural completeness similar to Theorem 3.16

for structural completeness. This has been used to describe almost structural
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completeness in terms of the algorithm MinGenSet in Theorem 3.27.

Theorem 3.28 can save a lot of calculation time since it ensures that

free algebras and minimal generating sets of clone equivalent algebras are

isomorphic (up to translations inside their clone of operations) and hence we

only need to run our algorithms once if the operations of two algebras are

inter-definable. Theorem 3.30 transfers Theorem 3.11 into the logical setting,

i.e., for a given logic L, it characterizes the admissibility of a rule Γ / ϕ by

the validity in another logic L′.

These theoretical results and obtained algorithms for admissibility in

finitely generated quasivarieties have allowed us to investigate when admis-

sibility and validity diverge in some basic cases: Theorem 4.1 provides a

new proof for the fact that every two element algebra is structurally com-

plete (compare [89, Corollary 1]). Section 4.2 comprehensively investigates

the minimal generating sets for Q(FG(ω)) for all three element groupoids G.

We have also used the obtained tools to investigate axiomatization problems:

Theorems 4.7, 4.5 and 4.9 provide bases for the admissible quasiequations of

the quasivarieties of Kleene algebras, Kleene lattices and De Morgan lattices,

respectively. Moreover, Theorem 4.11 presents a “basis” for the admissible

quasiequations of the variety of De Morgan algebras which does not consist

only of quasiequations, but also includes the proper clause (4.3) (in con-

trast to more recent work [26], where a proper basis is found using natural

dualities).

6.2 Outlook

For any finitely generated quasivariety Q, we can find a minimal set K (with

respect to the standard multiset ordering) of algebras to check admissibility

in Q (by checking validity in K). Nevertheless, the algorithm AdmAlgs is

not feasible for arbitrary input size because of the complexity of the tasks in-

volved. The bottlenecks are in particular: generating the free algebra, calcu-

lating the congruence lattice (or, equivalently, checking homomorphisms) and
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calculating subalgebras. Checking, e.g., whether A ∈ H(B) or A ∈ S(B) is

NP-hard for finite algebras A and B (see, e.g., [13, 53]), but running through

all subalgebras or congruences is EXPTIME-hard in general1. The following

ideas might be used to obtain faster algorithms:

• Only construct small subalgebras of the free algebra (heuristically) to

check if they generate the whole quasivariety, i.e., if they are pre-

homomorphic images of the initial algebras.

• Do not calculate the whole lattice of congruences in MinGenSet. In-

tuitively, we are only interested in the bottom region of the congruence

lattice Con(A) if we want to check whether A is Q(A)-subdirectly

irreducible (see Lemma 3.4 and Corollary 2.11(b)).

• Improve the algorithm for generating subalgebras used for the heuristic

procedure where we first check smaller, then bigger subalgebras of the

free algebra in AdmAlgs. Construct a directed graph to store (based

on the operation tables of the operations of the algebra) which elements

are “reachable” by which elements. E.g., in the Kleene lattice CL

3
(see

Section 4.4), 1 is reachable by −1, since ¬ − 1 = 1, but 0 is not.

• Search for convenient subalgebras of the free algebra top-down rather

than bottom-up by systematically excluding elements. This would be

particularly helpful if our conjecture is true, that the “admissibility

algebras” are always on the top of the lattice of subuniverses. I.e.,

given a finitely generated quasivariety Q and its minimal generating

free algebra FQ(n), then Q(B) = Q(FQ(n)) for some algebra B implies

Q(B′) = Q(FQ(n)) for all algebras B′ in the upset of B inside the

lattice of subuniverses (compare Figure 3.1 as an example).

• Improve the algorithms by restricting attention to certain classes of

algebras. E.g., if we consider congruence-distributive algebras, we

1See [14] for investigations on the size of free algebras.
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could use a polynomial time algorithm to find a subdirect decom-

position (see [33]) instead of a Q-subdirect decomposition, since ev-

ery Q-subdirectly irreducible algebra is subdirectly irreducible for a

congruence-distributive quasivariety2 Q (see [37, Theorem 2.3]).

• Try to prohibit redundant calculations as with Theorem 3.28 by consid-

ering the type sets (containing the types unary, affine, Boolean, lattice

or semilattice) of tame congruence theory (see [55]) for the given finite

algebra (see, e.g., [68] for complexity studies in universal algebra with

respect to tame congruence theory).

The usability of TAFA could also be improved. E.g., rather than calcu-

lating the free algebra within TAFA, we could implement an interface to the

tool UACalc, since this tool already implemented many optimization tricks

like “thinning the coordinates”. Also, it could be convenient to have import

(export) possibilities from (to) other formats suchas LATEX, UACalc, AWB

or Sage. Moreover, it could be helpful to save the calculated parts of the

free algebra if the calculation is aborted, e.g., to generate the fully defined

subalgebras of this part of the free algebra.

Finally, there remain numerous open problems and directions in the the-

oretical framework of admissible rules that might be tackled using the ideas

and tools developed in this thesis. In particular:

• The present work only considers propositional logics. Could the results

obtained in this thesis be transferred to predicate logics? Note, how-

ever, that admissibility is far from being understood even in the case

of classical predicate logic.

• How could we extend the work to locally finite quasivarieties, i.e., where

finitely generated algebras are finite, or even infinite algebras? The

problem of non-finitely generated quasivarieties is certainly that either

2A quasivariety Q is called congruence-distributive, if for every algebra A ∈ Q the
lattice ConQ(A) is distributive. By [37, Proposition 2.1] this is the case if and only if for
each n ∈ N, ConQ(FQ(n)) is distributive.
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only infinitely many algebras generate the quasivariety or some of the

generating algebras have infinite cardinalities. So using TAFA to inves-

tigate these algebras or hoping for the presented algorithms to termi-

nate will not work. Moreover, we would have to consider ultraproducts

in this case, since Q(K) = ISPPU(K) in general. Nevertheless, it still

makes sense to concentrate on Q(K)-subdirectly irreducible algebras

(to find minimal generating sets) since they generate the quasivariety

(see Theorem 2.8). Also methods for checking, e.g., structural com-

pleteness, like finding an embedding into the free algebra (see Theo-

rem 3.17) extend to infinite algebras.

• Finding admissible rules with some algorithm could be helpful in finding

bases of admissible rules automatically for a given quasivariety which

is not structurally complete. One of the motivations for investigating

admissibility is to obtain quasiequations that can be used to tune up

proof systems (shortening derivations, constraining proof search, . . . )

for these algebras. A further step could then also be to find potentially

useful quasiequations for a given finite algebra. Note however, that

there are finite algebras which do not have a finite basis of admissible

rules (see [73, Corollary 5.12]).

• We only treated admissible quasiequations here except for the clause

x ∨ y ≈ ⊤ ⇒ x ≈ ⊤, y ≈ ⊤,

which is admissible in De Morgan algebras (see Section 4.4), i.e., when-

ever σ(x)∨ σ(y) ≈ ⊤ is valid in all De Morgan algebras for any substi-

tution σ, then either σ(x) ≈ ⊤ or σ(y) ≈ ⊤ is valid in all De Morgan

algebras. We would therefore like to investigate how to adapt our al-

gorithms to treat such “multiple-conclusion rules” (see also [26]).

• A logic is said to be hereditarily structurally complete if all of its ex-

tensions are structurally complete. Algebraically, this corresponds to
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the fact that every proper subquasivariety is a variety. We would like

to investigate whether there is a characterization as for structural and

almost structural completeness in terms of minimal generating sets for

this property (see Theorems 3.23, 3.27).
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Appendix A

List of Three Element Groupoids

Table A.1 lists all three element pairwise not clone equivalent groupoids.

The listed numbers are the same for clone equivalent groupoids (see Theo-

rem 3.28)1. For the groupoid G := 〈{0, 1, 2}, ⋆〉 the operation ⋆ is coded in

flat form as

(⋆(0, 0), ⋆(0, 1), ⋆(0, 2), ⋆(1, 0), ⋆(1, 1), ⋆(1, 2), ⋆(2, 0), ⋆(2, 1), ⋆(2, 2)),

i.e., the operation table “line-by-line”. The groupoids are sorted and num-

bered by the alpha-numerical order of the flat form representation of their

operation tables. For each clone equivalence class the first groupoid corre-

sponding to this order is listed. The columns of the table are labelled as

follows:

• CE: The number of the clone equivalence class CloG.

• G: The number of the first groupoid G in this clone equivalence class.

• Operation: The operation table of ⋆G in flat form.

• n: The number of generators needed to generate Q(FG(ω)).

1A list of all non-isomorphic groupoids with the corresponding numbers of the clone
equivalence classes can be downloaded from the webpage of S.N.Burris, www.math.

uwaterloo.ca/~snburris/htdocs/MYWORKS/PAPERS/Groupoid_Tables.pdf

105



• F(n): The cardinality of the free algebra FG(n).

• SS: The cardinality of the smallest subalgebra of FG(n).

• MGS: The cardinalities of the minimal generating set for Q(FG(n)).

• SC: G is structurally complete.

• ASC: G is almost structurally complete.

Table A.1: Three element groupoids.

CE G Operation n F(n) SS MGS SC ASC

1 1 (0,0,0,0,0,0,0,0,0) 2 3 1 2 yes yes

2 2 (0,0,0,0,0,0,0,0,1) 1 3 1 3 yes yes

3 3 (0,0,0,0,0,0,0,0,2) 2 5 1 2,2 yes yes

4 4 (0,0,0,0,0,0,0,1,0) 2 5 1 3 yes yes

5 5 (0,0,0,0,0,0,0,1,1) 1 3 1 3 yes yes

6 6 (0,0,0,0,0,0,0,1,2) 2 7 1 3 yes yes

7 8 (0,0,0,0,0,0,0,2,1) 1 4 1 3 yes yes

8 9 (0,0,0,0,0,0,0,2,2) 2 7 1 4 no no

9 10 (0,0,0,0,0,0,1,0,0) 1 3 1 3 yes yes

10 11 (0,0,0,0,0,0,1,0,1) 1 3 1 3 yes yes

11 12 (0,0,0,0,0,0,1,0,2) 2 11 1 3 yes yes

12 13 (0,0,0,0,0,0,1,1,0) 1 3 1 3 yes yes

13 14 (0,0,0,0,0,0,1,1,1) 1 3 1 3 yes yes

14 15 (0,0,0,0,0,0,1,1,2) 2 7 1 3 yes yes

15 16 (0,0,0,0,0,0,1,2,0) 1 4 1 3 yes yes

16 18 (0,0,0,0,0,0,1,2,2) 2 13 1 3 yes yes

17 19 (0,0,0,0,0,0,2,0,0) 2 16 1 4 no no

Table A.1; continued on next page
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18 21 (0,0,0,0,0,0,2,0,2) 2 6 1 4 no no

19 22 (0,0,0,0,0,0,2,1,0) 2 24 1 3 yes yes

20 24 (0,0,0,0,0,0,2,1,2) 2 8 1 3 yes yes

21 25 (0,0,0,0,0,0,2,2,0) 2 8 1 3 no no

22 26 (0,0,0,0,0,0,2,2,1) 1 4 1 3 yes yes

23 27 (0,0,0,0,0,0,2,2,2) 2 4 1 2,2 yes yes

24 30 (0,0,0,0,0,1,0,1,0) 2 6 1 3 yes yes

25 31 (0,0,0,0,0,1,0,1,1) 1 3 1 3 yes yes

26 32 (0,0,0,0,0,1,0,1,2) 2 8 1 3 yes yes

27 33 (0,0,0,0,0,1,0,2,0) 2 5 1 3 yes yes

28 34 (0,0,0,0,0,1,0,2,1) 1 4 1 3 yes yes

29 35 (0,0,0,0,0,1,0,2,2) 2 11 1 3 yes yes

30 36 (0,0,0,0,0,1,1,0,0) 1 3 1 3 yes yes

31 37 (0,0,0,0,0,1,1,0,1) 1 3 1 3 yes yes

32 38 (0,0,0,0,0,1,1,0,2) 2 15 1 3 yes yes

33 39 (0,0,0,0,0,1,1,1,0) 1 3 1 3 yes yes

34 40 (0,0,0,0,0,1,1,1,1) 1 3 1 3 yes yes

35 41 (0,0,0,0,0,1,1,1,2) 2 11 1 3 yes yes

36 42 (0,0,0,0,0,1,1,2,0) 1 4 1 3 yes yes

37 43 (0,0,0,0,0,1,1,2,1) 1 4 1 3 yes yes

38 44 (0,0,0,0,0,1,1,2,2) 2 20 1 3 yes yes

39 45 (0,0,0,0,0,1,2,0,0) 2 24 1 4 no no

40 46 (0,0,0,0,0,1,2,0,1) 1 4 1 3 yes yes

41 47 (0,0,0,0,0,1,2,0,2) 2 10 1 4 no no

42 48 (0,0,0,0,0,1,2,1,0) 2 36 1 3 yes yes
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43 49 (0,0,0,0,0,1,2,1,1) 1 4 1 3 yes yes

44 50 (0,0,0,0,0,1,2,1,2) 2 14 1 3 yes yes

45 51 (0,0,0,0,0,1,2,2,0) 2 12 1 4 no no

46 52 (0,0,0,0,0,1,2,2,1) 1 4 1 3 yes yes

47 53 (0,0,0,0,0,1,2,2,2) 2 6 1 3 yes yes

48 59 (0,0,0,0,0,2,0,2,1) 1 4 1 3 yes yes

49 60 (0,0,0,0,0,2,0,2,2) 2 8 1 4 no no

50 61 (0,0,0,0,0,2,1,0,0) 1 4 1 3 yes yes

51 63 (0,0,0,0,0,2,1,0,2) 2 29 1 3 yes yes

52 65 (0,0,0,0,0,2,1,1,1) 1 4 1 3 yes yes

53 66 (0,0,0,0,0,2,1,1,2) 2 19 1 3 yes yes

54 67 (0,0,0,0,0,2,1,2,0) 1 4 1 3 yes yes

55 69 (0,0,0,0,0,2,1,2,2) 2 29 1 3 yes yes

56 70 (0,0,0,0,0,2,2,0,0) 2 26 1 5 no no

57 72 (0,0,0,0,0,2,2,0,2) 2 10 1 3 yes yes

58 73 (0,0,0,0,0,2,2,1,0) 2 50 1 3 yes yes

59 75 (0,0,0,0,0,2,2,1,2) 2 18 1 3 yes yes

60 78 (0,0,0,0,0,2,2,2,2) 2 6 1 3 yes yes

61 79 (0,0,0,0,1,0,0,0,1) 1 3 1 3 yes yes

62 80 (0,0,0,0,1,0,0,0,2) 2 3 1 2 yes yes

63 81 (0,0,0,0,1,0,0,1,1) 1 3 1 3 yes yes

64 82 (0,0,0,0,1,0,0,1,2) 2 5 1 3 yes yes

65 83 (0,0,0,0,1,0,0,2,1) 1 3 1 3 yes yes

66 85 (0,0,0,0,1,0,1,0,0) 1 3 1 3 yes yes

67 87 (0,0,0,0,1,0,1,0,2) 2 14 1 3 yes yes
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68 88 (0,0,0,0,1,0,1,1,0) 1 3 1 3 yes yes

69 89 (0,0,0,0,1,0,1,1,1) 1 3 1 3 yes yes

70 90 (0,0,0,0,1,0,1,1,2) 2 10 1 3 yes yes

71 91 (0,0,0,0,1,0,1,2,0) 1 3 1 3 yes yes

72 93 (0,0,0,0,1,0,1,2,2) 2 34 1 3 yes yes

73 94 (0,0,0,0,1,0,2,0,0) 2 18 1 3 yes yes

74 96 (0,0,0,0,1,0,2,0,2) 2 6 1 4 no no

75 97 (0,0,0,0,1,0,2,1,0) 2 30 1 3 yes yes

76 99 (0,0,0,0,1,0,2,1,2) 2 10 1 3 yes yes

77 100 (0,0,0,0,1,0,2,2,0) 2 10 1 2,2 yes yes

78 101 (0,0,0,0,1,0,2,2,1) 1 3 1 3 yes yes

79 102 (0,0,0,0,1,0,2,2,2) 2 4 1 2,2 yes yes

80 104 (0,0,0,0,1,1,0,1,1) 2 5 1 2,2 yes yes

81 105 (0,0,0,0,1,1,0,1,2) 3 7 1 2 yes yes

82 106 (0,0,0,0,1,1,0,2,1) 2 10 1 2,2 no no

83 107 (0,0,0,0,1,1,0,2,2) 3 12 1 2,2 no no

84 111 (0,0,0,0,1,1,1,1,0) 1 3 1 3 yes yes

85 112 (0,0,0,0,1,1,1,1,1) 2 7 1 4 no no

86 113 (0,0,0,0,1,1,1,1,2) 2 5 1 3 yes yes

87 115 (0,0,0,0,1,1,1,2,1) 2 26 1 3 yes yes

88 116 (0,0,0,0,1,1,1,2,2) 2 8 1 3 yes yes

89 117 (0,0,0,0,1,1,2,0,0) 2 34 1 3 yes yes

90 119 (0,0,0,0,1,1,2,0,2) 2 10 1 4 no no

91 120 (0,0,0,0,1,1,2,1,0) 2 44 1 3 yes yes

92 121 (0,0,0,0,1,1,2,1,1) 2 9 1 3 yes yes
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93 122 (0,0,0,0,1,1,2,1,2) 3 54 1 3 yes yes

94 123 (0,0,0,0,1,1,2,2,0) 2 18 1 3 yes yes

95 124 (0,0,0,0,1,1,2,2,1) 2 14 1 3 yes yes

96 125 (0,0,0,0,1,1,2,2,2) 3 18 1 3 yes yes

97 129 (0,0,0,0,1,2,0,2,1) 2 8 1 2,2 no no

98 130 (0,0,0,0,1,2,1,0,0) 1 3 1 3 yes yes

99 132 (0,0,0,0,1,2,1,0,2) 2 38 1 3 yes yes

100 134 (0,0,0,0,1,2,1,1,1) 2 16 1 4 no no

101 135 (0,0,0,0,1,2,1,1,2) 2 10 1 3 yes yes

102 136 (0,0,0,0,1,2,1,2,0) 1 3 1 3 yes yes

103 137 (0,0,0,0,1,2,1,2,1) 2 24 1 3 yes yes

104 138 (0,0,0,0,1,2,1,2,2) 2 7 1 3 yes yes

105 139 (0,0,0,0,1,2,2,0,0) 2 28 1 3 yes yes

106 141 (0,0,0,0,1,2,2,0,2) 2 10 1 3 yes yes

107 142 (0,0,0,0,1,2,2,1,0) 2 52 1 3 yes yes

108 143 (0,0,0,0,1,2,2,1,1) 2 34 1 3 yes yes

109 144 (0,0,0,0,1,2,2,1,2) 3 183 1 3 yes yes

110 147 (0,0,0,0,1,2,2,2,2) 3 15 1 3 yes yes

111 148 (0,0,0,0,2,0,0,0,1) 1 3 1 3 yes yes

112 149 (0,0,0,0,2,0,0,1,1) 1 7 1 3 yes yes

113 151 (0,0,0,0,2,0,1,0,0) 1 7 1 3 yes yes

114 153 (0,0,0,0,2,0,1,0,2) 1 3 1 3 yes yes

115 155 (0,0,0,0,2,0,1,1,1) 1 7 1 3 yes yes

116 157 (0,0,0,0,2,0,1,2,0) 1 7 1 3 yes yes

117 160 (0,0,0,0,2,0,2,0,0) 1 4 1 4 no no
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118 161 (0,0,0,0,2,0,2,0,1) 1 9 1 3 yes yes

119 162 (0,0,0,0,2,0,2,0,2) 1 3 1 3 yes yes

120 163 (0,0,0,0,2,0,2,1,0) 1 6 1 3 yes yes

121 165 (0,0,0,0,2,0,2,1,2) 1 3 1 3 yes yes

122 166 (0,0,0,0,2,0,2,2,0) 1 4 1 4 no no

123 168 (0,0,0,0,2,0,2,2,2) 1 3 1 3 yes yes

124 169 (0,0,0,0,2,1,0,1,1) 2 24 2 4 no no

125 170 (0,0,0,0,2,1,0,2,1) 2 8 2 4 no no

126 171 (0,0,0,0,2,1,1,0,0) 1 9 1 3 yes yes

127 175 (0,0,0,0,2,1,1,1,1) 2 56 2 4 no no

128 176 (0,0,0,0,2,1,1,1,2) 2 68 1 3 yes yes

129 178 (0,0,0,0,2,1,1,2,1) 2 68 2 6 no yes

130 179 (0,0,0,0,2,1,1,2,2) 2 70 1 3 yes yes

131 180 (0,0,0,0,2,1,2,0,0) 1 4 1 4 no no

132 182 (0,0,0,0,2,1,2,0,2) 1 3 1 3 yes yes

133 183 (0,0,0,0,2,1,2,1,0) 1 6 1 3 yes yes

134 184 (0,0,0,0,2,1,2,1,1) 2 272 2 6 no yes

135 185 (0,0,0,0,2,1,2,1,2) 2 24 1 3 yes yes

136 186 (0,0,0,0,2,1,2,2,0) 1 4 1 4 no no

137 188 (0,0,0,0,2,1,2,2,2) 2 12 1 4 no no

138 194 (0,0,0,0,2,2,1,1,1) 2 16 2 4 no no

139 195 (0,0,0,0,2,2,1,1,2) 2 102 1 3 yes yes

140 198 (0,0,0,0,2,2,1,2,2) 2 13 1 3 yes yes

141 199 (0,0,0,0,2,2,2,0,0) 1 5 1 5 no no

142 201 (0,0,0,0,2,2,2,0,2) 1 3 1 3 yes yes
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143 203 (0,0,0,0,2,2,2,1,1) 2 36 2 6 no yes

144 204 (0,0,0,0,2,2,2,1,2) 2 32 1 3 yes yes

145 207 (0,0,0,1,0,0,1,0,0) 1 3 1 3 yes yes

146 209 (0,0,0,1,0,0,1,0,2) 2 60 1 3 yes yes

147 213 (0,0,0,1,0,0,1,2,0) 1 6 1 3 yes yes

148 215 (0,0,0,1,0,0,1,2,2) 2 136 1 3 yes yes

149 216 (0,0,0,1,0,0,2,0,0) 2 7 1 3 yes yes

150 218 (0,0,0,1,0,0,2,0,2) 2 24 1 4 no no

151 219 (0,0,0,1,0,0,2,1,0) 2 40 1 3 yes yes

152 221 (0,0,0,1,0,0,2,1,2) 2 48 1 3 yes yes

153 222 (0,0,0,1,0,0,2,2,0) 2 14 1 3 yes yes

154 223 (0,0,0,1,0,0,2,2,1) 1 3 1 3 yes yes

155 224 (0,0,0,1,0,0,2,2,2) 2 16 1 3 yes yes

156 235 (0,0,0,1,0,1,2,0,2) 2 16 1 4 no no

157 239 (0,0,0,1,0,1,2,2,0) 2 6 1 2 yes yes

158 241 (0,0,0,1,0,1,2,2,2) 2 8 1 2,2 yes yes

159 244 (0,0,0,1,0,2,1,0,2) 2 160 1 3 yes yes

160 250 (0,0,0,1,0,2,1,2,2) 2 198 1 3 yes yes

161 252 (0,0,0,1,0,2,2,0,2) 2 18 1 4 no no

162 253 (0,0,0,1,0,2,2,1,0) 2 18 1 3 yes yes

163 255 (0,0,0,1,0,2,2,1,2) 2 72 1 3 yes yes

164 257 (0,0,0,1,1,0,1,0,0) 1 3 1 3 yes yes

165 258 (0,0,0,1,1,0,1,0,1) 1 3 1 3 yes yes

166 259 (0,0,0,1,1,0,1,0,2) 2 18 1 3 yes yes

167 260 (0,0,0,1,1,0,1,1,0) 1 3 1 3 yes yes
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168 261 (0,0,0,1,1,0,1,1,1) 1 3 1 3 yes yes

169 262 (0,0,0,1,1,0,1,1,2) 2 10 1 3 yes yes

170 263 (0,0,0,1,1,0,1,2,0) 1 3 1 3 yes yes

171 265 (0,0,0,1,1,0,1,2,2) 2 30 1 3 yes yes

172 266 (0,0,0,1,1,0,2,0,1) 1 3 1 3 yes yes

173 267 (0,0,0,1,1,0,2,0,2) 2 4 1 4 no no

174 268 (0,0,0,1,1,0,2,1,1) 1 3 1 3 yes yes

175 269 (0,0,0,1,1,0,2,1,2) 2 10 1 3 yes yes

176 270 (0,0,0,1,1,0,2,2,1) 1 3 1 3 yes yes

177 271 (0,0,0,1,1,0,2,2,2) 2 4 1 3 yes yes

178 272 (0,0,0,1,1,1,1,0,0) 1 3 1 3 yes yes

179 273 (0,0,0,1,1,1,1,0,2) 2 6 1 3 yes yes

180 274 (0,0,0,1,1,1,1,2,0) 1 3 1 3 yes yes

181 275 (0,0,0,1,1,1,2,2,2) 3 3 1 2 yes yes

182 278 (0,0,0,1,1,2,1,0,2) 2 44 1 3 yes yes

183 280 (0,0,0,1,1,2,1,1,1) 2 20 1 3 yes yes

184 281 (0,0,0,1,1,2,1,1,2) 2 6 1 3 yes yes

185 282 (0,0,0,1,1,2,1,2,0) 1 3 1 3 yes yes

186 283 (0,0,0,1,1,2,1,2,1) 2 16 1 3 yes yes

187 284 (0,0,0,1,1,2,1,2,2) 2 6 1 3 yes yes

188 286 (0,0,0,1,1,2,2,1,1) 2 24 1 3 yes yes

189 287 (0,0,0,1,1,2,2,1,2) 3 36 1 3 yes yes

190 298 (0,0,0,1,2,0,2,0,1) 1 3 1 3 yes yes

191 305 (0,0,0,1,2,1,1,1,1) 2 128 2 8 no no

192 306 (0,0,0,1,2,1,1,1,2) 2 32 1 4 no no
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193 308 (0,0,0,1,2,1,1,2,1) 2 20 2 8 no no

194 309 (0,0,0,1,2,1,1,2,2) 2 32 1 4 no no

195 311 (0,0,0,1,2,1,2,2,1) 2 16 2 8 no no

196 316 (0,0,0,1,2,2,1,1,1) 2 12 2 8 no no

197 317 (0,0,0,1,2,2,1,1,2) 2 48 1 4 no no

198 320 (0,0,0,1,2,2,1,2,2) 2 6 1 4 no no

199 321 (0,0,0,1,2,2,2,1,1) 2 8 2 8 no no

200 322 (0,0,0,2,0,0,1,0,0) 1 3 1 3 yes yes

201 341 (0,0,0,2,0,2,1,1,0) 1 3 1 3 yes yes

202 347 (0,0,0,2,1,0,1,0,2) 2 15 1 3 yes yes

203 349 (0,0,0,2,1,0,1,1,2) 2 153 1 3 yes yes

204 353 (0,0,0,2,1,1,1,1,1) 2 10 1 4 no no

205 354 (0,0,0,2,1,1,1,1,2) 2 10 1 4 no no

206 356 (0,0,0,2,1,1,1,2,2) 2 4 1 4 no no

207 359 (0,0,0,2,1,2,1,1,2) 2 8 1 4 no no

208 366 (0,0,0,2,2,2,1,1,1) 2 4 2 2 no yes

209 376 (0,0,1,0,0,0,1,0,0) 1 3 1 3 yes yes

210 377 (0,0,1,0,0,0,1,0,1) 1 3 1 3 yes yes

211 378 (0,0,1,0,0,0,1,0,2) 2 15 1 3 yes yes

212 379 (0,0,1,0,0,0,1,1,0) 1 3 1 3 yes yes

213 380 (0,0,1,0,0,0,1,1,1) 1 3 1 3 yes yes

214 381 (0,0,1,0,0,0,1,1,2) 2 14 1 3 yes yes

215 382 (0,0,1,0,0,0,1,2,0) 1 4 1 3 yes yes

216 384 (0,0,1,0,0,0,1,2,2) 2 46 1 3 yes yes

217 385 (0,0,1,0,0,0,2,0,0) 1 4 1 3 yes yes
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218 387 (0,0,1,0,0,0,2,0,2) 2 37 1 3 yes yes

219 388 (0,0,1,0,0,0,2,1,0) 1 4 1 3 yes yes

220 390 (0,0,1,0,0,0,2,1,2) 2 58 1 3 yes yes

221 391 (0,0,1,0,0,0,2,2,0) 1 4 1 3 yes yes

222 405 (0,0,1,0,0,1,1,1,0) 1 3 1 3 yes yes

223 406 (0,0,1,0,0,1,1,1,1) 1 3 1 3 yes yes

224 407 (0,0,1,0,0,1,1,1,2) 2 8 1 3 yes yes

225 410 (0,0,1,0,0,1,1,2,2) 2 27 1 3 yes yes

226 417 (0,0,1,0,0,1,2,2,0) 1 4 1 3 yes yes

227 434 (0,0,1,0,0,2,1,2,0) 1 4 1 3 yes yes

228 436 (0,0,1,0,0,2,1,2,2) 2 33 1 3 yes yes

229 437 (0,0,1,0,0,2,2,0,0) 1 4 1 3 yes yes

230 439 (0,0,1,0,0,2,2,0,2) 2 83 1 3 yes yes

231 454 (0,0,1,0,1,0,1,0,0) 1 3 1 3 yes yes

232 455 (0,0,1,0,1,0,1,0,1) 1 3 1 3 yes yes

233 456 (0,0,1,0,1,0,1,0,2) 2 15 1 3 yes yes

234 457 (0,0,1,0,1,0,1,1,0) 1 3 1 3 yes yes

235 458 (0,0,1,0,1,0,1,1,1) 1 3 1 3 yes yes

236 459 (0,0,1,0,1,0,1,1,2) 2 17 1 3 yes yes

237 460 (0,0,1,0,1,0,1,2,0) 1 3 1 3 yes yes

238 462 (0,0,1,0,1,0,1,2,2) 2 46 1 3 yes yes

239 463 (0,0,1,0,1,0,2,0,0) 1 3 1 3 yes yes

240 465 (0,0,1,0,1,0,2,0,2) 2 58 1 3 yes yes

241 469 (0,0,1,0,1,0,2,2,0) 1 3 1 3 yes yes

242 483 (0,0,1,0,1,1,1,1,0) 1 3 1 3 yes yes
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243 484 (0,0,1,0,1,1,1,1,1) 2 8 1 4 no no

244 485 (0,0,1,0,1,1,1,1,2) 2 6 1 3 yes yes

245 487 (0,0,1,0,1,1,1,2,1) 2 36 1 3 yes yes

246 488 (0,0,1,0,1,1,1,2,2) 2 12 1 3 yes yes

247 493 (0,0,1,0,1,1,2,1,1) 2 12 1 3 yes yes

248 494 (0,0,1,0,1,1,2,1,2) 2 10 1 3 yes yes

249 495 (0,0,1,0,1,1,2,2,0) 1 3 1 3 yes yes

250 496 (0,0,1,0,1,1,2,2,1) 2 20 1 3 yes yes

251 512 (0,0,1,0,1,2,1,2,0) 1 3 1 3 yes yes

252 513 (0,0,1,0,1,2,1,2,1) 2 28 1 3 yes yes

253 514 (0,0,1,0,1,2,1,2,2) 2 5 1 3 yes yes

254 515 (0,0,1,0,1,2,2,0,0) 1 3 1 3 yes yes

255 517 (0,0,1,0,1,2,2,0,2) 2 83 1 3 yes yes

256 519 (0,0,1,0,1,2,2,1,1) 2 58 1 3 yes yes

257 520 (0,0,1,0,1,2,2,1,2) 2 20 1 3 yes yes

258 522 (0,0,1,0,1,2,2,2,1) 2 40 1 3 yes yes

259 532 (0,0,1,0,2,0,1,0,0) 1 9 1 3 yes yes

260 534 (0,0,1,0,2,0,1,0,2) 1 3 1 3 yes yes

261 538 (0,0,1,0,2,0,1,2,0) 1 9 1 3 yes yes

262 562 (0,0,1,0,2,1,1,1,1) 2 82 2 4 no no

263 563 (0,0,1,0,2,1,1,1,2) 2 324 1 3 yes yes

264 565 (0,0,1,0,2,1,1,2,1) 2 324 2 6 no yes

265 566 (0,0,1,0,2,1,1,2,2) 2 486 1 3 yes yes

266 571 (0,0,1,0,2,1,2,1,1) 2 1296 2 6 no yes

267 600 (0,0,1,1,0,0,0,0,0) 1 4 1 4 no no
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268 602 (0,0,1,1,0,0,0,0,2) 2 100 1 3 yes yes

269 603 (0,0,1,1,0,0,0,1,0) 1 5 1 5 no no

270 604 (0,0,1,1,0,0,0,1,1) 1 5 1 5 no no

271 606 (0,0,1,1,0,0,0,2,0) 1 4 1 4 no no

272 608 (0,0,1,1,0,0,0,2,2) 2 208 1 3 yes yes

273 609 (0,0,1,1,0,0,1,0,0) 1 5 1 5 no no

274 612 (0,0,1,1,0,0,1,1,0) 1 5 1 5 no no

275 613 (0,0,1,1,0,0,1,1,1) 1 5 1 5 no no

276 615 (0,0,1,1,0,0,1,2,0) 1 6 1 3 yes yes

277 618 (0,0,1,1,0,0,2,0,0) 1 6 1 3 yes yes

278 620 (0,0,1,1,0,0,2,0,2) 2 256 1 3 yes yes

279 624 (0,0,1,1,0,0,2,2,0) 1 3 1 3 yes yes

280 629 (0,0,1,1,0,1,0,1,0) 1 5 1 5 no no

281 630 (0,0,1,1,0,1,0,1,1) 1 5 1 5 no no

282 632 (0,0,1,1,0,1,0,2,0) 1 4 1 4 no no

283 638 (0,0,1,1,0,1,1,1,0) 1 5 1 5 no no

284 639 (0,0,1,1,0,1,1,1,1) 1 5 1 5 no no

285 652 (0,0,1,1,0,2,0,0,0) 1 6 1 3 yes yes

286 654 (0,0,1,1,0,2,0,0,2) 2 336 1 3 yes yes

287 658 (0,0,1,1,0,2,0,2,0) 1 6 1 3 yes yes

288 677 (0,0,1,1,1,0,0,0,0) 1 3 1 3 yes yes

289 678 (0,0,1,1,1,0,0,0,1) 1 3 1 3 yes yes

290 679 (0,0,1,1,1,0,0,0,2) 2 10 1 3 yes yes

291 680 (0,0,1,1,1,0,0,1,0) 1 3 1 3 yes yes

292 681 (0,0,1,1,1,0,0,1,2) 2 10 1 3 yes yes
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293 682 (0,0,1,1,1,0,0,2,0) 1 3 1 3 yes yes

294 684 (0,0,1,1,1,0,0,2,2) 2 60 1 3 yes yes

295 687 (0,0,1,1,1,0,1,2,0) 1 3 1 3 yes yes

296 690 (0,0,1,1,1,0,2,2,0) 1 3 1 3 yes yes

297 691 (0,0,1,1,1,2,0,0,0) 1 3 1 3 yes yes

298 693 (0,0,1,1,1,2,0,0,2) 2 112 1 3 yes yes

299 695 (0,0,1,1,1,2,0,1,1) 2 80 1 3 yes yes

300 696 (0,0,1,1,1,2,0,1,2) 2 24 1 3 yes yes

301 697 (0,0,1,1,1,2,0,2,0) 1 3 1 3 yes yes

302 698 (0,0,1,1,1,2,0,2,1) 2 72 1 3 yes yes

303 704 (0,0,1,1,1,2,1,1,1) 2 48 1 3 yes yes

304 705 (0,0,1,1,1,2,1,1,2) 2 14 1 3 yes yes

305 707 (0,0,1,1,1,2,1,2,1) 2 48 1 3 yes yes

306 710 (0,0,1,1,1,2,2,0,2) 2 162 1 3 yes yes

307 712 (0,0,1,1,1,2,2,1,1) 2 72 1 3 yes yes

308 755 (0,0,1,1,2,1,1,1,1) 2 896 2 6 no yes

309 756 (0,0,1,1,2,1,1,1,2) 2 224 1 3 yes yes

310 758 (0,0,1,1,2,1,1,2,1) 2 224 2 6 no yes

311 780 (0,0,1,1,2,2,1,1,1) 2 144 2 6 no yes

312 792 (0,0,1,2,0,0,0,0,0) 1 7 1 3 yes yes

313 870 (0,0,1,2,1,0,0,0,2) 2 729 1 3 yes yes

314 885 (0,0,1,2,1,0,1,2,2) 2 27 1 3 yes yes

315 898 (0,0,1,2,1,1,2,0,2) 2 9 1 3 yes yes

316 984 (0,0,1,2,2,2,1,1,1) 2 36 2 6 no yes

317 1012 (0,0,2,0,0,0,2,0,0) 2 18 1 5 no no
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318 1014 (0,0,2,0,0,0,2,1,0) 2 34 1 3 yes yes

319 1038 (0,0,2,0,0,1,2,1,0) 2 38 1 3 yes yes

320 1040 (0,0,2,0,0,1,2,1,2) 2 13 1 3 yes yes

321 1065 (0,0,2,0,0,2,2,2,0) 2 6 1 3 no no

322 1066 (0,0,2,0,0,2,2,2,1) 1 4 1 3 yes yes

323 1084 (0,0,2,0,1,0,2,0,0) 2 20 1 3 yes yes

324 1086 (0,0,2,0,1,0,2,1,0) 2 36 1 3 yes yes

325 1107 (0,0,2,0,1,1,2,1,0) 2 40 1 3 yes yes

326 1108 (0,0,2,0,1,1,2,1,2) 3 15 1 3 yes yes

327 1132 (0,0,2,0,1,2,2,2,0) 2 8 1 2,2 yes yes

328 1133 (0,0,2,0,1,2,2,2,1) 2 13 1 3 yes yes

329 1151 (0,0,2,0,2,0,2,0,0) 1 5 1 5 no no

330 1153 (0,0,2,0,2,0,2,1,0) 1 6 1 3 yes yes

331 1176 (0,0,2,0,2,1,2,1,0) 1 6 1 3 yes yes

332 1200 (0,0,2,0,2,2,2,2,0) 1 5 1 5 no no

333 1202 (0,0,2,1,0,0,0,0,0) 2 164 1 3 yes yes

334 1205 (0,0,2,1,0,0,0,1,0) 2 240 1 3 yes yes

335 1219 (0,0,2,1,0,0,2,0,0) 2 160 1 3 yes yes

336 1221 (0,0,2,1,0,0,2,1,0) 2 216 1 3 yes yes

337 1225 (0,0,2,1,0,1,0,0,0) 2 68 1 3 yes yes

338 1227 (0,0,2,1,0,1,0,0,2) 2 20 1 3 yes yes

339 1231 (0,0,2,1,0,1,0,2,0) 2 96 1 3 yes yes

340 1233 (0,0,2,1,0,1,0,2,2) 2 32 1 3 yes yes

341 1242 (0,0,2,1,0,1,2,0,0) 2 64 1 3 yes yes

342 1249 (0,0,2,1,0,2,0,0,1) 1 6 1 3 yes yes
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343 1268 (0,0,2,1,0,2,2,2,0) 2 40 1 3 yes yes

344 1269 (0,0,2,1,0,2,2,2,1) 1 6 1 3 yes yes

345 1271 (0,0,2,1,1,2,0,0,1) 1 3 1 3 yes yes

346 1277 (0,0,2,1,1,2,1,0,0) 1 3 1 3 yes yes

347 1281 (0,0,2,1,1,2,2,2,0) 2 12 1 3 yes yes

348 1321 (0,0,2,1,2,1,2,0,0) 1 6 1 3 yes yes

349 1433 (0,0,2,2,1,0,2,0,0) 2 68 1 3 yes yes

350 1437 (0,0,2,2,1,0,2,2,0) 2 20 1 3 yes yes

351 1481 (0,0,2,2,2,0,2,2,0) 1 5 1 5 no no

352 1700 (0,1,1,1,0,0,1,0,0) 1 3 1 3 yes yes

353 1708 (0,1,1,1,0,0,2,0,0) 1 3 1 3 yes yes

354 1791 (0,1,1,1,2,1,1,1,1) 2 264 2 6 no yes

355 1793 (0,1,1,1,2,1,1,2,1) 2 28 2 6 no yes

356 1799 (0,1,1,1,2,1,2,2,1) 2 52 2 6 no yes

357 1818 (0,1,1,1,2,2,2,1,1) 2 20 2 6 no yes

358 1829 (0,1,1,2,0,0,1,0,0) 1 5 1 3 yes yes

359 1837 (0,1,1,2,0,0,2,0,0) 1 4 1 3 yes yes

360 1962 (0,1,1,2,2,2,1,1,1) 2 12 2 6 no yes

361 2088 (0,1,2,1,0,0,2,0,0) 2 6 1 3 yes yes

362 2090 (0,1,2,1,0,0,2,1,0) 2 36 1 3 yes yes

363 2102 (0,1,2,1,0,1,2,1,0) 2 9 1 3 yes yes

364 2104 (0,1,2,1,0,1,2,2,0) 2 12 1 3 yes yes

365 2116 (0,1,2,1,0,2,2,2,1) 1 3 1 3 yes yes

366 2124 (0,1,2,1,2,0,2,0,1) 1 3 1 3 yes yes

367 2135 (0,1,2,1,2,1,2,2,1) 2 20 2 6 no yes
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368 2144 (0,1,2,2,0,0,1,0,0) 1 3 1 3 yes yes

369 2159 (0,1,2,2,0,2,1,1,0) 1 3 1 3 yes yes

370 2171 (0,1,2,2,2,2,1,1,1) 2 12 2 6 no yes

371 2346 (0,2,1,2,1,0,1,0,2) 2 3 1 3 yes yes

372 2353 (1,0,0,0,0,0,0,0,0) 1 5 2 5 no no

373 2354 (1,0,0,0,0,0,0,0,1) 1 9 2 9 no no

374 2357 (1,0,0,0,0,0,0,2,0) 1 12 2 6 no yes

375 2369 (1,0,0,0,0,0,2,2,0) 1 12 2 6 no yes

376 2393 (1,0,0,0,0,2,0,2,0) 1 12 2 6 no yes

377 2407 (1,0,0,0,2,0,0,0,0) 1 27 3 3 yes yes

378 2428 (1,0,0,0,2,1,0,1,1) 1 12 2 6 no yes

379 2430 (1,0,0,0,2,1,0,2,1) 1 6 2 6 no yes

380 2436 (1,0,0,0,2,1,1,2,1) 1 6 2 6 no yes

381 2460 (1,0,0,1,0,0,0,0,0) 1 5 2 5 no no

382 2461 (1,0,0,1,0,0,0,0,1) 1 5 2 5 no no

383 2462 (1,0,0,1,0,0,0,1,0) 1 5 2 5 no no

384 2463 (1,0,0,1,0,0,0,1,1) 1 5 2 5 no no

385 2464 (1,0,0,1,0,0,0,2,0) 1 6 2 6 no yes

386 2466 (1,0,0,1,0,0,1,0,0) 1 3 2 3 yes yes

387 2467 (1,0,0,1,0,0,1,0,1) 1 5 2 5 no no

388 2472 (1,0,0,1,0,0,2,0,0) 1 3 2 3 yes yes

389 2476 (1,0,0,1,0,0,2,2,0) 1 6 2 6 no yes

390 2478 (1,0,0,1,0,1,0,0,0) 1 5 2 5 no no

391 2479 (1,0,0,1,0,1,0,0,1) 1 5 2 5 no no

392 2480 (1,0,0,1,0,1,0,1,0) 1 5 2 5 no no
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393 2483 (1,0,0,1,0,1,1,0,0) 1 5 2 5 no no

394 2486 (1,0,0,1,0,1,2,2,0) 1 6 2 6 no yes

395 2487 (1,0,0,1,0,2,0,0,0) 1 6 2 6 no yes

396 2493 (1,0,0,1,0,2,1,0,0) 1 6 2 6 no yes

397 2529 (1,0,0,1,2,1,2,2,0) 1 3 3 3 yes yes

398 2539 (1,0,0,1,2,2,1,1,1) 1 6 2 6 no yes

399 2545 (1,0,0,1,2,2,2,1,1) 1 6 2 6 no yes

400 2552 (1,0,0,2,0,0,1,0,0) 1 6 4 4 no no

401 2558 (1,0,0,2,0,0,2,0,0) 1 5 4 4 no no

402 2636 (1,0,0,2,2,2,1,1,1) 1 6 2 6 no yes

403 2654 (1,0,1,0,0,0,1,2,1) 1 6 2 3 yes yes

404 2686 (1,0,1,0,0,2,1,2,1) 1 6 2 3 yes yes

405 2698 (1,0,1,0,2,0,1,0,1) 1 10 3 3 yes yes

406 2702 (1,0,1,0,2,0,1,2,1) 1 12 3 3 yes yes

407 2739 (1,0,1,1,0,0,0,0,1) 1 5 2 5 no no

408 2799 (1,0,1,2,0,0,1,0,1) 1 15 3 3 yes yes

409 2803 (1,0,1,2,0,0,1,2,1) 1 15 3 3 yes yes

410 2934 (1,0,2,0,2,1,2,1,0) 1 3 3 3 yes yes

411 3242 (1,1,1,2,2,2,0,0,0) 1 3 3 3 yes yes
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rendus des séances, Soc. des sci. et des lett. de Varsovie, 23:30–50,

1930.

[73] G. Metcalfe. An Avron rule for fragments of R-mingle. J. Logic Com-

put., to appear.

[74] G. Metcalfe. Proof calculi for Casari’s comparative logics. J. Logic

Comput., 16(4):405–422, 2006.
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